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Preface
T h e  I n t e r @ c t i v e L e a r n i n g  S e r i e s :  t h e  e - L e a r n i n g  R e v o l u t i o n

Azimuth’s goal is to bring you the best designed and most technically advanced training materials.
The Inter@ctiveLearning Series from Azimuth is a revolution in software e-learning. You can now
learn both business and software skills anytime, anywhere, using books, CDs, or the Web. It’s the
fast, easy way to e-learn. The Inter@ctiveLearning Series is available on the Web, Local Area
Networks (LANs), CDs, and books.

Approach
All editions emphasize a step-by-step, skills and concepts approach to learning proven in thou-
sands of college classrooms across North America. The Web, network and CD editions make
extensive use of rich media like audio, video and simulations to make learning fun and effective.
The books use large scale graphics and a two-page spread design to achieve the same objectives.
You can move from learning platform to another with ease.

Organization
The Inter@ctiveLearning Series is available in Essentials and Intermediate Editions.  Essentials
Editions introduce you to basic business and software skills. Intermediate Editions teach you more
advanced skills and prepare you for a variety of certification exams including MOUS certification
(Microsoft Office User Specialist).

About the Book
Each book is organized into lessons and skills. Each skill is presented on two facing pages. On the
left page, an Overview section describes why the skill is important and where it is used. This is
followed by step-by-step instructions on how to use the skill. Large screen illustrations on the
right page show you what the screen should look like when you follow the steps.

About the CD and Web Editions
The CD and Web editions are organized just like the books: concepts, skills, and how-to steps
show you exactly how the software works. The CD and Web editions take advantage of the latest
interactive multimedia technologies to make learning fun and exciting. The emphasis is on interac-
tivity – letting you demonstrate what you have learned to the TeacherWizard. It’s like having a
teacher in the machine!

Digital e-Learning Options for Business and Government
The Inter@ctiveLearning Series is ideal for training new hires, existing employees, and agency
clients who are trying to improve their software and business skills. The Inter@ctiveLearning
Series is available for network environments:

Local Area Networks: the Series is available for Novell, NT, and Windows networks.

Intranets: the Series is available for corporate and government intranet servers.

Outsourcing: you may choose to outsource all you software training, testing, evaluation, and
administrative work to Azimuth. The training and testing program can be accessed from any
employee or trainee workstation connected to the Internet.

Contact Azimuth Sales for further information at 1-800-416-6786. 
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U s i n g  t h e  B o o k
In the book, each skill is described in a two-page graphical spread. The left side of the two-page
spread describes the skill, the concept, and the steps needed to perform the skill. The right side of
the spread (facing page) uses screen shots to show you how the screen should look at key stages.

Skill: Each lesson is
divided into a number
of specific skills

Overview: A concise
description of why the
skill is useful and where
it is commonly used

How To: Step-by-step
instructions show you
how to use the skill using
a real-world case that ties
the skill and the concept
to a practical situation

Extra: Enriches your
understanding of the
skill with extra details
and additional features



v

End-of-Lesson Features

In the book, the learning in each lesson is reinforced at the end by a quiz and a skills review called
Interactivity, which provides step-by-step exercises and real-world problems for the students to
solve independently.

Summary tables:
Tables give you a quick
overview of shortcuts
and toolbar icons
needed to use the skills

Screen shots: Screen
shots show you what
the screen should look
like after following the
How to: steps

Hot Tip: Gives
you advice on how
to use the software
and warns you of
potential problems

Practice: Allows you to practice
the skill with a built-in exercise
or a practice file
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U s i n g  t h e  I n t e r a c t i v e  C D - R O M
The Inter@ctiveLearning Series multimedia CD-ROM provides an unparalleled learning environ-
ment in which you can learn software skills faster and better than in books alone. The CD-ROM
creates a unique interactive environment in which you can learn to use software faster and remem-
ber it better. The CD-ROM uses the same lessons, skills, concepts, and How To: steps as found in
the book, but presents the material using voice, video, animation, and precise simulation of the
software you are learning. A typical CD-ROM contents screen shows the major elements of a 
lesson.

Navigation controls: Precise and
simple user controls permit you to
start, stop, pause, jump forward or
backward one page, or jump for-
ward or backward an entire session.
A single navigation star takes you
back to the lesson’s table of contents

Lessons and skills:
The lessons and
skills covered in
the CD are coordi-
nated closely with
those in the book

Skills list: A list of skills allows you
to jump directly to any skill you
want to learn or review, including
interactive sessions with the
TeacherWizard

Review: The
Review summarizes
the skills you have
learned in a lesson
and allows you to
return to a skill by
clicking its title

Review Questions and SmartQuiz:
Review Questions test your
knowledge of the concepts cov-
ered in the lesson; SmartQuiz tests
your ability to accomplish tasks in
a simulated software environment
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U n i q u e  F e a t u r e s  o f  t h e  C D - R O M :
Te a c h e r W i z a r d T M a n d  S m a r t Q u i z T M

The Inter@ctiveLearning Series offers many leading-edge features on the CD currently found in no
other learning product on the market. One such feature is interactive exercises in which you are
asked to demonstrate your command of a software skill in a precisely simulated software environ-
ment. Your actions are followed closely by a digital TeacherWizard that guides you with addition-
al information if you make a mistake. When you complete the action called for by the
TeacherWizard correctly, you are congratulated and prompted to continue the lesson. If you make
a mistake, the TeacherWizard gently lets you know: “You clicked on the wrong button. Click on
the folder icon on the left side of the toolbar to open a file.” No matter how many mistakes you
make, the TeacherWizard is there to help you.

Another leading-edge feature is the end-of-lesson SmartQuiz. Unlike the multiple choice and
matching questions found in the book quiz, the SmartQuiz puts you in a simulated digital 
software world and asks you to show your mastery of skills while actually working with the 
software.

SmartQuiz: For each skill you
are asked to demonstrate, the
SmartQuiz monitors your
mouse and keyboard actions

Skill question: Interactive quiz
questions correspond to skills
taught in lesson

Automatic scoring: At the end of the
SmartQuiz, the system automatically
scores the results and shows you
which skills you should review
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Skills

Microsoft FrontPage is a Web site authoring application.
Web authoring programs are useful for quickly creating,
editing, and enhancing Web pages, the basic units of Web

sites. In general, you will find Web authoring programs are much
faster in generating Web pages than raw HTML (hypertext markup
language). A Web authoring program like Microsoft FrontPage pro-
vides an organized environment that will help you integrate graph-
ics, text, and navigational elements. Just as important, you will
learn how to create Web pages that are fun to use!

In this book you will learn how to use Microsoft FrontPage to cre-
ate useful and attractive Web pages and Web sites. You are limited
only by your imagination and your skill. You will learn how to add
graphics and other effects to your Web pages to make them more
effective. In addition, you will learn how to build e-commerce Web
pages and sites that benefit businesses and other organizations.

The steps in this book will carry you through the process of creating
a Web site for the Speed Demons, a national skydiving club.
Primarily, the club wants its Web site to serve a dual purpose: to
provide member services and to attract new members. It would also
like the site to be a resource for skydiving enthusiasts. Professional
Web designers often design Web sites and then train employees to
maintain them.

FP 1.1

INTRODUCING
MICROSOFT
FRONTPAGE

Introducing Microsoft
FrontPage

Starting FrontPage

Exploring the FrontPage
Screen

Opening a Web Page

Saving a Web Page

Using Page View

Getting Help in FrontPage

Exiting FrontPage

1L E S S O N



O v e r v i e w While millions of people use the Web everyday, few know how Web pages and sites
are actually built. Most Web users believe that building Web pages is quite compli-
cated, and they are often intimidated by unfamiliar acronyms like HTML, HTTP,
and URL.

In the past, authoring Web pages required knowledge of an editing language called
HTML, hypertext markup language. While knowledge of HTML is still useful,
there are new, more user-friendly Web authoring tools that make it possible for
people to build Web pages without knowing HTML. The barriers to easy Web site
construction are slowly but surely being erased.  FrontPage 2000 enables you to
design attractive and professional looking Web pages and sites with relative ease.

In the next four lessons you will learn the important basic steps in Web page and
site design. First you will learn the basic elements of the FrontPage 2000 software:
how to start the software, open a Web page, save a Web page, and get help. In the
second lesson you learn how to create new Web pages, use the Web Wizard, and
edit a Web page. In the third lesson you will learn how customize the Web page to
achieve the objectives you want by adding hyperlinks, tables, and custom themes.
In the fourth lesson you will learn how to organize, maintain, and publish Web
pages. 

Figure 1-1 provides an example of a Web Page in FrontPage 2000 and some of the
features which may be added to a Web page.

Introducing

Microsoft FrontPage

L e s s o n  1  • I n t r o d u c i n g  M i c r o s o f t  F r o n t P a g e
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Skill
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FP 1.3

Figure 1-1  Web Page in FrontPage 2000
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O v e r v i e w Before you can view or edit a Web page, you must open the FrontPage 2000
application. FrontPage opens with a new blank Web page file ready to format.

H o w  To : Start the FrontPage application.

Make sure the computer, monitor, and any other necessary peripheral devices are
turned on. The Windows desktop should appear on your screen. Your screen may
differ slightly from the one shown.

Locate the Windows taskbar, usually found at the bottom of your screen. Use your
mouse to guide the pointer over the Start button          , on the left side of the
Taskbar.

Click           on the Windows taskbar. The Start menu appears.

Move the mouse pointer over the Programs folder to highlight it and open the sub-
menu. The Programs submenu is displayed in Figure 1-2.

Position the pointer over Microsoft FrontPage icon to highlight it and click the left
mouse button. FrontPage will open with a blank page, as shown in Figure 1-3.

E x t r a Each computer varies in its set-up, depending on its hardware and software 
configurations. Therefore, your startup procedure may be slightly different from the
one described above.

Notice that your mouse has two buttons to click. Whenever you are told to click a
mouse button, click the left button, unless otherwise indicated.

Starting FrontPage
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Figure 1-2  Windows Desktop

Figure 1-3  FrontPage Window

Programs menu

Mouse pointer

Start menu

Start button 

Taskbar



O v e r v i e w FrontPage opens to a blank Web page enclosed in a frame. View buttons line the
left side of the FrontPage window on the Views bar. The Views bar is a new 
feature of FrontPage 2000, which facilitates Web site management. The buttons on
the Views bar are labeled according to the functions they control. These buttons are
designed for working with Webs. A Web is a group of related interconnected Web
pages intended to be explored as a Web site. A Web page is a document that can be
viewed over the internet with its own URL, or Uniform Resource Location. A Web
site is a group of Web pages that are linked together to form a cohesive, navigable
Web. The FrontPage window is displayed in Figure 1-4.

The specific buttons on the Views bar are as follows:

Page: This button allows you to create and edit an individual Web page. Most 
formatting and the addition of graphics and other elements are done in this view.

Folders: This button enables you to view and organize the files and folders 
associated with a Web.

Reports: This view provides reports and updates on the status of files and 
hyperlinks, which enables you to keep your Web site up to date.

Navigation: This button displays the navigational structure of your Web site. You
can also add navigation buttons to a Web page in this view.

Hyperlinks: This view displays every hyperlink to and from every page in a Web.

Tasks: This view lists the uncompleted tasks in a Web.

The remaining FrontPage window consists of the following elements:

Title bar: The bar running across the top of the FrontPage window which contains
the Control menu icon, the name of the application, and the Sizing buttons in the
right-hand corner.

Sizing buttons: The Minimize button reduces the window to a program button on
the Windows taskbar. The Maximize button will appear if the FrontPage window is
not enlarged to fit the entire screen. The Restore button, which reverts the 
window to its previous size and location, will appear if the window is maximized.
Finally, the Close button will close the application.

Menu bar: The row of menu titles below the Title bar. When you click a menu title,
a drop-down list of commands related to the title appears.

Standard toolbar: The row of icons used to execute common commands.

Formatting toolbar: The row of list boxes and icons used to perform common text
formatting commands.

Status bar: The bar on the bottom of the FrontPage window, that displays the activ-
ity being performed, active features, and the estimated downloading time.

Exploring the

FrontPage Screen
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Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 1.7

The Maximize button     replaces the
Restore button when the FrontPage 
window is not enlarged to fit the entire
screen. Dialog boxes and floating toolbars
will also have a Close button     in their 
right-hand corner.

Figure 1-4  FrontPage Window
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O v e r v i e w You will probably design your Web over a series of editing sessions. In order to
work with a file, you must know how to reopen it after you saved it. You must
know the name of the file and its location in order to open it.

H o w  To : Open an existing Web page.

Click File, on the Menu bar. The File menu opens.

Move the mouse pointer over Open to highlight it and click once. The Open File
dialog box appears.

Click the drop-down arrow in the Look in: text box, as shown in Figure 1-5, to
find the location of your FP Data Files folder. It may be located on a disk or in a
folder on your desktop. If it is located on a disk you must highlight 31⁄2 Floppy [A:]
to access it. If it is on your desktop, you must highlight the folder, and 
double-click to open any subsequent folders until you reach the desired file.

Once located, double-click the FP Data Files folder, and click on the FPHowto1-3
file. 

Click                .

The Web page FPHowto1-3 opens, as shown in Figure 1-6.

E x t r a Once you have created a Web, you can open its files by clicking the Open Web
command on the File menu. The Open Web dialog box operates similarly to the
Open File dialog box.

After you have created a Web or a file, you can bypass the Open File dialog box by
clicking File on the Menu bar and highlighting Recent Files, or Recent Webs. The
corresponding submenus will display the last Web pages or files you have accessed.
These shortcuts are a new feature of FrontPage 2000.

If you open a file directly from its folder, it will open in your default Web browser.
A Web browser is an application that enables you to view Web pages on the
Internet. In order to edit a Web page however, you must open it from the FrontPage
application.

Opening a Web Page
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Practice Hot Tip
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Locate and open the file FPPrac1-1 from
your FP Data Files folder.

Folders can be located using the buttons
on the left-hand side of the Open File
dialog box instead of the down arrow 
button in the Look in: list box.

Figure 1-5  Open File dialog box
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Click drop-down
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desktop

Figure 1-6  Web page opened in FrontPage

Click to open file



O v e r v i e w If you do not save your work, data can be lost due to power outages or computer
failure. You can save Web pages to a hard drive, floppy disk, or network drive. If
data is lost you can open your file to the most recently saved version therefore, it is
important to frequently save your Web pages.

H o w  To : Save a Web page under a new name and in a new location.

Click File on the Menu bar.

Move the mouse pointer over Save As to highlight it.

Click once on Save As. The Save As dialog box opens.

The default folder is myweb, as shown in Figure 1-7. This folder is located in the
My Webs folder, which is in the My Documents folder.

In the File name: text box type skydive, as shown in Figure 1-8.

Click                .

When you open the myweb folder again, the skydive Web page should be there
with a logo next to it, also shown in Figure 1-8.

E x t r a The Save command and the Save As command perform different functions. The
first time you save a document, the Save command on the File menu, or the Save
button      on the Standard toolbar, will open the Save As dialog box.  After you
have named a file and stored it in a specific location, the Save command will simply
overwrite the existing document. The Save As command will enable you to change
the name and/or location of the document. It allows you to save and make changes
to a document under a new name while maintaining the original file under the ini-
tial file name. Both commands are accessed from the File menu.

Webs are saved in folders entitled myweb. The more pages and Webs you create the
more myweb folders there are. The next Web you create will be saved as myweb1,
then myweb2, and so on.

Saving a Web Page
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Practice Hot Tip
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Save the file FPPrac 1-1 as Caddy in the
myweb folder.

You can create a customized folder in any
location by clicking the Create New Folder
button     in the Save As dialog box.

Figure 1-7  Save As dialog box

Figure 1-8  Web Page saved in folder
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O v e r v i e w Most Web page designing is done in Page view. Text, graphics and other Web 
elements are added and reformatted in Page view. There are three formats available
for viewing Web pages: Normal, HTML, and Preview.

H o w  To : View a Web page in the three formats provided by Page view.

Open the skydive Web page in FrontPage.

Click the Page button on the View bar if it is not already selected.

Three tabs are located on the lower left-hand side of the window. Click the HTML
tab. This view displays your page in HTML format, as shown in Figure 1-9.

Click the Preview tab. The page will be displayed in a browser window. You cannot
format or edit your page from the Preview tab. You can only use this format to
click on hyperlinks, and preview your visual effects. The Preview format is 
displayed in Figure 1-10. Since no effects have been added however, it looks the
same as Normal format.

E x t r a FrontPage is an HTML editor. It takes the work you create and edit in Normal
view and converts it into Hypertext Markup Language or HTML. If you know
HTML, you can create a page using the HTML tab rather than the Normal tab.
The results of your work can always be viewed in the Preview tab. 

Using Page View
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Practice Hot Tip
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Open the Caddy Web page you saved in
the previous skill, and use the Page view
tabs to view the page in HTML, and
Preview formats.

Page view is the only view explicitly used
for creating, editing, and enhancing your
Web pages. The other views are primarily
used for managing your Web.

Figure 1-9  Web page in HTML format

Figure 1-10  Web page in Preview format

Page view button

HTML tab

HTML code

Preview tab

Views bar



O v e r v i e w FrontPage has several help options. The FrontPage Help window has three tabs:
Index, Contents, and Answer Wizard.

H o w  To : Use the Help window tabs to find out about three different views.

Click Help on the Menu bar.

Click the Microsoft FrontPage Help command, the Microsoft FrontPage Help
dialog box opens on the right side of the screen.

Click the Index tab.

In the Type keywords text box type Reports. You will automatically receive a list of
Help topics, as shown in Figure 1-11.

Double-click on Reports_view in the Or choose keywords box. Read what it says
about Reports view.

Click the Answer Wizard tab. In the What would you like to do text box, type in
What is Navigation view.

Click              .

The Select topic to display: window provides an index of related topics, as shown
in Figure 1-12.

E x t r a All three Help tabs direct you to the same information. If you are unsure of exactly
what you are looking for, the Contents tab allows you to search an expandable
table of contents. General topics are listed next to book icons. Clicking the plus
sign to the left of the book icon will access a list of more specific subtopics. The
Index tab uses keywords to locate topics. It is useful if you know the name of the
feature you wish to explore. The Answer Wizard enables you to request help topics
by asking a question in your own words.

The Hide button     , in the upper left-hand corner of the FrontPage Help window,
reduces the window to one section. The Hide button is then replaced by the Show
button     , which in turn, expands the Help window back to the two-paneled 
format. 

Another Help feature is the What’s This? command. It is also accessed from the
Help menu. When you click the What's This? command the pointer turns into a
. When you click a particular button, or other screen element with this pointer, a
screen tip appears describing its function in further detail.

Getting Help in

FrontPage
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Practice Hot Tip
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Using whatever help feature you feel most 
comfortable with, look up information on
Folders, Hyperlinks, Tasks, and Page
views.

At the top left of the Help window are 
navigation buttons. You can use these 
buttons to move back and forth between
topics you have already viewed.

Figure 1-11  Index help feature

Figure 1-12  Answer Wizard help feature

Index tab

Keyword

Help topics that
match your keyword

Answer Wizard tab

Type a question

Same help topics are
available in both
Contents and Index



O v e r v i e w It is important to exit the FrontPage application properly. Exiting and closing the
application properly will prevent data loss.

H o w  To : Exit the FrontPage program when you are finished working.

Open the skydive Web page.

Click File on the Menu bar.

Move the pointer over Exit to highlight it.

Click Exit once, as shown in Figure 1-13.

If you have made changes to the page without saving them the Warning dialog box
shown in Figure 1-14 appears. Clicking               saves the changes and closes
FrontPage. Clicking              closes the program without saving the changes, and
clicking           stops the program from closing.

If you have not made any changes, FrontPage simply closes.

E x t r a There are other ways to close a file and exit Front Page. The easiest method is to
use the Close buttons      . The Close button on the Title bar closes the application,
while the Close button in the upper right-hand corner of the Front Page window
closes the active Web page.

There is no keyboard shortcut for exiting FrontPage, however, there is one for clos-
ing the active file. Instead of using the File menu, you can press [Control] and F4
on the keyboard simultaneously to close the active Web page.

Exiting FrontPage
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Practice Hot Tip
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Open the Caddy Web page you saved in a
previous skill. Then close the file and exit
FrontPage.

You can also close the program by 
accessing the Control menu. The Control
menu is opened by clicking the FrontPage
icon at the left of the Title bar, or by 
right-clicking the Title bar.

Figure 1-13  Exiting FrontPage

Figure 1-14  Warning dialog box

File menu

Closes page
without exiting
application

Closes page and
exits application

Close button

Close file
button
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Shortcuts
B u t t o n / M o u s eF u n c t i o n

Open File

Open Web

Save File

Microsoft FrontPage
Help

What’s This?

Page view

M e n u
Click File, then click
Open

Click File, then click
Open Web

Click File, then click
Save

Click Help, then click
Microsoft FrontPage
Help

Click Help, then click
What’s This?

Click View, then click
Page

K e y b o a r d
[Ctrl]+[O]

[Ctrl]+[S]

F1

[Shift]+F1



Test Yourself

a. Save

b. Windows taskbar

c. Page View

d. Sizing buttons

e. Index

f. Status bar

g. Web

h. URL

10. Creating, editing and most Web page formatting is done here

11. The Web page address

12. This help feature looks up keywords

13. Overwrites an existing document

14. An assortment of Web pages that make up a Web site

15. The Start button is found here

16. Displays activities being performed and active elements at the bottom of the
screen

17. Buttons at the top right of the window that allow you to alter the size of the
window
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I d e n t i f y  K e y  F e a t u r e s

Figure 1-15  Components of the FrontPage window



Test Yourself

18.  The Contents tab is part of this feature:

a. Views bar

b. Menu bar

c. The Help Window

d. Status

19.  Click this command to open a recently worked on
Web site:

a. File

b. Recent Web

c. Open File

d. Old Web

20.  This view gives you updates on your files and hyper-
links so that you can keep your Web up to date:

a. Reports view

b. Page view

c. Hyperlinks view

d. Update view

21.  If you open a Web page directly from an icon in one
of your desktop folders:

a. It will not open at all

b. All data will be lost

c. It will open in FrontPage to will be able to edit it

d. It will open in your browser to will be unable to
edit it

22.  This Help feature enables you to click items to access
screen tips.

a. Index

b. Contents

c. Answer Wizard

d. What’s this?

23.  This contains graphical buttons that execute specific
commands:

a. Standard toolbar

b. Menu bar

c. Graphical toolbar

d. Taskbar

24.  The Control menu is accessed from the:

a. File menu

b. Taskbar

c. Title bar

d. Menu bar

25.  The formatting language used to create Web pages:

a. URL

b. Web code

c. FrontPage 2000 code

d. HTML

FP 1.20
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Test Yourself
1.  Opening FrontPage 2000:

a. Start FrontPage by using the Start menu, accessed from the Windows taskbar.

b. Click the different view buttons on the Views bar.

2.  Open a Web Page:

a. Click File, then click Open.

b. Locate your FP Data Files folder.

c. Locate the Web Page FPTest 1, and open it.

3.  Save a Web Page:

a. Click File, then click Save As.

b. Locate the mywebs folder, in the My Documents folder.

c. Save the file as watertaxi.

4.  View a Web Page in Page View:

a. Open the watertaxi page.

b. Click the Page View button on the Views bar, if it is not already selected.

c. Click the HTML tab.

d. Click the Preview tab.

5.  Getting help in FrontPage:

a. Click Help, then click Microsoft FrontPage Help.

b. On the Contents tab, find the section on Pages under the heading, Designing Web Pages.

c. On the Index tab type in the key word Graphic and see what comes up.

6.  Exiting FrontPage:

a. Click File, then click Exit.

b. Do not save any changes that you made since you last saved watertaxi.

FP 1.21
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Test Yourself
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7.  Congratulations. You have been hired by Diggs & Associates as an Office Assistant. Your position is primarily
involved with the creation and maintenance of a Web site for a small publishing house, Diggs & Associates. In order
to maintain a competitive advantage, they realized they would need a Web site to distribute information to agents,
authors, and other potential business partners. Furthermore, they realized that certain business transactions could be
conducted via the Internet.

8.  Your first job is to devise a rough draft of a Web site. Nothing concrete is necessary, just a few conceptual propos-
als including thematic examples and possible features. Some possible features to consider are a product ordering page
and a guest book to record visitors to the site.

9.  Make a list of the Web site components you advocate. Use your imagination, be creative and brainstorm. All of
your ideas may not be plausible but many can come to fruition. For example, images complete with animation can be
added. Plug-ins and applets are other possibilities. These terms will be explained in future lessons if you are 
unfamiliar with them.

10.  Devise a personally significant Web site. For example, if you are a soccer enthusiast, create a soccer Web site.
Consider what type of information will be relevant and useful to visitors and what sites might complement yours.
Search the Internet for related sites to link to yours.

11. Find one or more Web sites that you like and compile a list of the attributes that attracted you to them. Take
detailed notes about what makes these sites attractive and engaging to visitors. Your notes should include everything
from animation and graphics to theme, color, writing style, font size, and font color.



Skills

After you have planned a Web site, the next step is to create the
necessary Web pages. This can be accomplished in several different
ways.

You can start from scratch with the blank page that automatically
appears when you open the FrontPage application, or use a wizard
or a template to create a new page. In this lesson we will show you
how to use wizards and templates. A Wizard is a series of dialog
boxes that guides you through the creation process. A template is a
preformatted Web page containing sample text and pictures that a
Web author copies and edits to create their own unique page.

Wizards and templates can also be used to create entire Webs. The
Wizard will build a rough Web, complete with a Home page, and
the general organization and style of your choice.

In addition this lesson will teach you the fundamental tasks of
adding, editing and spell checking text. You will learn how to find
and replace specific words or subjects and how to preview a pub-
lished Web page.

FP 2.1

CREATING WEB
SITES

Creating a New Web Page

Creating a New Web Using a
Template

Using a Web Wizard

Using the Import Web Wizard

Adding Text to a Web Page

Spell Checking and Editing a
Web Page

Using the Find Command

Previewing a Web Page in a
Browser

2L E S S O N



O v e r v i e w The fundamental building block of a Web site is one or several Web pages. One of
the easiest ways to get started building Web pages is to use templates that are pre-
defined by FrontPage. Templates can be easily modified to suit your specific needs.

H o w  To : Create a new Web page using a template.

Click File, on the Menu bar.

Highlight New, and click Page from the submenu that appears.

The New Page dialog box opens.

Click the Guest Book page, as shown in Figure 2-1.

Click              .

The new Web page appears in the FrontPage window complete with placeholder
text, as shown in Figure 2-2. Placeholder text displays the text format and facili-
tates data entry.

E x t r a A template is a basic structure or outline. FrontPage has many useful templates
from which to choose. Some templates are specifically designed to accommodate
graphics, some come equipped with radio buttons, still others have predesigned
return forms. Take advantage of these templates to create functional Web pages.

Directly below and to the right of the FrontPage window are scroll bars equipped
with scroll boxes and scroll arrows. Clicking the right or left scroll arrow on the
horizontal scroll bar will move the view to the right or left. Clicking the up or
down scroll arrow on the vertical scroll bar, will move the screen up or down one
line at a time.

You can move more quickly by clicking and dragging the scroll boxes up, down,
left or right. The size of the scroll box changes with the page size. The longer a
page is top to bottom, the shorter the vertical scroll box. As page width increases,
horizontal scroll box size decreases.

Creating a New Web

Page
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Practice Hot Tip
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Open FrontPage and create a new Web
page using whatever template you want.

Cascading style sheets, available in the
New Page dialog box, offer a wider range
of style options than standard HTML. 

Figure 2-1  New Page dialog box

Figure 2-2 New page with placeholder text

Web page templates
and wizards

Allows you to
preview what the
template looks
like

Description of the
type of page you
are creating

Placeholder text

Scroll arrow

Scroll arrows

Scroll arrow

Scroll box



O v e r v i e w A new Web can be started as easily as a new Web page. If you have an idea of the
theme and format you want, you can create one using a template. A Web template
will create an entire Web site with a Home page and a general organizational 
structure and outline. You will overwrite placeholder text with your own data.

H o w  To : Sydney is going to create a Web using a preconstructed template.

Click File on the Menu bar.

Highlight New, and click Web from the submenu that appears.

The New Web dialog box appears. Select the Customer Support Web, as shown in
Figure 2-3.

Click              .

Your Web is created, complete with a Home page.

To view the structure of the Web, click the Navigation button      on the Views bar.

This site is displayed in Figure 2-4.

E x t r a Every Web contains a Home Page. A Home page is the first page a visitor sees
when they reach a site. Links are used to navigate between the various pages in the
Web.

The New Web dialog box provides a description of each available template. The
Customer Support Web furnishes a feedback mechanism to improve 
customer support services. The Project Web provides a team member directory and
enables project team members to discuss ideas and concerns, post status reports,
and schedule meetings. A Personal Web consists of a Home page, a Photo album
page, an Interests page, and a page which links to the author’s favorite sites.

Each of these Web templates serves different purposes, however, a template is not a
restrictive structure. Web templates can be edited and reorganized. Themes can be
applied during or after the creation process. Unnecessary pages can be deleted and
additional pages can be inserted. For example, if a company wants to advertise
using multiple photographs, the Web author can begin with the Personal Web
template and add a Form page and a Guest book page. Start with a Web template
that is suited to your requirements and edit it in any way you wish to make it your
own.

Creating a New Web

Using a Template
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Practice Hot Tip
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Create a Project Web to be used with the
Caddy page you saved in Lesson 1.

Most Web servers require a default name
for Home pages, usually, Index.htm. If you
change it, FrontPage will automatically
rename it if required by the server, when
you publish the Web.

Figure 2-3  New Web dialog box

Figure 2-4  New Web with placeholder text

Web templates
and wizards

Customer Support Web

Web description

Placeholder text

Navigation view 
displays the structure
of the Web



O v e r v i e w A wizard is an automated procedure that conveniently performs a complex opera-
tion. A series of dialog boxes prompts you to choose options that accomplish the
task to your specifications. The quickest easiest method for creating a Web is to
choose a Web Wizard.

H o w  To : Use a wizard to create a new Web.

Click File, on the Menu bar.

Highlight New, and click Web from the submenu that appears.

The New Web dialog box appears. Click the second icon from the left, the
Corporate Presence Wizard, and click              .

The first dialog box is an introduction to the Wizard, shown below in Figure 2-5.
Click          .

The next dialog box allows you to choose the pages to include in your Web. Make
sure that all of the check boxes are checked, except for the Products and Services
box. Click          .

The next dialog box is a description of the Home page. Only check the Mission
Statement and Contact Information boxes, as shown in Figure 2-6. Click          .

The next dialog box describes the What’s New page. Click the Articles and
Reviews, and Web Changes check boxes, as shown in Figure 2-7. Click          .

The next dialog box sets up the Feedback Form. Leave the default settings selected
and click the Mailing Address check box, as shown in Figure 2-8. Click          .

Using a Web Wizard
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Figure 2-5  Corporate Presence Web Wizard dialog box
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Figure 2-6  Web Wizard dialog box

Figure 2-7  Web Wizard dialog box

Figure 2-8  Web Wizard dialog box

Page description

Check the topics you want
included in the page

Progress bar displays the
amount of work completed

All checked items will be
part of the Feedback Form



H o w  To : Accept the default settings, and click          .

The next dialog box sets up the Table of Contents. Click the Keep page list up-to-
date automatically check box, and click          .

The next dialog box adds objects to the top and bottom of each page. Leave the
default settings checked. In addition click the check boxes to place the company
logo at the top of each page, and click the Date page was last modified at the bot-
tom of each page, the dialog box is shown in Figure 2-9. Click          .

Accept the default setting, and click          .

Click in the company name text box to place the insertion point there. Delete the
sample company name and type Speed Demons Sky Diving Club. Type in Skydiver
as the one word version of that name. The address is 345 Rocky Rd., Falling Water,
N.Y. 10566, as shown in Figure 2-10. Click          .

The telephone number and the fax number are the same, (914) 728-9903. The
Webmaster’s e-mail address is Shanson@domain.skydiver.com. The e-mail address
for general info is info@domain.speed_demon.com. Click          .

Click          , without choosing a Web theme.

Click          .The Web opens in Tasks view, the only tasks are for you to customize
the pages. Click the Navigation view button     , see Figure 2-11.

E x t r a Web Wizards are most useful when creating a complicated Web, they will guide a
user through the process of creating a complicated site. You can use wizards to 
create a Form Page, which is used to collect information from the user. You can
also create Data Access Pages, which are Web pages created using Microsoft Access
databases. You can create a Personal Web, which includes a photo album you can
use for picture. There is also a Discussion Web Wizard, a Customer Support Web
Wizard, and an Import Web Wizard.

You can type in the specified location of your Web folder in the Specify the
Location of the New Web text box in the New Web dialog box. FrontPage will 
create a new folder with a specified name. For example, type
C:\Windows\Desktop\Sydney’s Web\, FrontPage will create a folder on your desk-
top called Sydney’s Web. If you do not place the Windows before Desktop then the
folder will be created in your Desktop folder on the hard drive.

The first letter specifies the drive where the folders are located. Generally A: is the
floppy disk drive, C: is the hard drive, and D: is the CD ROM drive. Then specify
the location, such as Desktop, or My Documents, this method can help you save a
Web anywhere on your computer.

Using a Web Wizard

(continued)
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Practice Hot Tip
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Create a Corporate Presence Web for the
Caddy file. The Company name and
address appear in the file. Only provide the
information already contained in the file.

If you do not specify the name of the folder
or the location in which to save it,
FrontPage will create a default folder called
myweb. Each succeeding Web will be
labeled myweb1, myweb2, myweb3, etc.

Figure 2-9  Web Wizard dialog box

Figure 2-10  Web Wizard dialog box

Figure 2-11  Web in Navigation view

You can finish the
wizard at any time

You can cancel the
wizard at any time

You can always go
to the previous step
in the wizard

Go to a page by clicking
on it in Navigation view



O v e r v i e w When you import a file to FrontPage you are essentially creating a new Web using
preexisting files. A wizard has been created to make the importing process easier.
The Import Web Wizard creates a new Web, while also importing data from anoth-
er file.

H o w  To : Use the Import Web Wizard to create a new Web, by importing data from preexist-
ing files.

Click File on the Menu bar.

Highlight New, and click Web from the submenu that appears. The New Web dia-
log box opens. Click on the Import Web Wizard. In the Specify the Location of the
New Web text box type C:\My Documents\Skydiver\. As shown in Figure 2-12.
This means that the Web will be saved in a folder called Skydiver in the My
Documents folder. Click              . The first Import Web Wizard dialog box opens.

Click the From a source directory of files on a local computer or network radio
button. Click the             .

In the Browse for Folder dialog box locate your FP Data Files folder, and click
FPHowto2-5 as shown in Figure 2-13. Click              . Click the Include subfolders
check box and click          .

Click           again, then click          .

Double-click the Index file in the Skydiver Web. It is the original Skydiver page you
worked with earlier.

E x t r a FrontPage opens your Web to a blank page. To open a previously saved Web page,
double-click the page icon beneath the folder it is located in, in the Folder List. You
can also click the Navigation button on the Views bar and double-click the page
you want to view on the Navigation structure. At present, in Navigation view, the
Skydiver Web contains only one page. Double-clicking it will open the Speed
Demons page in Page view.

Using the Import

Web Wizard
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Practice Hot Tip
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Import FPPrac2-8 into a new Web you cre-
ate called Caddy Shop. Place the new fold-
er wherever you would like.

You can use the Import Web Wizard to
transfer data from a published Web site to
a new Web as well as to convert a folder
to a Web.

Figure 2-12  New Web dialog box

Figure 2-13  Browse for Folder dialog box

Import Web
Wizard icon

Specify new
Web’s location

Click the plus sign to
open a folder, and the
minus sign to close it



O v e r v i e w Perhaps the most important job in creating a Web site is composing the text.
Imparting information to visitors to your site is after all, your primary goal. Adding
text is the first step in the creation of a functional Web site.

H o w  To : Add text to an a Web page. You will add text to the imported Home page in the
Web you have created.

Open the Speed Demons page in Page view from the Skydiver Web.

Move the pointer over the text. The pointer turns into an I-beam . If the color of
the background is colored, than the I-beam color may change.

Move the I-beam to the end of the word Club, and click. A flashing insertion point,
a black bar which marks where text will be added, should appear at the end of
Club. The insertion point also changes with the background color, as shown in
Figure 2-14.

Press the [Enter] key on your keyboard four times.

Type: A National Organization for those who live on the edge. Your page should
look like Figure 2-15.

Click File, then click Save.

Close the Index page.

E x t r a In Lesson 3, you will learn how to format or change the appearance of text, using
the Formatting toolbar. Text formatting includes font, font style, size, color and
alignment. Special effects can even be added to enhance the way text appears.

Adding Text to a

Web Page
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Practice Hot Tip
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Five lines below the last line of text on the
Index page in the Caddy Shop Web, type:
Best Prices this Side of the Pond.

The [Tab] key on the keyboard moves text
several spaces, generally toward the right,
depending on the format you apply. You
can use the [Enter], [Tab] key, and [Space
bar] to effect where on a page text
appears.

Figure 2-14  Insertion point placed in text

Figure 2-15  Page with new text added

Insertion point

New text



O v e r v i e w Typing errors are inevitable. While adding text to a Web page in the Normal tab,
you can use the Spell Checker to locate mistakes. Underlines will alert you to 
possible errors. Editing text is then a fairly simple task.

H o w  To : Check a Web page you have created for spelling errors, and make the necessary
corrections.

Open the page FPHowto2-6 from your FP Data Files folder.

Click Tools on the Menu bar, then click Spelling.

The Spelling dialog box automatically opens when it reaches a word that is not in
its dictionary, as shown in Figure 2-16.

Click             .

Click             .

Place the I-beam behind the k in the misspelled word, and click to place the 
insertion point. The misspelled word is shown in Figure 2-17.

Press the [Backspace] key on the keyboard to delete the k.

Type rm, so the word determine is spelled correctly.

Save the file as Writing Tips in your My Documents folder.

E x t r a Clicking              will add a word to the spell checking dictionary. This is 
particularly useful if the checker frequently stops on your name, or for unusual
words that are not in the dictionary. You can also highlight and right-click a word
to access a shortcut pop-up menu. The shortcut menu will contain a list of possible
replacements and the Add and Ignore commands.

Spell Checking and

Editing a Web Page
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 2.15

Find and correct the spelling errors in
FPPrac2-9. Save it as Order Form.

When a word is underlined in red, it 
indicates that it is not in the dictionary. You
can do on-the-spot editing without 
accessing the Spell Checker.

Figure 2-16  Spelling dialog box

Figure 2-17  Misspelled word in page

List of possible
replacements for
misspelled word

Ignores word
not in dictionary

Changes error to
suggested word

Ignores all words
of same spelling

Changes all
errors to suggest-
ed word

Underline indicates
word does not appear
in dictionary



O v e r v i e w Quickly locating specific words or phrases can be difficult in a lengthy page or
Web. The FrontPage Find and Replace commands enable you to search for and
review or edit text quickly and accurately.

H o w  To : Use FrontPage's Find command to locate a specific section of text on a particular
Web page.

Open the Writing Tips page.

Click Edit on the Menu bar, then click Find.

The Find dialog box opens, as shown in Figure 2-18.

In the Find what: text box type adverb clauses.

Click              . The Find command takes you to the first mention of adverb
clauses.

Click               again. The Find command takes you to the second occurrence of
adverb clauses, as shown in Figure 2-19.

Click             . 

Close the page.

E x t r a The Replace command is also accessed from the Edit menu. The Replace dialog
box is almost identical to the Find dialog box. However, an additional text box
enables you to enter replacement text. Two additional buttons enable you 
to replace a single instance,              or all instances of a particular word or 
phrase,             . In the Search section options section, radio buttons allow you to
choose to search the entire document or just the current page. In the Direction sec-
tion you can choose to search up or down the document.

The Replace command may be on the extended Edit menu. Not all commands are
on the primary menu. In Office 2000, menus automatically expand after a few 
seconds. You can hasten the process by moving the pointer over the double arrows
at the bottom of the menu. Primary menu commands will include commands you
have recently used.

Using the Find

Command
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 2.17

Open the Order Form and find a question
that asks the user to enter their age.

You can use the Find and Replace
commands in almost every different view.
You can also use them to find and replace
text in HTML.

Figure 2-18  Find dialog box

Figure 2-19  Text found in page

Matches upper
and lowercase

Direction to search

Text found and
highlighted in
page



O v e r v i e w FrontPage Webs will look exactly as you see them in Internet Explorer 4 or above,
but may look very different in other browsers. Even simple Web pages will display
differently depending on the browser used. The Preview tab in Page view, displays a
Web as it will appear online. However, the Preview in Browser command will give
you an even better idea of how your Web pages will look when published. A
browser, as you will recall, is a program that enables you to view Web pages and
HTML documents.

H o w  To : Preview your Web with a browser to see how it looks.

Open the Skydiver Web.

Open the Index page.

Click File on the Menu bar. Then click the Preview in Browser command. It may
appear on the extended menu. 

The Preview in Browser dialog box opens, as shown in Figure 2-20.

Click              .

The browser opens with your page displayed, as shown in Figure 2-21.

Close the browser.

Close FrontPage.

E x t r a If you click on a file directly from the folder it’s in, rather than opening it in
FrontPage, then it will open in your default browser without going through the
process of the Preview in Browser dialog box.

Previewing a Web

Page in a Browser

L e s s o n  2  • C r e a t i n g  W e b  S i t e s

FP 2.18

1

5

6

4

2

3

7

8

Skill



Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 2.19

Open the Caddy Shop file, and preview it
in your browser.

As long as they are in good working order,
your hyperlinks will operate when you 
preview a page in your browser. You can
link to other pages in a Web or to Web
sites on the Internet.

Figure 2-20  Preview in Browser dialog box

Figure 2-21  Web page previewed in browser

You can set the
window size

Add other
browsers on your
computer
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Shortcuts
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New Page

New Web

Preview in Browser

Find

Replace

Check Spelling
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Find
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Test Yourself

a. Match case

b. I-beam

c. Template

d. Browser

e. Dictionary

f. Wizard

g. Insertion point

h. Home page

10.  A series of dialog boxes that facilitates the creation of a Web page or an entire
Web

11.  A preconstructed document that allows you to fill in your own content

12.  Allows you to type text directly onto the page

13.  The pointer turns into this when it is held over the FrontPage screen

14.  This feature allows you to search by the case of the first letter in a word

15.  A word will be flagged by the Spell Checker if it does not appear here

16.  The first Web page you visit in a Web site

17.  Allows you to view Web pages and HTML documents

FP 2.21
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I d e n t i f y  K e y  F e a t u r e s

Figure 2-22  Web page in FrontPage



Test Yourself

18.  Both the New Page and New Web commands can be
found on this menu:

a. Insert menu

b. Tools menu

c. Edit menu

d. File menu

19.  A Web page that is created using a database from
Microsoft Access is called a:

a. Form page

b. Data Access page

c. Home page

d. Discussion page

20.  If you open a file directly from a folder, rather than
opening it in FrontPage:

a. It will open in FrontPage anyway

b. It will open in a Web editor

c. It will open in a Browser

d. It will not open at all

21.  Some commands cannot be found on the regular
menu, sometimes you must open:

a. An extended menu

b. A folder

c. A wizard

d. A keyboard shortcut

22.  When you use either the Find or Replace command,
you have the option of searching a page:

a. Left-to-right, right-to-left

b. By the size of the word

c. Up or down

d. By the verb tense

23.  When creating a Web using the Import Web Wizard
you must select the folder to import using:

a. The Find Folder command

b. The Browse for Folder dialog box

c. The Find Folder dialog box

d. The Edit menu

24.  If you misspelled a word while typing, FrontPage
alerts you:

a. By highlighting the word

b. By automatically changing the word

c. By underlining the word in red

d. By having a dialog box open automatically

25.  The computer hard drive is usually marked by the
letter:

a. D

b. E

c. A

d. C

FP 2.22
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Test Yourself
1.  Create a new Web page using a template:

a. Click File, then New. Click Page from the submenu that appears.

b. Select a template from the ones provided in the New Page dialog box.

2.  Create a new Web with a template:

a. Click File, then click New. Click Web from the submenu that appears.

b. Select the Personal Web Wizard from the New Web dialog box.

c. Save the Web as My Site.

3.  Create a Web using a Web Wizard:

a. Click File, then New. Click Web from the submenu that appears.

b. Select Corporate Presence Wizard from the New Web dialog box.

c. Create a Corporate Presence Web using the options provided.

4.  Import a Web:

a. Click File, then New. Click Web from the submenu that appears.

b. Select the Import Web Wizard.

c. Create a Web called Water Taxi.

d. Import the FPTest 2 Web from your FP Data Files folder to the Water Taxi Web.

5.  Add and Edit Text:

a. Fix the spelling error that occurs in the FPTest 2 file.

b. Below the table, type in a slogan for the Water Taxi service.

c. Place the insertion point at the end of the table. Press the [Enter] key until you are four lines below the table.

d. Add the slogan.

6.  Preview a Web page in a browser:

a. Make sure FPTest 2 is open.

b. Click File, then click Preview in Browser.

c. Select a Browser.

d. Close the browser, and FrontPage, and save as Water Taxi.

FP 2.23
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Test Yourself

FP 2.24
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7.  Use the Corporate Presence Wizard to create a Web site for Diggs & Associates. Name the Web folder Diggs and
save it in your My Documents folder. Keep your earlier plans in mind. You can always add pages to a Web to accom-
modate your various ideas. Include a Products/Services page. Accept the default settings for the Products/Services
page. Fill in the name of the company, Diggs & Associates, the address, 987 Park Lane, Tompson MA 02411, and
the telephone number, (582) 690-9043. The fax number is (582) 690-1649. Your e-mail address is the Webmaster’s
address. The general info address is: info@domain.diggs.com. Leave the default settings for everything else. 

8.  Your supervisors think you should add a product-ordering page. They have asked you to design a prototype for
their perusal. Use the Form Page Wizard, found in the New Page dialog box, to give them an idea of what a product-
ordering page will look like. In the first dialog box, click Add to affix ordering information to the page. Leave the
default settings for everything else.

9.  Another Diggs employee is interested in previewing the Web site. He has asked you to create a blank Web using
the Corporate Presence Wizard, to give him a rough idea of the site structure. Change the options in various ways to 
create several versions to show him. 

10.  Create your personal Web site. Use a template or a wizard if appropriate. You can start with a blank page and
write a short bio, if you like. Create an entire Web or merely a Home page. Experiment and let your creativity flow.



Skills

Formatting to make your site aesthetically pleasing is a difficult
task. It is crucial, however, in order to attract visitors to your site. If
you use a template, with preformatted text, you may not bother
with formatting. However, as you become more adept at creating
your own Web pages, you will probably want to exert more control
over the final product.

Tastes are extremely variable and subjective. The Microsoft
FrontPage program offers many possibilities for designing Webs to
suit various styles and sensibilities.

Applying a theme is perhaps the easiest formatting method. The
font or typeface, text color, background, bullet style, and graphics
are chosen all at once. This saves time, and complementary elements
have been chosen for you.

Adding objects takes practice and experience. Certain objects are
more effective in specific situations. Lists, tables, hyperlinks, and
images can be added to your pages and formatted to your 
specifications.

Forms can be added to Web pages or created as independent pages.
Text boxes, radio buttons, check boxes, and drop-down menus can
be added to forms to gather information from Web site visitors.
After answering questions, with the help of these various form
fields, the visitor clicks a Submit button to send the data to the 
server.

After you add objects to a Web page you must know how to 
reformat them, move them, change their colors, size, and borders,
and even add animation. Learning these skills will enable you to
produce an appealing, high quality Web site.

FP 3.1

FORMATTING AND
ADDING OBJECTS

TO WEB PAGES

Formatting Text on a Web
Page

Adding and Formatting Lists

Creating Tables

Formatting Tables

Applying Themes to a Web

Applying Custom Themes

Creating Text Hyperlinks

Editing Hyperlinks

Adding Images

Formatting Images

Image Mapping

Creating a Hover Button

Creating a Marquee

Inserting Text Boxes

Adding Check Boxes and
Radio Buttons

Creating a Drop-Down Menu

Creating a Push Button

3L E S S O N



O v e r v i e w FrontPage allows for many formatting options. These formatting options include
changing the font or typeface, font style, font size, color and alignment. Text can be
aligned to the left, right, or center. It can be underlined, italicized, or made bold.
Many formatting commands can be accessed from the Formatting toolbar, which is
directly above the Front Page window. 

H o w  To : Change the font and font size of Web page text.

Open the Skydiver Web, to the Index page.

Click and hold the I-beam in front of the letter A, in the second phrase. Click and
drag the pointer to the end of the phrase, highlighting it. The text should appear as
shown in Figure 3-1.

Click the drop-down arrow in the Font Size list box on the Formatting toolbar, the
toolbar is shown in Figure 3-2.

Select the size 5 (18 pt) from the drop-down list. The highlighted paragraph
becomes smaller.

Click the drop-down Font list box, seen in Figure 3-2.

Scroll down until you get to the font Monotype Corsiva font. Click it to select it.
The text is changed to the new font.

Highlight the first two lines of the page.

Click the Underline button      on the Formatting toolbar.

Click once anywhere on the screen to deselect the highlighted text.

Your page should now resemble Figure 3-3.

Save the file.

E x t r a The word Font refers to typeface style. Some fonts are bold, some are ornate, some
are classic. You can choose a comical or a serious font to set the tone for your
page. 

Next to the Underline button are the Bold and Italic buttons, which can be
used together or separately. The three style buttons are especially useful for headers,
footers and other text you want to stand out.

The three layout buttons, align left     , align right     , and center      control where
text appears on the page. Sometimes you must use the alignment buttons in con-
junction with the space bar to arrange text exactly as desired.

Formatting Text on a

Web Page
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 3.3

On the Index page of the Caddy Shop
Web, format the text so that the address of
the shop appears in the font Century
Gothic, and is underlined.

If you apply a format before typing, it will
be applied to the entire page. If you 
highlight the target text, on the other hand,
the formatting will be applied only to the
selected section.

Figure 3-1  Page text highlighted

Figure 3-3  Formatted text

Figure 3-2  Formatting toolbar

Highlighted text

Font color
button

Highlight buttonFont list box Drop-down
arrows

Style list box

Font size box

Numbering button

Bullets button
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New size and font

Underline style
applied



O v e r v i e w FrontPage has many ways of organizing information on a Web Page. One simple
and convenient way for organizing information on a Web page is to create a list.
Lists consolidate information in a concise format. They can either be numbered or
bulleted using the corresponding buttons on the Formatting toolbar.

H o w  To : Add a new page with a list to a Web.

Open the Skydiver Web.

Open the Index page.

Click File on the Menu bar and highlight New. Click Page from the submenu that
appears. Click Normal Page, then click              . A new page opens.

Type: Organizational Goals. Then click the Center button     . Select the text and
format it so that the font is Arial Black and the size is 5 (18pt).

Click and place the insertion point after s in Goals. Press the [Enter] key.

Click the Align Left button     . Then click the Bullets button     . Type: Increase
club membership. Press the [Enter] key again. Type: Increase public awareness.

Follow the same procedure to create a list that includes: Catch media attention,
Stress safety measures, and Make skydiving more affordable and enjoyable for all.
The page is shown in Figure 3-4.

Right-click one of the bullets in the list. Click List Properties. The List Properties
dialog box opens.

Click the bullets that are empty circles, as shown in Figure 3-5, and click              .

Save the file in the Skydiver Web, accept the default name, organizational_goals.ht-
ml.

E x t r a You can create a numbered list rather than a bulleted list using the Numbering
button     . Then, you can right-click an item in a numbered list to access the 
shortcut pop-up menu. In the Numbers tab of the List Properties dialog box you
can choose to label your list with capital or lowercase letters or Roman numerals.

Adding and

Formatting Lists
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 3.5

Create a new page in the Caddy Shop
Web. At the top write Best selling items.
Then create a numbered list, listing, in
order, Tees, Balls, Clubs, Bags, Shoes,
Shirts, Pants, Videos, Books.

To change the properties of only one item
in the list, right-click the item you want to
change and select List Item Properties
from the shortcut menu. The List Item
Properties dialog box will open presenting
formatting options for that particular item.

Figure 3-4  Bulleted list

Figure 3-5  List Properties dialog box

Bullets for organizing
list information

Specifies type of
bullet that appears

Options for
numbered lists



O v e r v i e w Tables are commonly used on Web pages to organize information in a structured
and attractive way. To start, all you need is a rough outline and a general idea of
where you want to insert the table. Tables consist of cells containing blocks of text
or numbers. Tables can be imported from Microsoft Word or Microsoft Excel, so
that  you can reuse existing tables from word processing or spreadsheet documents.

H o w  To : Insert a table into the Index page in the Skydiver Web.

Open the Index page from the Skydiver Web.

Place the insertion point halfway between the slogan for the club, and the 
underlined name of the club.

Click Table on the Menu bar. Then highlight Insert, and click Table from the 
submenu.

The Insert Table dialog box opens, as shown in Figure 3-6.

Click              to accept the default settings.

The table is created with the insertion point in the first cell.

Type: Organizational Goals. Press the [Tab] key.

Type: Schedule of Events, Recent News, and Skydiving Near You, pressing the
[Tab] key after each entry.

When you have finished entering the text, save the file. Your page should now look
like Figure 3-7.

E x t r a The Insert Table button      on the Standard toolbar can also be used to create a
table. A box appears in which you move the pointer to highlight the desired 
number of cells. If you want to change any of the cell properties, however, you
should use the Table menu and go through the Insert Table dialog box.

The number and size of the rows and columns does not have to be decided ahead
of time. As you add content to your table, the rows and columns will expand. To
add two more entries to the table you just created, simply press the [Tab] key at the
end of the text in the fourth cell. Another row with two cells will automatically be
inserted. 

Creating Tables
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Practice Hot Tip
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FP 3.7

Insert a table into the Index page of the
Caddy Shop Web. Add the following text;
Sales, Products, Contact us, and
Employment, into the four cells.

You can create a table without borders by
changing the Border size, Cell padding,
and Cell spacing to 0 in the Insert Table
dialog box.

Figure 3-6  Insert Table dialog box

Figure 3-7  Page with table inserted

Changes table
alignment

Changes the table
structure and spacing

Changes the
number of cells

Cell

Row

Column



O v e r v i e w Formatting can be applied to tables after they are created. Text formatting 
including font changes, underlining and color can also be added. The Table
Properties dialog box will enable you to add background colors, apply various 
borders, and adjust the spacing between cell contents and cell walls. Changes can
be made to the entire table, individual cells or specific rows or columns. You can
also use the pointer to resize the table.

H o w  To : Format the table you have created.

Right-click the border of the table.

Click Table Properties from the shortcut menu. The Table Properties dialog box
opens.

Click the drop-down list in the Color list box in the Borders section. Click on the
white color square. Click             .

Change the Light Border and Dark Border to white. Click             .

Change the Background Color to the same blue background as the page. 
Click             . The Table Properties box should look like Figure 3-8.

Click              . Right-click the border. Click Cell Properties from the shortcut
menu. The Cell Properties dialog box opens.

Click the drop-down arrow on the Horizontal Alignment list box in the Layout
section. Click Center from the drop-down list.

Click              and then              . Notice that only one cell is affected. Click and
drag to select the entire table and right-click. Reopen the Cell Properties dialog box
and repeat the procedure to center the remaining cells. When you have finished
your page should look like Figure 3-9.

E x t r a You can use the pointer to resize a table, move the pointer over the border you
want to move. If you want to resize the table horizontally, move the pointer over a
vertical border, and the pointer will turn into a horizontal resizing arrow       . If
you want to resize the table vertically,  move the pointer over a horizontal border
and it will turn into a vertical resizing arrow   .

Once the pointer has turned into a resizing arrow, simply click and drag the 
border until it is the size that you want.

To add rows or columns, click and drag to select the table. Click Tables on the
Menu bar. Click Insert, then click Rows or Columns. Use the Insert Rows or
Columns dialog box to insert the rows or columns you want.

Formatting Tables
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Practice Hot Tip
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FP 3.9

Format the table on the Index page in the
Caddy Shop Web so that the borders are
all the same color green as the text.

If you click Font on the shortcut menu, the
Font dialog box will open, allowing you to
change the font, color, and other aspects
of the text.

Figure 3-8  Table Properties dialog box

Figure 3-9  Formatted table on a page
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Border colors are
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centered within cells



O v e r v i e w A theme is a preformatted style that can be applied to a Web page or an entire
Web. A set of formatting instructions controls the background, fonts, colors, and
button styles. Themes provide a fast method for designing Webs or applying a
matching design to multiple pages.

H o w  To : Apply a theme to a Web.

Open the Index page from the Skydiver Web.

Click Format on the Menu bar.

Click Theme. The Themes dialog box opens.

In the selection box on the left, click on Blends to highlight it. A preview appears,
as shown in Figure 3-10.

Make sure that the All Pages radio button is selected. Click              .

A warning message appears telling you that you will be permanently replacing 
formatting information. Click              .

It takes FrontPage several seconds to apply the theme. When it does your page
should resemble Figure 3-11.

If you open the organizational_goals page, you will notice the formatting has been
applied to that page as well.

Save these changes.

E x t r a You can also use the Themes dialog box to apply a theme to only one page in a
Web. In Navigation view, double-click on the target page to open it. Open the
Themes dialog box, select the theme, and click the Selected page radio button,
which appears beneath the All pages radio button. The theme will only be applied
to the selected page. To remove a theme click No Theme in the Themes dialog box.
Applying themes is a new feature that has been added to FrontPage 2000.

Applying Themes to

a Web
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Practice Hot Tip
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FP 3.11

Apply the Citrus Punch theme to the
Caddy Shop Web.

Clicking the Vivid colors check box in the
Themes dialog box will bring out brightly
colored text and graphics in the themes.

Figure 3-10  Themes dialog box

Figure 3-11  Web with theme applied

Radio button

Vivid colors
check box

Theme preview

Theme is applied
to all FrontPage
elements



O v e r v i e w One of the reasons themes are so useful, is because they do not restrict the user to
the prechosen format. Even though colors, fonts, etc., have already been selected,
FrontPage allows you to make changes to these features. Knowing how to make
these changes will allow you to work with existing themes, to create a customized
theme.

H o w  To : Make changes that will allow you to customize an existing theme that you have
already applied to a Web.

Open the Index page of the Skydiver Web.

Click Format, click Theme. The Themes dialog box opens. Click the All Pages
radio button.

Click the Vivid colors check box.

Click the Expedition theme to highlight it.

Click             . Several new buttons appear below the preview window.

Click             . The Modify Theme dialog box opens, as shown in Figure 3-12.

Click             . The Modify Themes dialog box reopens. Body should be selected in
the Item: list box. Click the Comic Sans MS font to highlight it. As shown in 
Figure 3-13. Click              .

Click              in the Themes dialog box. The Save Theme dialog box opens. Type
New Theme as the title of the theme.

Click              . Close the Themes dialog box.

Save the changes. Your custom theme should look like Figure 3-14.

E x t r a The Color Wheel tab in the Modify Theme dialog box can be used to select 
customized colors for your theme. The color intensity can also be adjusted on the
Brightness bar. Your selections can be previewed on the right-hand side of the 
dialog box, allowing you to precisely fine-tune your color scheme.

Applying Custom

Themes

L e s s o n  3  • F o r m a t t i n g  &  A d d i n g  O b j e c t s  t o  W e b  P a g e s

FP 3.12

1

5

6

4

2

3

7

10

9

8

Skill



Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 3.13

Add a customized theme to the Caddy
Shop Web. Apply the Capsules theme and
modify it using the Cactus color scheme.
Change the body text to Garamond.

You can use the Graphics button to add
background images to your Web. Click
and locate the desired image to incorporate
it into the Web background.

Figure 3-12  Modify Theme dialog box

Figure 3-13  Text modification

Figure 3-14  New theme applied

Color schemes

Theme preview

Selected fonts

Different Navigation
button styles



O v e r v i e w A hyperlink is an object in a Web page that connects a visitor to a file, another Web
page or another Web site. Hyperlinks can be designed to download files or start
other operations. They can also link to e-mail addresses. Almost any object, word,
or image can be used to create a hyperlink.

H o w  To : Create text hyperlinks in the Skydiver Web to link the pages in the Web.

Open the Index page in the Skydiver Web.

Highlight Organizational Goals in the table.

Click Insert on the Menu bar, then click Hyperlink. The Create Hyperlink dialog
box opens. 

In the dialog box window click the organizational_goals page, as shown in 
Figure 3-15.

Click              . The hyperlink is created. The text changes color, and is underlined.

Highlight Recent News in the table. Click Insert, then Hyperlink.

Double-click in the URL: box, and type: recent_news.htm. Click              .

Follow the same procedure to create hyperlinks to the target URL’s
schedule_of_events.htm, and skydiving_near_you.htm.

Save the changes. Click the Preview tab.

Notice that when you move the pointer over a hyperlink it turns into a     , as it
would in a browser. Click the Organizational Goals hyperlink. The Organizational
Goals page is displayed.

Your page should now look like Figure 3-16.

E x t r a There are four buttons to the right of the URL list box. The first,     , enables you
to use your Web browser to link to a selected page or file. The second button,     ,
enables you to link to a file on your computer. The third button,     , enables you to
create a link that sends e-mail. When the user clicks the link, their default mail 
program opens to a mail-composing window with the specified e-mail address
inserted. The final button,     , creates a new page, then automatically links to that
new page.

You can create a hyperlink without choosing a specific word, phrase or image on
the Web page. Simply place the insertion point where you want to position the
hyperlink. Access the Create Hyperlink dialog box and locate the target page or
file. When you create the link, the title of the target page will be inserted on the
Web page. If there is no title, the URL will be inserted.

Creating Text

Hyperlinks
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 3.15

Create four hyperlinks for the four items in
the table on the Index page in the Caddy
Shop Web. The addresses are sales.htm,
best_selling_items.htm (for Products),
employment.htm, and the e-mail address
luckycaddy@domain.caddy.com.

When you move the pointer over a link in
Page view, the target address is displayed
in the Status bar. Check the hyperlink by 
holding the [Ctrl] key and clicking the link.

Figure 3-15  Create Hyperlink dialog box

Figure 3-16  Hyperlinks on a page

Target address

Pages in the
Web

Hyperlink text
changes color and is
underlined



O v e r v i e w It is often necessary to edit hyperlinks. Page names or target addresses may change.
You may want to switch from one kind of link to another, for example, change a
URL link to an e-mail address link. Microsoft FrontPage 2000 makes it easy to
change links after they are inserted.

H o w  To : Make some changes to hyperlinks you created earlier.

Open the Index page of the Skydiver Web.

Right-click the Schedule of Events hyperlink.

Click Hyperlink Properties from the shortcut menu. The Edit Hyperlink dialog box
opens, as shown in Figure 3-17.

Click     . Click Normal Page in the New Page dialog box, click              .

Click File from the Menu bar, and select the Save As command to save the new
page under the name calendar. Change the title to Calendar by clicking the Change
button to the right of the default Page title, New Page 1. Be sure to save it in the
Skydiver Web.

Double-click the Index page to open it. Move the pointer over the Schedule of
Events hyperlink. Hold [Ctrl] and click the hyperlink. The link takes you to the
new calendar page.

Reopen the Index page and right-click the Skydiving Near You hyperlink. Follow
the same procedure to name the new page local and change the title to Local.
Repeat the procedure for the Recent News hyperlink. Click File and choose the
Save As command to name the page news and change the title to News.

E x t r a Changes can be made to hyperlink text the same way you make changes to regular
text. You can use the Formatting toolbar to change the font, font color, font size,
and font style of hyperlink text. If hyperlinks are in different locations on the page
however, you will probably have to change each hyperlink individually. With the
hyperlinks in the table structure, you can simply select it and reformat the table. 

If there is no theme applied you can change the format of hyperlinks on a page by
right-clicking, then click Page Properties from the shortcut menu, then click the
Background tab. The Background tab of the Page Properties dialog box is dis-
played in Figure 3-18. 

To change the text color of all the hyperlinks in a Web at once, access the Custom
tab in the Color section of the Modify Theme dialog box. In the Item: list box,
select Hyperlinks and choose a color from the Color: list box.

The easiest way to create a hyperlink is to type the URL of the target page directly
onto the Web page. FrontPage will automatically create a link to the specified Web
address.

Editing Hyperlinks

L e s s o n  3  • F o r m a t t i n g  &  A d d i n g  O b j e c t s  t o  W e b  P a g e s

FP 3.16

1

5

6

4

2

3

7

Skill



Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 3.17

Create new pages to link to and from the
Caddy Shop Index page. Title the new
pages Sales and Employment. Be sure to
save them in the Caddy Shop Web.

To delete a hyperlink, access the Edit
Hyperlink dialog box and delete the text in
the URL list box. The text or image that
you used to activate the link will remain on
your Web page. You can also delete the
hyperlink text directly from the Web page.

Figure 3-17  Edit Hyperlink dialog box

Figure 3-18  Page Properties dialog box

Address is already
selected for editing

Allows you to
format hyperlinks



O v e r v i e w Images can add informative content to a Web page or simply augment its style. You
should keep in mind, however, that each picture lengthens a page-loading time. The
Microsoft Clip Art Gallery allows you to quickly add graphics and photos to your
Web page.

H o w  To : Insert an image from the Microsoft Clip Art Gallery into the Index page of the
Skydiver Web.

Open the Index page from the Skydiver Web.

Place the insertion point between the title of the club and the table.

Click Insert on the Menu bar. Click Picture, then click Clip Art from the submenu
that appears. The Microsoft Clip Art Gallery opens.

Click in the Search for clips: text box to highlight the text and press the [delete]
key. Type: air, and press the [Enter] key. The results of the search are shown in
Figure 3-19.

Click the clip on the left. A small menu of buttons appears, as shown in 
Figure 3-20.

Click the top button, Insert Clip.

The image is inserted as shown in Figure 3-21.

Save the file. The Save Embedded Files dialog box will open. Click              . This
will save the image in the Skydiver Web. If the image is not saved with the Web, or
is accidentally saved in a folder in another Web, it will not appear with the 
published Web.

E x t r a Images are sometimes so large that they prevent a Web page from loading in a 
reasonable amount of time. Be sure to check the loading time on the Status bar. 

The best formats to save images in are GIF ( Graphic Interchange Format), and
JPEG (Joint Photographic Experts Group). These formats compress large 
photographic files so that they do not take as long to load when published. Images
you insert that are not in GIF or JPEG format will be automatically converted to
GIF when FrontPage copies them to the Web page folder.

Adding Images
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 3.19

Insert an image into the Index page in the
Caddy Shop Web. Insert it one line below
the table. Search for a clip with the words
easy going. Insert the clip on the left and
save the file.

To insert a picture you follow a similar 
procedure. Click Insert, then Picture, then
From File on the submenu. You will just
have to locate the picture file on your 
computer. Once you insert it, save the file
in your Web.

Figure 3-19  Clip Art Gallery

Figure 3-20  Menu

Figure 3-21  Page with image inserted

Click to view more
images

Search for clips that
match specified word

Click to view previous
clips

Click to view clip
categories

Insert clip

Preview clip

Add clip to Favorites
or another category

Find similar
clips



O v e r v i e w FrontPage gives you the ability to easily format images once they are placed on the
page. After you place images on a Web page it is often necessary to resize them,
change their location, or alter their colors.  There are many different formatting
effects that you can choose from.

H o w  To : Format an image by resizing it and by placing a border around it.

Open the Index page from the Skydiver Web.

Click the image to select it. Sizing handles appear at the corners and on each side of
the image. Move the pointer over the sizing handle at the lower-right corner of the
image. The pointer turns into a resizing arrow     .

Click and hold down the mouse button, drag it upwards until the entire table can
be seen with the image, as shown in Figure 3-22.

Right-click the image. Click Picture Properties on the shortcut menu.

The Picture Properties dialog box opens. Click the Appearance tab. In the Border
thickness: text box type 3, as shown in Figure 3-23.

Click              . The image now has a border around it. 

Save the changes.

E x t r a Whenever you create a Web, FrontPage automatically creates an images folder. If
you intend to use a lot of images, you should move them to this folder. Images can
be saved there using the Save Embedded Files dialog box. This is a good file 
management practice that will allow you to quickly locate your images.

You can resize an image horizontally or vertically using the midpoint sizing 
handles. Clicking and dragging the right or left midpoint sizing handle will adjust
the image horizontally, while dragging the top or bottom midpoint sizing handle
will adjust it vertically. While the image is selected, you can delete it using the
Delete key on the keyboard.

Formatting changes can also be made using the Image toolbar shown on page 
3.23. The image can be rotated, flipped, cropped, beveled, and moved forwards 
or backwards. Text can be written over it, and contrast and brightness can be 
adjusted.

Formatting Images
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 3.21

Resize the image on the Index page of the
Caddy Shop Web so that it is larger, and
centered.

When you insert an image or click behind
it, a large insertion point is placed behind
the image. You can press the Backspace
key to delete it or align it left, right, or cen-
ter using the corresponding buttons on the
Formatting toolbar.

Figure 3-22 Resizing an image

Figure 3-23  Picture Properties dialog box

Sizing handles

Click and
drag to resize

Allows you to align
the image on the page

Allows you to change the size
of an image by specifying
pixels or percent



O v e r v i e w An image containing multiple links is called an image map. Creating a link between
an image and another page is easy to accomplish. Image maps are also called 
clickable images or hotspots. Hotspots are invisible boxes on a picture, each of
which has a link attached to it. The Image toolbar contains three buttons for 
creating differently shaped hotspots.

H o w  To : Use an image you inserted to create a link to another page.

Open the Index page in the Skydiver Web.

Click the image to select it.

Click the rectangular hotspot button      on the Image toolbar that appears at the
bottom of the screen. The Image toolbar is shown in Figure 3-24.

Use the pointer, which is now a pencil     to draw a rectangle around the airplane,
as shown in Figure 3-25.

The Create Hyperlink dialog box opens. Click the link to new page button     . It is
the last of the four buttons to the right of the URL list box.

Select the Frequently Asked Questions page, the second icon in the second row of
the New Page dialog box. Click              .

Save the file under the default name, Table of Contents.

Open the Index page again.

Click the Preview tab. Notice that the pointer turns into a hand over the airplane as
it would on any other hyperlink, but not when it is over part of the image that was
not mapped, as shown in Figure 3-26.

Click on the image. The linked page opens.

Return to Normal view, and save the changes.

E x t r a You can insert as many hotspots as will fit on an image, however, it is advisable to
choose an image with easily distinguishable areas so that visitors can guess where
the links are.

The entire image can also be a hyperlink. Simply click the image to select it and
click Insert from the Menu bar. Then select Hyperlink and type in the URL, or
locate the page or file you wish to link to in the Create Hyperlink dialog box.

To change a hotspot’s link, double-click the hotspot and change the URL or find a
new page or file to link to in the Edit Hyperlink dialog box. To delete a hotspot,
click once to select it and press the Delete key.

Image Mapping
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 3.23

Create a hotspot on the Index page of the
Caddy Shop Web. Link to a new
Frequently Asked Questions page that
you will create. Save everything.

You can use the Circular Hotspot or the
Polygonal Hotspot buttons on the Image
toolbar to more precisely conform to the
shape of the chosen area on the image.

Figure 3-24  Image toolbar

Figure 3-25  Creating a hotspot

Figure 3-26  A hotspot

Insert picture
from a file

Text over
an image

Bring
forward

Send
Backward

Rotate
image

Flip image

Contrast Brightness

Crop

Black and
White

Bevel

Hotspots

Pointer over
a hotspot

Hotspot is inside
the rectangle

Image toolbar



O v e r v i e w A Hover button is one whose appearance changes when you pass the pointer or
“hover” over it. It is a Java applet, which means that its special effects will appear
only on browsers that can read the Java programming language. The button may
glow, change color or even appear to bend inward. Hover buttons are used as
hyperlinks.

H o w  To : Create a Hover button on one of the Web pages in the Skydiver Web.

Open the organizational_goals page, from the Skydiver Web.

Place the insertion point below the last line of text.

Click Insert, highlight Component and click Hover button from the submenu. The
Hover Button Properties dialog box opens.

In the Button text: text box type Home.

Click             . The Select Hover Button Hyperlink dialog box opens. Click the
Index page to link to it, and click              .

Click the drop-down arrow in the Button color: list box. Choose the black square.

Click the drop-down arrow in the Effect color: list box. Choose the yellow square.

Click the drop-down arrow in the Effect: list box and select Reverse glow.

The Hover Button Properties dialog box should now look like Figure 3-27.

Click              .

Save the file.

Click the Preview tab.

Move the pointer over the Hover button, and it should glow, as shown in 
Figure 3-28. If you click on it, it will take you to the Index page.

E x t r a If a visitor does not have a Java-enabled browser only the special effects will not
function. The button will be present and the hyperlink will function, but the color
change and glow will not occur.

Creating a Hover

Button

L e s s o n  3  • F o r m a t t i n g  &  A d d i n g  O b j e c t s  t o  W e b  P a g e s

FP 3.24

1

5

6

4

2

3

7

10

9

8

Skill

11

12

13



Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 3.25

In the Caddy Shop Web, add a 
Hover button with special effects to the
table _of_ contents page to link it to the
Index page.

You can edit and make format changes to a
Hover button by right-clicking it and 
selecting Hover Button Properties from
the shortcut menu.

Figure 3-27  Hover Button Properties dialog box

Figure 3-28  Hover button in Preview mode

Changes the
font on the
button

Basic button
color

Color that
appears when
pointer is over
button

Hover button



O v e r v i e w A marquee is a piece of animated text. Marquees grab people’s attention as they
scroll across the Web page. Scrolling marquees are only supported by Internet
Explorer. Visitors who use Netscape Navigator, will only see the marquee’s text as
ordinary text.

H o w  To : Add a marquee to the Index page in the Skydiver Web.

Open the Index page, in the Skydiver Web.

Place the insertion point in front of the S in Speed Demons.

Click Insert, highlight Component and click Marquee from the submenu.

The Marquee Properties dialog box opens. In the Text: text box type Come fly 
with us.

Click the Alternate radio button in the Behavior section, the The Marquee
Properties dialog box is shown in Figure 3-29.

Click              .

Save the changes

Click the Preview tab.

The marquee moves around the screen, as shown in Figure 3-30.

E x t r a Although marquees are typically placed at the top of a page they can be placed
wherever you wish. If you place the insertion point at the end of a line of text, the
marquee will be inserted on the following line. As you saw in the exercise above, if
you place the insertion point before a line of text, the marquee will be inserted one
line above it.

Creating a Marquee
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 3.27

Place a marquee that says, Lucky Caddy,
on the Index page of the Caddy Shop
Web. Increase the speed and format it
however you wish.

To format marquee text; click the marquee
to select it. Sizing handles will surround
the marquee. Either use the buttons on the
Formatting toolbar, or click Format on the
Menu bar and select Font, to open the
Font dialog box.

Figure 3-29  Marquee Properties dialog box

Figure 3-30  Marquee sliding and scrolling across page

Controls the way
the marquee moves

Speed in which
marquee moves

Marquee



O v e r v i e w A text box is an area on a Web page where users can submit information back to
the Web site.  In FrontPage a text box is called a form field. Often users are asked
to complete registration forms before they can use a Web site. You can create these
forms with the Form Wizard. All forms contain a Submit and Reset button. After
you insert a form onto your Web page, you must determine the what fields (or
pieces of information) the visitor will be asked to submit.

H o w  T O : Add a form page to the Skydiver Web, and then begin adding form fields by adding
two one-line text boxes and a scrolling text box.

Open the Index page from the Skydiver Web.

Open a new, Normal page, by clicking File on the Menu bar, highlighting New and
clicking Page from the submenu. When the New Page dialog box opens, click the
Normal Page icon and click              .

Press the [Enter] key three times.

Click Insert on the Menu bar, highlight Form and click Form from the submenu
that appears. Two buttons appear. Place the insertion point in front of the Submit
button and press the [Enter] key. Place the insertion point one line above the but-
tons and type Name. Then click Insert, highlight Form, and click One-Line Text
Box from the submenu. The form is displayed in Figure 3-31. Press the [Enter] key.

Type e-mail address and insert another one-line text box. Press the [Enter] key.

Type, Describe your First Skydiving experience. Then click Insert, highlight Form,
and click Scrolling Text Box from the submenu.

Save the changes. Use Form as the page title and save it as form.

Click the Preview tab. The form page should look like Figure 3-32.

E x t r a To resize a text box, click it once to select it. Sizing handles will allow you to adjust
its dimensions. If you right-click a text box you can access many formatting options
from the shortcut pop-up menu.

Inserting Text Boxes
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 3.29

Create a new form page in the Caddy Shop
Web. Devise two short questions and cre-
ate two one-line text boxes. Devise another
question, with a lengthy answer, and insert
a scrolling text box. Save the new page as
form and change the title to Form.

Click and drag a text box to reposition it in
the form.

Figure 3-31  Form with text box inserted

Figure 3-32  Text boxes in Preview mode

Form buttons

Text boxes are
ready to be written
in and submitted

Text box



O v e r v i e w Two other form fields are check boxes and radio buttons. Check boxes are used to
submit yes or no answers. Radio buttons are generally created for questions where
the answers are limited to several options. These two form fields facilitate data
entry by allowing visitors to answer questions with a click of the mouse.

H o w  To : Add a check box and radio buttons to a form page.

Open the Form page in the Skydiver Web.

Place the insertion point before the Name text box. Press the [Enter] key.

Place the insertion point one line above the Name text box.

Type Check the box if you have gone skydiving before.

Click Insert on the Menu bar, highlight Form and click Check Box from the 
submenu. A check box is inserted, as shown in Figure 3-33.

Press the [Enter] key.

Type: If so how many times?:. Press the [Enter] key again.

Click Insert, highlight Form, and click Radio Button from the submenu. A radio
button is inserted. Type: 1-10, then press [Tab]. Add another radio button. Type
11-20. Press [Tab]. Add another radio button, type 21 and over.

Save the changes.

Click the Preview tab. Your page should look like Figure 3-34.

E x t r a Radio buttons and check boxes are similar in that visitors can choose from one or
more options. Radio buttons offer a group of options from which one is chosen.
Check boxes are generally used to answer yes or no questions but can also be 
created in situations where you want to allow multiple selections.Radio buttons
and check boxes cannot be resized or reshaped.

Adding Check Boxes

and Radio Buttons
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 3.31

Compose a yes or no question and add it,
along with a check box, to the Caddy Shop
Web form page. Insert an option group
with 2-3 radio buttons.

The Form Page Wizard can also construct
radio buttons. If you enter a list in the
Enter the Labels for the Options text box,
a group of radio buttons will be created.

Figure 3-33  Form page with check box

Figure 3-34  Form page with radio buttons

Check box

Radio buttons



O v e r v i e w Another form field that can be created is a drop-down menu. After creating a drop-
down menu, you must add the selections from which the visitor will choose. Drop-
down menus are used when there are multiple selections. They simplify data entry
and save space on the form.

H o w  To : Add a drop-down menu to the form that you have been working on.

Open the Form page from the Skydiver Web.

Place the insertion point after the scrolling text box.

Press the [Enter] key.

Type: What area of the country do you live in?.

Click Insert on the Menu bar. Highlight Form and click Drop-Down Menu from
the submenu.

Double-click the drop-down menu. The Drop-Down Menu Properties dialog box
opens.

Click             . The Add Choice dialog box opens. Type: Northeast, as shown in
Figure 3-35. Click              . In the Initial State section, make sure the Not selected
radio button is selected.

Follow the same procedure to add Southeast, Midwest, South, Sunbelt, Rockies,
North, Northwest, and West Coast. In the Name: text box type Area. When you
are finished the dialog box should look like Figure 3-36.

In the Allow multiple selections section, make sure the radio button next to No is
selected. Click              . Save the changes.

Click the Preview tab. When you click the drop-down arrow, the menu should
appear, as shown in Figure 3-37.

E x t r a In the example above, we left Not selected as the initial state for each radio button.
If you think most visitors will choose a particular answer however, you can make
one of the options appear preselected. If the user would have chosen that option, he
or she can skip that field. They can select another option if the initial state is incor-
rect.

You can edit your entries using the Modify button              in the Drop-Down
Menu Properties dialog box. You can rearrange the list order using              
and             . An option is also available for permitting visitors to make multiple
selections from the list. Since this is not generally done however, this could be 
confusing to visitors. Check boxes are probably a better choice when you want to
allow multiple selections.              enables you to delete entries.

Creating a Drop-

Down Menu
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Practice Hot Tip
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Create a drop-down menu of payment
methods on the form page of the Caddy
Shop Web. Your list should include: cash,
credit card, debit card, cash on delivery,
and money order.

Click         to set data entry rules for the
drop-down menu. You can stop a form
from being submitted unless a menu item
is selected, or you can disallow certain
items from being selected. These options
are available on all form controls.

Figure 3-35  Add Choice dialog box

Figure 3-36  Drop-Down Menu Properties dialog box

Figure 3-37  Drop-Down Menu 

Choice available for user

List of choices that will
be available on menu

Drop-down menu created
to your specifications



O v e r v i e w Another form field is a push button. Most Web authors leave the Reset and Submit
buttons at the bottom of the form page. However, sometimes it may be convenient
to locate a Reset or a Submit button at some earlier point in the form. In these
cases a push button can be it inserted. A push buttons can also be used to answer a
yes or no question.

H o w  To : Create a push button that will Reset the form, so users don’t have to scroll to the
bottom of the form if they want to reset it.

Place the insertion point after the check box at the top of the form.

Press the [Tab] key five times.

Click Insert, highlight Form and click Push Button from the submenu. The button
is created in the location you specified.

Double-click the button. The Push Button Properties dialog box opens.

In the Value/label: text box type Reset.

Click the Reset radio button to the right of Button type:.

The Push Button Properties dialog box should now look like Figure 3-38.

Click              .

Save the changes.

Click the Preview tab. Your form should now look like Figure 3-39.

E x t r a To specify where a form is going to be submitted,  right-click          . Then click
Form Properties from the shortcut menu. Use the Form Properties dialog box to
locate a file or folder to send completed forms to, or an e-mail address where com-
pleted forms will be sent. You can also send forms to databases or to other types of
files for storing data.

Creating a Push

Button
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Practice Hot Tip
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Add a Reset button somewhere on the
Form page in the Caddy Shop Web.

Use the Options section of the Form
Properties dialog box to specify what
fields will be saved and where the data
results will be saved once they are
received.

Figure 3-38  Push Button Properties dialog box

Figure 3-39  Button in a form

Normal button may
be used to enter
data, like a check
box

Will clear all data
from form when
clicked
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Shortcuts
B u t t o n / M o u s eF u n c t i o n

Bold

Italics

Underline

Center

Align left

Align right

Hyperlink

Insert picture from file

Insert table

Bullets and numbering

Font

Theme

Decrease indents

Increase indents

M e n u

Click Insert, then click
Hyperlink

Click Insert, highlight
Picture, then click
From File

Click Table, highlight
Insert, then click Table

Click Format, then
click Bullets and
Numbering

Click Format, then
click Font

Click Format, then
click Theme

K e y b o a r d
[Ctrl]+B

[Ctrl]+I

[Ctrl]+U

[Ctrl]+E

[Ctrl]+L

[Ctrl]+R

[Ctrl]+K

[Ctrl]+[Shift]+M

[Ctrl]+M



Test Yourself

a. hotspot

b. Font list box

c. Marquee

d. Formatting toolbar

e. Image toolbar

f. Hover button

g. Table

h. Theme

i. Check box

10. Formats an entire Web with similar fonts, color schemes, and other formatting
options

11. Organizes information in a structured and attractive way

12. Creates a hyperlink over a specific area of an image

13. Creates a title for a page that scrolls or slides across the screen

14. Form field used for a yes or no question

15. Controls the typeface style

16. The hotspot button is found here

17. The bold and italic buttons are found here

18. A button that creates an effect when the mouse moves over it
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I d e n t i f y  K e y  F e a t u r e s

Figure 3-40  Formatted Web page



Test Yourself

19.  When you move the pointer over the screen to enter
text the pointer turns into an:

a. I-beam

b. Insertion point

c. I-point

d. Insertion beam

20.  You can change the properties of a numbered or 
bulleted list by:

a. Double-clicking the list

b. Right-clicking the list and selecting List Item
Properties from the shortcut menu

c. Right-clicking the list and selecting Number and
Bullet Properties from the shortcut menu

d. Double-clicking the list and selecting List
Properties from the shortcut menu

21.  To figure out how many rows and columns you need
to create a certain number of cells:

a. Add the number of rows plus the number of
columns

b. Subtract the number of columns from the number
of rows

c. Multiply the number of rows by the number of
columns

d. Multiply the number of cells you need by the
columns, then divide by the number of rows

22.  You can perform every function from the Create
Hyperlink dialog box except:

a. Color the hyperlink

b. Link to a new page

c. Create a link that sends an e-mail

d. Search the browser for a page to link to

23.  The most efficient file formats for saving large
images are:

a. RIFF

b. JIFF and TIFF

c. GIF and JPEG

d. PREG and FREG

24.  A hyperlink over a specified area of an image is also
called a:

a. Linked map

b. Warmspot

c. Coolspot

d. Hotspot

25.  A Java applet, which is used to create a hover 
button is:

a. Named after a type of fruit

b. Designed to run on every browser no matter what

c. A set of instructions written in the Java language

d. Utterly useless without a plug in

26.  An alternative method of creating radio buttons is:

a. Using the Corporate Presence Wizard

b. Using the Form Page Wizard

c. Using the Submit Form Template

d. With the Radio Button Properties dialog box

FP 3.38
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Test Yourself
1.  Create and format a list:

a. Open the Water Taxi Web.

b. Create a new blank page in the Web, save it as, and title it Locations.

c. Create a bulleted list for the water taxi destinations: Ocean Harbor, Lee Beach, Red Sands, Bay Sands, Cherry
Road, Blue Birch, and Tom’s Grand Cove.

d. Change the font of the list text and save the page.

2.  Insert a table:

a. Create a new page called Fees. Save it in the Water Taxi Web.

b. Insert a table to organize the destinations listed above and their associated fees: $3.50, $6.25, $4.75, $10.00,
$5.25, $2.50, and $8.25 respectively.

c. Save the page.

3.  Apply a theme to a Web:

a. In the Water Taxi Web, apply the Rice Paper theme to the entire Web.

b. Design a custom theme using the Sumi Painting theme. Name the new theme, Customized theme.

c. Apply the custom theme to the entire Web.

4.  Create Hyperlinks:

a. Create hyperlinks from the already existing text on the Index page of the Water Taxi Web. Create the new pages
to which they will link. For example, create a link from the Fees link in the table to the newly created Fees page.
Create a link from the Information link on the Index page to the newly created Locations page.

b. For the rest of the links in the table, link them to a new page titled and saved with the same name as the link.
Create a Staff page, an Employment page, a Weather page, and a Related Services page.

c. Test all the links to make sure they work.

5.  Add an image and create a hotspot:

a. Create a new page, save it as, and title it Image. Save it in the Water Taxi Web.

b. Search the Clip Art Gallery using the word water. Select and insert the clip of the boat on the right.

c. Create a hotspot somewhere on the image that links it to a new  form page that you will create using the Form
Page Wizard. Save and title the page Form.

FP 3.39
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6.  Create a hover button and a marquee:

a. Open the Index page from the Water Taxi Web.

b. Create a scrolling marquee for the company name.

c. Open the Information page.

d. Create a hover button with special effects that links to the Index page in the Water Taxi Web.

7.  Add form fields to the Water Taxi Web form page:

a. Open the Form page in the Water Taxi Web.

b. Add a check box at the top of the form that asks, Would you like to make reservations for a water taxi ride?.

c. Type: How many people will be joining you?. Create three radio buttons for the options: 1-4, 5-8, and 9-12 peo-
ple, with one radio button for each option.

d. Next type: On what date will you be riding with us?. Add a one-line text box after the question.

e. Type: How did you hear about us?, and add a scrolling text box to the page.

f. Type: Where will you be going to?. Create a drop-down menu that includes the list of locations that you entered
on the Information page earlier.

8.  You have been doing a good job at Diggs & Associates but the tough part has just begun. You must now format
the Web to meet the tastes and the organizational needs of your employers. Insert a table with hyperlinks to each page
in the Web. For example, create a cell that says, Products and Services and link it to the Products and Services page.
Design a conservative, professional-looking theme to apply to the Web. The Bold Stripes and Industrial themes are
good places to start. Customize one of these two themes if you so desire. On the Products and Services page, create a
products list including the categories: Fiction, Non-Fiction, How-To, Textbooks, Poetry, Drama, Biographies,
Reference, and Childrens. Create a marquee for the company name. At the bottom of the page create a Hover button
with the special effects and colors of your choice. Be sure to save after reformatting or adding objects to a page. Save
the pages in the Diggs Web.

9.  Create a form page using the Form Page Wizard. Select, ordering information as the type of input to collect. Save
the results to a text file. Keep the rest of the default settings. Add a one-line text box labeled, Name: Insert a scrolling
text box so users can describe how they heard of Diggs & Associates. Provide a check box for next day delivery.
Create three radio buttons to identify new customers, customers who have previously ordered from Diggs, and cus-
tomers who have not ordered in a year. Create a drop-down menu list of Diggs’ products that have been purchased
before. Include, None for new customers.
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10.  Begin formatting your personal Web site. You may want to begin by writing and formatting text. Change the font
to set the tone for your site. Apply bold formatting, or underline or italicize your text. Align it left, right or center. If
you have digital camera photographs, or are able to scan photos, you can add these to your site. You can create text
hyperlinks, image hyperlinks and/or hotspots. You can create an image map to link to the other pages in your Web. If
appropriate, organize information into a table or create a numbered or bulleted list. Decide if you want Hover 
buttons or a marquee for your Home page. Get out the list you created earlier and insert the elements you found
appealing.

11.  Create a form page either from scratch or using the Form Page Wizard. If you use the Wizard, you must deter-
mine what information to extract from the visitor. There are several types of inputs you can collect to get personal
data. You can create radio buttons or check boxes. If you do not use the Wizard, determine what information you
want to gather and compose your questions. Create the appropriate form fields for each question. Some questions
may require text boxes and others a drop-down menu. When you are finished, save the page as, form and title it,
Form. 

Test Yourself
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Skills

After you have designed and formatted your Web, you must 
maintain it. Hyperlinks can be broken, components may be 
malfunctioning, or new links may need to be created. Web site
maintenance includes checking components, verifying that 
hyperlinks are targeted to the correct locations, and ensuring that
visitors can easily navigate the site. 

Other basic tasks you need to learn are how to import Office 
documents, and how to use the Office clipboard. FrontPage Web
pages can be created quickly using a word processing program such
as Word, with which you may be more familiar. Entire documents
can be inserted, or portions of documents can be cut and pasted
onto a Web page.

After you have previewed and tested your Web, it will finally be
time to publish it. Viewing it over the Internet is after all, the final
goal. Updating your Web after a period of time is as easy as 
publishing it.

FP 4.1

PUBLISHING AND
MAINTAINING

WEB PAGES

Creating a Web Hierarchy

Adding a Navigation Bar

Viewing and Printing the Web
Structure

Organizing Files in Folders
View

Verifying Hyperlinks

Renaming Pages and
Changing URL’s

Opening an Office Document
in a Web

Using the Office Clipboard

Publishing a Web

4L E S S O N



O v e r v i e w Creating a Web hierarchy will help you to organize your links. When the structure
or hierarchy of your site has been defined, FrontPage will be able to create
Navigation bars to connect the Web pages. A Web hierarchy, also called a tree dia-
gram, is created in Navigation view. When you create a Web using a Web Wizard
the tree diagram will be automatically constructed.

H o w  To : Use Navigation view to create a Web hierarchy or tree diagram for the Skydiver
Web site.

Open the Index page in the Skydiver Web.

Click the Navigation button      on the Views bar. The Navigation view should
resemble Figure 4-1. The Navigation view shows the Speed Demons page, or the
Index page, and a list of files on the left called the Folder List.

In the Folder List, click and drag the organizational_goals file so that it is 
underneath the Speed Demons page. When you release the mouse button, the 
organizational_goals page is linked to the Index page as shown in Figure 4-2. The
Organizational Goals page is now a child page of the Index page.

Next Click and drag the news page so it is underneath the Index page and next to
the Organizational Goals page. It is thus a child page of the Index page and on the
same level as the Organizational Goals page.

Follow the same procedure until the Local, Table of Contents, and Form pages are
all child pages of the Index page.

Finally click and drag the calendar page so that it is underneath the News page.
Thus the Calendar page will be a child page of the News page. The tree diagram or
Web hierarchy is shown in Figure 4-3.

E x t r a A Web hierarchy organizes the links in a Web. It is a prerequisite to creating
Navigation bars. Navigation bars are rows of buttons or text that link to the other
pages in the Web. Following the tree diagram, Navigation bars will be created to
link the parent page, Index, to every other page except the Calendar page.
Conversely, each of the child pages will link back to the Index page. The Calendar
page will link to its parent page, News.

Most Web pages have lowercase file names.  Lowercase names refer to files, while
uppercase names refer to page titles. Notice that the file names in the Folder List
are lowercase and the page titles in Navigation view are uppercase.

To reorganize the tree, click and drag a page to a different position in the hierarchy.
Observe the line that appears as you drag, and position the page to create the
desired relationship. There is no need to save a hierarchy. FrontPage will reopen a
Web with the last tree diagram you created before exiting the program.

Creating a Web

Hierarchy
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Practice Hot Tip
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FP 4.3

Create a hierarchy so that the
Employment, Best Selling Items, Form,
and Sales pages are child pages of the
Index page. Make the Table of Contents
page a child page of the Best Selling Items
page.

If you create a form page and save the
results to a text file, it will be included in
the Folder List. Do not add it to the 
hierarchy. It will still be part of the Web.

Figure 4-1  Page in Navigation view

Figure 4-2  Home page and child page

Figure 4-3  Web hierarchy

Helps create a
Navigation bar

List of folders and
files in the Web

Parent page

Child page

Home page



O v e r v i e w Navigation bars are rows of text or buttons that allow you to navigate through a
Web. When you create Navigation bars, the links behind them are automatically
produced. Navigation bars can be formatted to enhance Web site attractiveness.

H o w  To : Add Navigation bars to a Web site.

Open the Index page of the Skydiver Web.

Click the Navigation button      on the Views bar. The hierarchy appears in
Navigation view.

Click Format on the Menu bar, you may have to access the extended menu. then
click Shared Borders. The Shared Borders dialog box opens.

Make sure the All pages radio button is selected.

Click the Left check box, then click the Include navigation buttons check box. The
dialog box should now look like Figure 4-4.

Click              . Click the Page view button on the Views bar. Hyperlinks appear on
the left of the Index page. When you move the pointer over one of these links it
turns into     .

Double-click one of the links. The Navigation Bar Properties dialog box opens.

Make sure that the Child level radio button is clicked. Also make sure that the
Home Page and Parent Page check boxes are checked.

Check the Buttons radio button in the Orientation and appearance section, so that
your dialog box looks like Figure 4-5.

Click              . Click the Preview tab. Your page should look like Figure 4-6.

Save the changes. A Save As dialog box will open to save the shared borders in a
new folder in the Web called Borders.

E x t r a You can test the Navigation bars by previewing the Web in a browser. After 
opening the Web in your browser, click the Navigation bars to verify that the target
pages open.

Not all pages will link to each other. The child pages of the Index page link back to
their parent, Home, which is the Index page. The News page links to its parent
page, Index, and its child page, Calendar.

A Navigation bar can also be inserted by clicking Insert from the Menu bar and
selecting the Navigation Bar command. The properties are then set in the
Navigation Bar Properties dialog box.

Adding a Navigation

Bar
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Create a Navigation bar in the Caddy Shop
Web. Make it a horizontal bar and use text
links rather than buttons. Save the
changes.

After they have been clicked, hyperlinks
change color. Hyperlink text colors can be
modified by accessing the Background
dialog box from the Format menu. You
cannot access this feature however, if a
theme is applied.

Figure 4-4  Shared Borders dialog box

Figure 4-5  Navigation Bar Properties dialog box

Figure 4-6  Page with Navigation bar

Preview of where
the Navigation bar
will appear

Preview of which pages
contain which hyperlinks

Navigation bar with buttons
and links specified in earlier
dialog boxes



O v e r v i e w When you are in the process of designing a Web, having a hard copy of the site
structure can sometimes be useful. If you are creating a site for someone else, an
outline of the proposed structure can demonstrate the progress you are making, or
serve as a visual aid in presentations. FrontPage enables you to print the tree dia-
gram directly from Navigation view.

H o w  To : View a Web's hierarchy in Navigation view and print a hard copy.

Open the Index page of the Skydiver Web.

Click the Navigation button      on the Views bar.

Click the white box      at the bottom of the Speed Demons page in Navigation
view. The hierarchy collapses, as shown in Figure 4-7.

Click the new box      to expand the hierarchy.

Click File on the Menu bar, then click Print.

The Print dialog box opens, as shown in Figure 4-8.

Make sure you have the correct printer selected. Then click              .

A copy of the navigation structure should print.

Exit the application. Save any changes to the print settings you might have made.

E x t r a The Print Preview command is also found on the File menu. You may have to
access the expanded menu to find it. The Print Preview command enables you to
view the tree diagram, as it will look when printed. Once you know its parameters,
you can make the necessary changes to ensure that it prints properly. You can
change the page orientation to Landscape, in the Features tab of the Print dialog
box, using the Properties button. This may be necessary to ensure that it fits on one
page. You can also return to Page view and select the Page Setup command from
the File menu. The margins can be adjusted in the Print Page Setup dialog box.
Orientation and paper size can also be altered in the Print Page Setup dialog box
using the Options button.

Viewing and

Printing the Web

Structure

L e s s o n  4  • P u b l i s h i n g  a n d  M a i n t a i n i n g  W e b  P a g e s

FP 4.6

1

5

6

4

2

3

7

9

8

Skill



Practice Hot Tip
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Print two copies of the navigation structure
of the Caddy Shop Web.

Click Properties, in the Print dialog box, to
change everything from page orientation to
graphical resolution.

Figure 4-7  Web hierarchy collapsed

Figure 4-8  Print dialog box

Icon represents
home page

Identify printer

Print only
specified pages

Specify number
of copies



O v e r v i e w As additional files and folders increase the size of your Web, some basic 
organizational skills become essential. Some file organization can be done in
Navigation view, but the majority is done in Folders view. These basic skills include
moving, renaming, and sorting files.

H o w  To : Move one of the files from your Web site into a folder, rename another file, and
sort the files by size.

Open the Index page of the Skydiver Web.

Click the Folders button      on the Views bar.

Click and drag the bd05680_.gif image file from the Contents window of the screen
to the images folder in the Folder List section of the screen, as shown in Figure 4-9.

Right-click the file fphover.class. This is one of the Hover button files. Click
Rename from the shortcut menu.

The name of the text becomes highlighted. Type hoverbutton.class, and press the
[Enter] key. A warning dialog box appears, asking you if they should update the
hyperlinks affected by the name change, as shown in Figure 4-10. Click              .

Click the title heading Size in the Contents window, click the title. The files will be
sorted in ascending size order, as shown in Figure 4-11. Click it again and the files
will be sorted in descending size order.

Save the changes.

E x t r a You can view and modify file properties by right-clicking a file, and selecting
Properties from the shortcut menu. The Properties dialog box allows you to change
page titles, view the size and modification dates of files, add comments to the file,
and assign the file to a workgroup.

Organizing Files in

Folders View
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In the Caddy Shop Web, rename the image
file you inserted earlier to caddy.gif. Then
move it to the images folder. Finally, sort
the files by the Modified Date.

To view the contents of a folder in the
Folder List, click the plus sign     next to
that folder.

Figure 4-9  Folders view

Figure 4-10  Rename warning dialog box

Figure 4-11  Files sorted by size

File being moved by
clicking and dragging
to new folder

Number of hyperlinks that
are affected by renaming file

Files sorted by size
from smallest to largest

Contents window



O v e r v i e w Hyperlinks are one of the most important elements in a Web. If hyperlinks are 
malfunctioning, Web visitors will be unable to navigate the site. A broken hyperlink
may disallow a user from viewing the page they require. Incorrect target names,
changed file names, or changed or incorrect URL’s can cause broken hyperlinks.
There are several ways to verify hyperlinks. Earlier, we tested them in a browser.
Now, we will use Reports view and Hyperlinks view to verify hyperlinks.

H o w  To : Make sure that all of the hyperlinks in your Web are inserted and working 
properly.

Open the Index page in the Skydiver Web.

Click the Reports button      on the Views bar.

The Site Summary opens, as shown in Figure 4-12.

Notice that the summary reveals no broken hyperlinks. It does however, reveal one
unlinked file. Double-click the Unlinked files row in the Site Summary.

The file that is unlinked is fphoverx.class. It is an important Hover button file, so
you do not need to make any changes to it.

Click the Hyperlinks button      on the Views bar. An icon for the file you were just
looking at appears unlinked on the screen.

Click the Index page in the Folder List. All of the hyperlinks to and from the 
Index page are displayed, as shown in Figure 4-13. Links to the page you are view-
ing appear on the left, and links from that page appear on the right.

Click the News page from the Folder List. There are two links from the Index page
and one link from the Calendar page. The News page links to the Index page and
the Calendar page.

E x t r a Hyperlinks can be repaired manually by opening the pages containing the faulty
hyperlinks and either repairing or deleting them. They can be repaired using the
Recalculate Hyperlinks command in the Tools menu. The Recalculate Hyperlinks
dialog box informs you that the command will repair the hyperlinks in your Web,
update the components, including shared borders and Navigation bars, and 
synchronize Web data.

Verifying Hyperlinks

L e s s o n  4  • P u b l i s h i n g  a n d  M a i n t a i n i n g  W e b  P a g e s

FP 4.10

1

5

6

4

2

3

7

8

Skill



Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 4.11

Verify that all of the hyperlinks in the
Caddy Shop Web are functional. Repair
them if necessary.

Clicking the plus sign    in the upper-left 
corner of the page icon in Hyperlinks view
expands the diagram. The left side displays
the links to that page, and the right side
displays links from that page.

Figure 4-12  Reports view

Figure 4-13  Hyperlinks view

Displays files that
have no links

Displays statistics and
status of hyperlinks in
the Web

Describes specified
report

Links from the
Index page

Links to the
Index page



O v e r v i e w Two other important file management tasks are renaming pages and changing
URL’s. Earlier we changed the file name of a page but not its title. In this skill we
will change the page title and the URL. Distinctive titles are important for both the
Web author and the Web site visitor. If page names are too similar, distinguishing
between them can become problematic. In the sample Web, a second form page
should be given a distinctive title so that the Web designer does not make errors
creating links and the Web site visitor is able to navigate to the correct page.

H o w  To : Rename and change the URL of one of the pages in the Skydiver Web to improve
the site's structure.

Open the Index page in the Skydiver Web.

Click the Navigation button      on the Views bar.

Right-click the Speed Demons page icon, click Rename from the shortcut menu.

The title is highlighted. Type Home, and press the [Enter] key.

Right-click the Index page in the Folder List, and click Rename from the shortcut
menu.

The file name is highlighted. Type home.htm. Press the [Enter] key. Click Yes in the
Rename dialog box to update the pages so that links will not be broken.

Right-click the Home page icon again. Click Properties from the shortcut menu.
The Properties dialog box should look like Figure 4-14.

In Navigation view the Home page should now look like Figure 4-15.

Return to Page view and save the changes.

E x t r a You can also change the URL in Page view. Right-click an empty area on the page
and click Page Properties from the shortcut menu. Type the desired URL in the
Base location: text box in the Page Properties dialog box. This is not necessary in
the exercise above because changing the file name will change the URL.

You should check Reports view after changing a URL to verify that no hyperlinks
were broken.

If you save a file under a new name, the old file will still exist. If the file is not
deleted, it can disrupt file management. Both file names will be in your Folder List
and you may accidentally create a link to the obsolete version.

Renaming Pages and

Changing URLs
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 4.13

Change the title and file name of the Index
page in the Caddy Shop Web to Home,
and home.htm respectively.

You can access the Rename and
Properties commands to make changes to
the URL or page title, by right-clicking the
file icon, or the page icon, in any of the 
different FrontPage views.

Figure 4-14  Properties dialog box

Figure 4-15  Change reflected in Navigation view

File name changes
are reflected in
location and URL

File size equals
how much memory
the file takes up

New name is
immediately used
for this page



O v e r v i e w Many Microsoft Office programs allow you to save documents in HTML format
and open pages in your default browser. Office documents can be imported and
published in a Web. Almost all Microsoft created documents can be imported into
a FrontPage Web.

H o w  To : Open a Microsoft Office document, in this case a Microsoft Word document, in
FrontPage.

Open Microsoft FrontPage. Do not open any Webs, begin with a blank page.

Click Insert, then click File. The Select File dialog box opens.

Click the Files of type: drop-down list and click Word 97-2000 (*.doc), as shown in
Figure 4-16.

Locate your FP Data Files folder.

Locate and click document FPHowto4-9.

Click              . You may have to install this feature from your Office 2000 CD-
ROM.

The Word document opens, as shown in Figure 4-17.

Save the page in My Documents as wordfile.

E x t r a You may have noticed when you accessed the Files of type: drop-down list, that
Word documents are not the only files that can be inserted into a Web Page. You
can insert Rich Text Format (RTF) documents, Plain text (TXT or ASCII) files,
Excel worksheets, or Lotus1-2-3 worksheets, WordPerfect 5.x and 6.x, Works 4.0,
Word for Macintosh, and HTML documents.

Instead of cutting and pasting, or reentering data, importing allows you to take 
previously saved documents in various formats and convert them to HTML.

Opening an Office

Document in a Web
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 4.15

Insert FPPrac4-11 from your FP Data Files
into a Web page. Save the file as 
insertword.

When the document opens in FrontPage, it
has been converted to HTML and is now a
Web document.

Figure 4-16  Select File dialog box

Figure 4-17  Word document

Lists the formats that
can be inserted into
FrontPage Webs

Page can be viewed
in all three formats



O v e r v i e w The Office Clipboard is a new feature of Office 2000. It enables you to save up to
twelve pieces of data from any Office program to the clipboard. Clipboard items
can be pasted into other programs or used within a single application. Data is sent
to the clipboard using the Cut and Copy commands. After it is saved to the 
clipboard, the Paste command is used to insert it into the various programs.

H o w  To : Copy and paste data from another program to FrontPage with the aid of the Office
Clipboard.

Locate your FP Data Files folder and open FPHowto4-13.

Microsoft Word opens to a meeting agenda. Click View on the Menu bar, highlight
Toolbars and click Clipboard from the submenu. The Office Clipboard opens.

Scroll down the document until you reach the Agenda section of the 
document. Highlight the entire Agenda section beginning with Ad Campaign and
ending with State of the Club.

Click Edit on the Menu bar, then click Copy. That section of the text is sent to the
Office Clipboard, as shown in Figure 4-18.

Close Microsoft Word. You may be asked if you want data on the clipboard to be
available for use in other programs, if so click .

Open FrontPage, and open the News page from the Skydiver Web.

Type Monthly Meeting Agenda. Press the [Enter] key.

Click Edit on the Menu bar, then click Paste.

Save the changes. This page should now look like Figure 4-19.

E x t r a There is also a Paste Special command on the Edit menu, you may have to access
the extended menu to reach it. The Paste Special command on the expanded Edit
menu enables you to paste data onto the clipboard in different formats. You can
create one paragraph, break it into several paragraphs, turn it into formatted para-
graphs, add line breaks, or simply treat the data as HTML.

The Office Clipboard can not be viewed in FrontPage.

Using the Office clipboard, you can copy and paste the portions of a document you
need, rather than importing the entire document.

Using the Office

Clipboard
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Practice Hot Tip
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FP 4.17

Open FPPrac4-15. There is only one line of
text. Copy it from Word and paste it at the
bottom of the Home page in the Caddy
Shop Web.

You can also cut, copy and paste data
within the FrontPage program. If you place
something incorrectly, or put it on the
wrong Web page, you can cut it and paste
it to the correct location.

Figure 4-18  Office Clipboard

Figure 4-19  Data pasted into FrontPage

Data copied
from Word

Purges the clipboard
of all data

Data inserted
directly from Word



O v e r v i e w When you create a Web site, the goal is to get it published. You can publish directly
to a Web server using FrontPage. New pages can be published and existing ones
can be changed with ease. If you find mistakes, or have a page that requires 
continuous updating, just edit your original files and republish. The changed files
will automatically replace the existing ones.

H o w  To : Publish your Web so that it can be viewed as a Web site.

Open FPHowto4-17 in FrontPage from your FP Data Files folder. Save it as
table_of_contents in your Skydiver Web. When a dialog box asks you if you want
to replace the file of the same name, click .

Click File, on the Menu bar and click Publish Web, you may have to access the
extended menu to find the Publish Web command. The Publish Web dialog box
opens.

Click              .

In the Specify the location to publish your web to: text box type C:/My
Documents/Published Skydiver Web. Make sure the Publish all pages radio button
is selected, as shown in Figure 4-20. Click              .

A dialog box will open telling you that one of the components on your pages will
not work unless it is copied to a Web server with FrontPage extensions installed.
Click              .

The files begin copying to the necessary folder, as shown in Figure 4-21.

When it finishes a dialog box opens telling you that your Web has been published
successfully, as shown in Figure 4-22.

Click the link to view the published Web. All the objects and all the links should
work properly now that the Web is published.

Close the browser, and click              , then close FrontPage.

E x t r a Before you publish your Web with a server, you will need several pieces of 
information. You will need to get the address of your Web server, and an assigned
name for your Home page. You will also need to find out if they have FrontPage
extensions. In some cases, in order to be viewed, components require that your
Web server have this special Microsoft software installed. If your Web server does
not have FrontPage extensions, you may be able to get the address of an FTP, or
File Transfer Protocol, server to circumvent this problem. Your Web server will also
give you folder information, such as, what folder they want you to upload to, and
how they want your Web files to be organized. Once you have published the Web,
you can publish individual pages, or the entire Web again to continually update it.

Publishing a Web
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Practice Hot Tip
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FP 4.19

Publish the Caddy Shop Web to C:/My
Documents/Caddy Shop Web Final.

Many Web servers require you to join their
online communities and choose a user
name and password. You will be required
to enter them when you publish your Web.

Figure 4-20  Publish Web dialog box

Figure 4-21  Publishing a Web

Figure 4-22  A Web published successfully

Progress bar, displays
how much of an
action is completed

File being published

Link to new published
Web site



FP 4.20

L e s s o n  4  • P u b l i s h i n g  a n d  M a i n t a i n i n g  W e b  P a g e s

Shortcuts
B u t t o n / M o u s eF u n c t i o n

Copy

Cut

Paste

Folder List

Print

Publish Web

Page View

Folders View

Reports View

Navigation View

Hyperlinks View

Tasks View

M e n u
Click Edit, then click
Copy

Click Edit, then click
Cut

Click Edit, then click
Paste

Click View, then click
Folder List

Click File, then click
Print

Click File, then click
Publish Web

Click View, then click
Page

Click View, then click
Folders

Click View, then click
Reports

Click View, then click
Navigation

Click View, then click
Hyperlinks

Click View, then click
Tasks

K e y b o a r d
[Ctrl]+C

[Ctrl]+X

[Ctrl]+V

[Ctrl]+P

[Alt]+P



Test Yourself

a. Shared Borders

b. Reports

c. Office Clipboard

d. Recalculate hyperlinks

e. Insert

f. Hard copy

g. Print Preview

h. Tree diagram

i. URL

10. A Web hierarchy is also known as

11. You can add a Navigation bar to your Web pages using this command

12. A printed reproduction of a computer screen

13. When your hyperlinks are broken use this command

14. A Web address

15. What view should you use to make sure that all your files and links work 
properly

16. This holds up to twelve pieces of data

17. Access this menu to open an Office document in FrontPage

18. Allows you to view what a page will look like when it is printed

FP 4.21
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I d e n t i f y  K e y  F e a t u r e s

Figure 4-23  Skydiver Web in FrontPage



Test Yourself

19.  You must use this view to create a Web hierarchy:

a. Reports

b. Hyperlinks

c. Tasks

d. Navigation

20.  A list of files and folders appears in:

a. Tasks view

b. Folder List

c. Reports view

d. Hyperlinks view

21.  When you insert a file from another program you
must use this dialog box:

a. Insert Document

b. Select File

c. Insert Data

d. Insert

22.  To prevent people from sabotaging sites that are not
theirs, most Web servers require:

a. A user name and password

b. A computer ID number

c. A coded entry language

d. A keyword or secret phrase

23.  One method you can use to format hyperlinks is to
access:

a. The Hyperlinks menu

b. The Background dialog box

c. The Foreground dialog box

d. The Page Properties dialog box

24.  You can use these two commands to take data from
one document and insert it into another:

a. Copy and Insert

b. Cut and Insert

c. Cut and Place

d. Copy and Paste

25.  Once an Office document has been opened in
FrontPage it is converted to:

a. FrontPage speak

b. Java

c. HTML

d. Applet

26.  Clicking the plus sign, in Navigation view and
Hyperlinks view, performs this function:

a. Expands the diagrams

b. Contracts the diagrams

c. Expands the menu

d. Contracts the window

FP 4.22
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Test Yourself
1.  Create a Web hierarchy:

a. Open the Water Taxi Web.

b. Switch to Navigation view. Click and drag files from the Folder List so that they are child pages of the Index
page.

c. Make the Form page in the Water Taxi Web a child page of the Fees page.

2.  Create a Navigation bar:

a. Create a Navigation bar on the Index page that links to all of its child pages.

b. Make sure there is a link from the child pages back to the Index page.

c. Also make sure there is a link from the Fees page to the Form page.

d. Make the links in the Navigation bar text rather then buttons.

3.  Print the Web structure:

a. Open the Water Taxi Web in Navigation view.

b. Print the structure of the Web.

4.  Verify your hyperlinks:

a. Open the Water Taxi Web in Reports view. 

b. If there are broken hyperlinks, repair them with the Recalculate Hyperlinks command.

c. Make sure that files that need to be linked are linked.

d. View the Web in Hyperlinks view to make sure all of the pages are linked properly.

5.  Open an Office document in a Web:

a. Open FPTest 4 in FrontPage.

b. Save it as Resume.

6.  Publish a Web:

a. Open the Water Taxi Web.

b. Publish the Web to C:/My Documents/Watertaxiweb.

c. After it is published, view the Web.

FP 4.23
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Test Yourself

FP 4.24
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7.  Your work at Diggs & Associates is almost finished. Your job does not include composing all the text. You are to
train a group of Diggs employees to finish creating and maintain the site. They will complete any additional pages
following the design, theme, color scheme, and style you have devised. Before you are finished, you must create a
Web hierarchy, and Navigation bars. The Index page, of course, will be at the top of your hierarchy. The Search,
Feedback, Contents and all other pages will be child pages of the Index page. After you have completed the tree 
diagram, create Navigation bars. Use button hyperlinks for your Navigation bars. They should link from the Index
page to each child page, according to the hierarchy you created. Each child page should in turn, link back to the
Index page. Demonstrate your progress to Diggs’ executives by printing several copies of your Web structure. View
the Web in Folders view and if necessary, move image files to the image folder and rename files.

8.  Verify the hyperlinks in the Diggs Web. First view the Web in Reports view. Make sure none of the necessary files
are unlinked. Also make sure there are no broken hyperlinks. If any of the hyperlinks are broken use the Recalculate
hyperlinks command to fix them. Rename all of the pages so that thy are easier to organize. Rename any similarly
titled pages. For example, the Services pages need distinct names rather than Service 1, Service 2, etc. This will enable
Diggs’ employees to locate particular pages for editing.  Finally publish the Web to C:/My Documents/Diggsweb.

9.  Continue working on your personal Web. First, create a Web hierarchy. If you used a wizard to create your per-
sonal Web, this was done automatically. If you added pages to a Home page, or formatted several pages and linked
them together however, you will need to either edit or create a tree diagram. If you decide to add Navigation bars,
make sure they complement your chosen style. Print the Web structure and view the Web in Folders view. Reorganize
files and folders if necessary. 

10.  View the Web in Reports and Hyperlinks views to verify the hyperlinks. Thoroughly navigate your Web as a final
check that all links are functional. Make sure all file names, URL’s and page names are correct. If you want to put
poetry or fiction that you have written, or a resume, on your site, import the documents from your word processing
program. If you promote it, prospective employers or publishers might discover and view your Web site. Use the
Office Clipboard to insert a table, or a block of text from another program. Remember to save imported documents
and make sure they are linked to your site. Finally, publish the Web. If you have a URL and a Web server, and are
confident that your site is ready, you can publish it with your Web server. If not, publish it to C:/My Documents/(file
name), as we did in the lesson.



Skills 5

Formatting Web pages includes more than formatting text,
changing colors, applying themes, and adding hyperlinks. You
will want to control many other variables as you become more

comfortable with creating Webs. FrontPage includes many compo-
nents you can add and features you can use to make your Web
pages both visually intriguing and functional.

You have already learned how to insert an Office document into a
Web. Now you will learn how to import an Office document so
that it inherits the style and theme of your Web. You can also
import Web pages and images. Imported Web pages are also auto-
matically converted to the style and theme of your Web. When you
import images and save them in your Web, they are converted to
one of the two image file formats supported by most browsers. You
can format your images to add to the aesthetic appeal of your Web.
In this lesson you will learn how to add a three-dimensional effect
called a bevel to an image. You will also learn how to add text over
an image.

It can become counterproductive to make multiple formatting
changes to many different blocks of text. Instead, you can use the
Format Painter to copy all paragraph and character formatting from
one paragraph to another. In a few short steps, you can easily create
uniform paragraphs or identically formatted blocks of text.

FrontPage also allows you to add features that will make your Web
more functional and informative. Among these are hit counters and
search forms. You will learn how to insert these advanced compo-
nents. You will also learn how to apply special effects that run as
one page disappears and another loads. Finally, you will learn to use
a powerful formatting tool, cascading style sheets, to position ele-
ments on your Web page. Experienced Web authors believe that cas-
cading style sheets will eventually replace tables as the layout device
of choice for HTML pages.

FP 5.1

ADVANCED
FORMATTING

L E S S O N

Importing and Converting Text

Importing Web Pages

Importing Images

Advanced Image Formatting

Placing Text over an Image

Using the Format Painter

Inserting a Hit Counter

Creating a Search Form on a
Web Page

Formatting Web Page
Transitions

Using Style Sheets



O v e r v i e w You can import many different types of files into your Web. Imported text is 
automatically converted to HTML. You can use documents you have already 
created to easily construct Web pages. Importing text is easier than copying and
pasting full documents. Furthermore, unlike inserted documents, imported 
documents are converted to the style and theme of your Web.

H o w  To : Import a schedule of events into the calendar page of the Skydiver Web.

Open the calendar page in the Skydiver Web.

Click File on the Menu bar. Click Import on the File menu. The Import
dialog box opens.

Click             . The Add File to Import List dialog box opens.

Locate and open your Student Files folder. Click the MS Word document calendar. 
Click              . The file appears in the Import dialog box, as shown in Figure 5-1.

Click              . The file has been imported into your Web.

Click Insert on the Menu bar. Click File on the Insert menu. The Select File dialog
box opens. Locate your Skydiver Web. Double-click to place it in the Look in: list
box.

Click the Files of type: drop-down list arrow. Scroll to the top of the drop-down
menu. Click All Files on the drop-down menu.

Click the calendar Word document to select it. Click              . The text is 
converted to HTML format. It is also converted to the style and theme of your
Web. The imported document is displayed in Figure 5-2.

E x t r a You can also import files and link to them from a Web page, rather than inserting a
file on a page. Simply create a hyperlink on your Web page. The target of the
hyperlink will be the name of the file. If the file to which you are linking has been
imported to your Web folder, the link will work properly. 

To quickly import a file or a selection of files, you can drag them to the Folder List
from the Windows Explorer program.

Importing and

Converting Text
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Practice Hot Tip
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FP 5.3

Import the MS Word document FPPrac 5-1
to your Caddy Shop Web. Insert the text
from that document on the bottom of the
home page.

These documents and file types can be
imported and converted to HTML: MS
Word, RTF (Rich Text Format) documents,
TXT (plain text or ASCII) files, worksheets
from MS Excel and Lotus 1-2-3, and
WordPerfect 5.x and 6.x documents.

Figure 5-1  Using the Import dialog box

Figure 5-2  Imported text converted to HTML

File being
imported

Import additional
files to Web

Import a folder to
a Web

Modifies the loca-
tion of a file within
a Web



O v e r v i e w If you have already created or have access to finished Web pages, you can easily
import them. Importing will convert the Web pages to the style and theme of the
current Web. You can import individual pages or entire Web folders that are stored
on your computer, LAN, or the World Wide Web. This is particularly useful for a
company that uses the same Web page on several different sites.

H o w  To : Import a previously created skydiving frequently asked questions Web page into the
Skydiver Web.

Open the home page from the Skydiver Web.

Click File on the Menu bar. Click Import on the File menu. The Import dialog box
opens.

Click              to open the Add File to Import List dialog box.

Locate your FP Data Files folder. Open the FPHowto5-4 folder. Click faq.htm to
select it.

Click              . The FAQ page is added to the Import dialog box as shown in
Figure 5-3.

Click              . The file has been imported.

Open the FAQ page. This is displayed in Figure 5-4.

Right-click faq.htm in the Folder List. Select Properties on the shortcut menu. Type:
FAQ, to replace the highlighted default text in the Title text box. Click              .

Click the Navigation button      on the Views bar. Click and drag faq.htm from the
Folder List to the tree diagram. Place it below the Table of Contents page. Return
to Page view. Save the FAQ page.

E x t r a You can import Web pages directly from the Internet by clicking             . This
opens the Import Web Wizard. You will be required to enter the Web site address
of the page you want to import. You can also import a published Web from your
local network with the Import Web Wizard. After specifying the address, you can
control how much information you download and how long it will take. When you
finish, the Web page will be imported to your Web.

It is important to note that although you can easily import Web pages that others
have created to your own Web, you should not do so unless you have permission.
Otherwise you may violate copyright law.

Importing Web

Pages
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Practice Hot Tip
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FP 5.5

Import a page of your choice from the
Skydiver Web to your Caddy Shop Web.

You can click         to add an entire folder
to your Web. This is useful for adding a
folder of images or other files to your Web.

Figure 5-3  Import dialog box

Figure 5-4  Imported page converted to your Web style

URL of the file
you are importing

Allows you to
import elements
from the Internet

Text is automatically
converted to the style
of your Web



O v e r v i e w You can import images to your FrontPage Web that you have stored on your 
computer or found on the World Wide Web. When you import images, store them
in the images folder. This way they will be in a central location where you can 
easily use them more than once. This will be convenient for graphics such as logos
that you will use on multiple pages.

H o w  To : Import an image from another Web that was created previously and store it in the
images folder in the Skydiver Web.

Open the news page in the Skydiver Web.

Click File on the Menu bar. Click Import on the File menu. The Import dialog box
opens.

Click Add File to open the Add File to Import List dialog box. Locate your FP Data
Files folder.

Double-click to open the FPHowto5-4 folder. Open the images folder. Select
plane.wmf.

Click              . The plane image is added to the Import dialog box, as shown in
Figure 5-5.

Click              . The file is imported to your Web.

Click Insert on the Menu bar. Move the pointer over Picture on the Insert menu.
Click From File on the submenu.

The Picture dialog box opens. Click plane.wmf to select it.

Click              . The image is inserted into the news page, as shown in Figure 5-6.

Save the news page.

E x t r a You can click               to change the location to which the file will be imported.
Enter a new file location within your Web, or rename the file in the Edit URL
dialog box. You may want to change the file name or store imported files with 
similar names in different folders to avoid confusion.

Another advantage of importing and inserting an image is that it will be converted
to GIF or JPEG format. When you format the image (as you will see in the next
skill), you will have to save the embedded file. The image you just inserted will be
converted to GIF format.

You can also create a thumbnail or small version of your image. With the image
selected, click the Auto Thumbnail button on the Pictures toolbar. The thumbnail
replaces the full-sized image on the Web page. Visitors can click the thumbnail to
view the full-sized image.

Importing Images
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 5.7

Import the money image from FPHowto5-4
to your Caddy Shop Web.

Importing images does not automatically
add them to your Web page. It simply
means you are getting them onto your site
so you will be able to easily access them.
You must insert images to place them in
your pages.

Figure 5-5  Importing an image

Figure 5-6  Imported image inserted into a Web page

WMF, Windows
MetaFile, the format
clip art is in



O v e r v i e w You can apply many different effects to your pictures, including beveling. Beveled
borders give images an elevated, three-dimensional appearance. You can also resize
your graphics to tell the Web browser how to display them. These image formatting
tools will help you to design lively Web pages.

H o w  To : Resize a graphic and use the Bevel command to create a three-dimensional frame
effect around the image.

Open the news page.

Click on the image. The image is selected and surrounded by sizing handles. The
Pictures toolbar opens.

Move the pointer over the sizing handle on the lower-right corner of the image. The
pointer turns into a resizing arrow     .

Click and drag the bottom-right corner to the upper-left until the entire table at the
bottom of the page is visible. Your page should now look like Figure 5-7.

With the image still selected, click the Bevel button      on the Pictures toolbar.

The image has been beveled, as shown in Figure 5-8.

Save the news page. Click               to save the embedded image.

E x t r a You can make modifications to the bevel effect on the image. Clicking on the Bevel
button      multiple times will add depth to the frame. You can continue to click the
Bevel button      until you get the effect you want. If you do not like the depth of
the frame, use the Undo button       to reverse the effect you have just applied.

When you resize graphics, use a corner sizing handle to maintain the proportions of
your image. If you use a side handle, the image will be distorted. When you
decrease the size of an image, it will take up a smaller area in the browser window,
but the file size and download time will not be changed. To decrease the file size,
click the Resample button on the Pictures toolbar after you have resized the image.
The file size will be reduced to match the smaller image size.

Advanced Image

Formatting
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 5.9

Insert the money image on one of your
pages in the Caddy Shop Web. Resize until
you like the size. Then, bevel the image.
Click the Bevel button until you get the
effect you like. Then save the page.

You can click the down arrow button next
to the Undo button to access a list of your
most recent actions. You can undo multiple
actions back to and including the first
action you performed.

Figure 5-7  A resized image in FrontPage

Figure 5-8  A beveled image in FrontPage

Sizing handles

Frame effect created
from beveling the image



O v e r v i e w You can also insert text over the top of an image. Placing text over an image allows
you to label your graphics or add a title to give an image a magazine-cover look. A
graphical table of contents, image map, product advertisement or logo may also
benefit from the merging of text and images.

H o w  To : Place text over the image you inserted previously on the news page.

Open the news page.

Click the image to select it.

Click the Text button      on the Pictures toolbar at the bottom of the screen. A text
box appears at the center of the image.

Type Skydiver News. Your page should look like Figure 5-9.

Click the down arrow button next to the Font Color button        on the Formatting
toolbar. Click the black square in either the Standard Colors palette or the Theme
Colors palette.

Click in the center of the text box and drag it to the upper-left corner until it will
not go any further.

Move the pointer over the right midpoint-sizing handle, so the pointer turns into a
horizontal resizing arrow        . Click and drag to the left until only the word
Skydiver is visible.

Next, move the pointer over the bottom midpoint-sizing handle, so the pointer
becomes a vertical resizing arrow   .

Click and drag the bottom sizing handle until the word News is visible.

Click outside the image to deselect the text box. Your page should look like 
Figure 5-10.

Save the news page.

E x t r a If the image you inserted is in GIF format, the text box will immediately open in
the center of the image. If the image is in JPEG format, FrontPage will prompt you
to convert it to GIF. Text is not supported in the JPEG format. Click               to
convert the image to GIF. If the image is in a different format such as BMP or
WMF you will be prompted to save it as a GIF when you save the page.

You can format text over an image the same way you format any other text. You
can use the Formatting toolbar to change the alignment, color, size, font, and other
attributes of the text.

Placing Text over 

an Image
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 5.11

Place the text: Caddy Shop over the
money image you inserted in the previous
practice section. Format the text so it is
visible against the background of the
image.

If you increase the size of text placed over
an image, you will be required to increase
the size of the text box. You can do this by
clicking and dragging the sizing handles
until all the text is visible.

Figure 5-9  Text placed over an image, unformatted

Figure 5-10  Text placed over an image and formatted

Text is unformatted
and barely visible
over the image

Formatted text
is visible and fits
the image



O v e r v i e w You can format large blocks of text quickly and easily using the Format Painter.
You can make multiple formatting changes with just a few clicks of the mouse.
Rather than selecting many different formatting commands to achieve a uniform
result, you can copy all the character formatting from one block of text and apply
it to another.

H o w  To : Use the Format Painter to change the formatting of sections of text on a Web page.

Open the home page.

Move the pointer over the text: A National Organization for those who live on the
edge. Highlight the text, as shown in Figure 5-11.

Click the Format Painter button      on the Standard toolbar. The pointer changes
to a Format Painter pointer     .

Click the Navigation button      on the Views bar. Double-click the Calendar page
to open it.

Move the pointer to the beginning of the first date listed, Monday Nov. 1,1999.
The I-beam changes to a Format Painter I-beam      .

Highlight the date. The format of the text has been changed to the format you
copied from the home page.

With the first date still highlighted, click the Format Painter button      again.

Now, highlight the next date, Thursday Nov. 18, 1999.

Follow the same procedure to format all the dates on the page. When finished, your
calendar page should resemble Figure 5-12.

Save the calendar page.

E x t r a You can also use the Format Painter to copy and paste a hyperlink. To copy 
multiple links from one hyperlink, simply select the desired hyperlink. Then, 
double-click the Format Painter button      and highlight all the pieces of text which
you want to link to the original target. Both the format and the target of the 
hyperlink will be copied to the selected pieces of text.

You can also copy all paragraph formatting including style, alignment, and indent
from one paragraph to another. When you select a paragraph and click the Format
Painter button     , both the paragraph and character formatting are copied. You
can quickly create identical paragraphs on your Web pages.

Using the Format

Painter
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 5.13

Use the Format Painter to copy the format
from text on one Web page and paste it to
another page in the Caddy Shop Web.

To copy the desired format to several loca-
tions, double-click the Format Painter
button. When you have finished pasting
the desired format to different pieces of
text, click the Format Painter button again
to deactivate the Format Painter.

Figure 5-11  Highlight the format to be copied

Figure 5-12  Copied format pasted to another Web page

Once the desired
format is selected,
click the Format
Painter button

Format copied and
pasted from home page



O v e r v i e w One fun element you can add to your Web site is a hit counter. A hit counter is an
interactive tool that is used to track the number of visitors to your site. Web mas-
ters often use hit counters to maintain a record of how many hits a Web site
receives over a certain period of time.

H o w  To : Add a hit counter to your home page.

Open the home page.

Place the insertion point at the end of the word edge in the last line of text at the
bottom of the page. Press the Enter key.

Type: You are visitor number. Then, press the Enter key.

Click Insert on the Menu bar. Move the pointer over Component on the Insert
menu. Click Hit Counter on the submenu that appears.

The Hit Counter Properties dialog box opens, as shown in Figure 5-13.

Click the third radio button next to the hit counter with the red numbers.

Click              .

If you publish your Web with the Microsoft Personal Web Server or with a server
that has FrontPage Server Extensions, it will look like Figure 5-14.

Save the home page.

E x t r a The Microsoft Personal Web Server for Windows NT and Windows 95 can be
downloaded from the Microsoft Web site. If you are using Windows 98, you can
install it from your program CD-ROM. To install it, click Start and select the Run
command. In the Open list box, type: E:\add-ons\pws\setup.exe (where E is the let-
ter of your CD-ROM drive). Next, you will have to install the FrontPage Server
Extensions onto the Personal Web Server. Close FrontPage. Click Start and high-
light Programs. Highlight Microsoft Office Tools and click Server Extensions
Administrator to open the Microsoft Management Console. Close the Tip of the
Day. Click the plus signs in front of FrontPage Server Extensions and your comput-
er name. If anything is listed in front of your computer name, right-click it and
highlight Task. Click Remove Server Extensions. Leave the check on Preserve Meta
information. Right-click your computer name and highlight New. Click Web to
open the Server Extensions Configuration Wizard. If you are asked to choose, high-
light Microsoft Personal Web Server and click Next. When you are asked for your
SMTP server, either use your real information or enter the TCP/IP loop back
address, 127.0.0.1. Complete the steps of the wizard and click Finish. Close the
console and save the settings when prompted. Open FrontPage. Open the File menu
and click Open Web. In the Folder name list box, type: http://localhost. Click
Open. You should now be on the Personal Web Server and have full functionality.

Inserting a Hit

Counter
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 5.15

Add a hit counter to the home page in the
Caddy Shop Web.

You must publish your Web to a server that
has FrontPage Server Extensions for your
hit counter to be visible on the Internet.

Figure 5-13  Hit Counter Properties dialog box

Figure 5-14  Hit counter on a Web page

You can create a cus-
tom image to use as a
hit counter

Customize when your
hit counter resets

Customize the number
of digits on a hit
counter



O v e r v i e w Visitors to your site may want to quickly access a specific piece of information. You
can create a search form to help them find what they want. The user types a word
or phrase into a text box, presses the Search button, and a list of items that match
the topic appears. Search forms are most useful on large Web sites where related
information is found on many different pages.

H o w  To : Add a search form to your home page so visitors can locate specific information in
your Web.

Open the home page.

Place the insertion point one line below the table on your home page.

Click Insert on the Menu bar. Move the pointer over Component on the Insert
menu. Click Search Form on the submenu that appears. You may have to open the
extended submenu to find the Search Form command. The Search Form Properties
dialog box opens, as shown in Figure 5-15.

In the Label for Input text box, type: Find:.

In the Label for “Start Search” button: text box delete Start, so only the word
Search remains.

Click              . The Search Form is added to your home page.

Click the Preview tab at the bottom of the screen. Your screen should look like
Figure 5-16. Close the home page and save the changes when prompted.

E x t r a A search form, like many FrontPage components, must be published with a
FrontPage compliant server. You can publish your Web with the Personal Web
Server to test it on your local computer. When the search form is published, users
can type keywords and the server will return a list of pages. Each item on the list
will be a hyperlink to a page containing a match to the keyword.

On the Search Results tab in the Search Form Properties dialog box, you can click
the Display score check box to include the score for each match with the list of
hyperlinks. A higher score will indicate a closer match.

You can make the one-line text box on a search form longer or shorter. Right-click
the search form and click Search Form Properties on the shortcut menu. Change the
number in the Width in characters text box. The visitor can still type as many 
characters as necessary. The extra characters will scroll off the left end of the text
box, but the complete text will be submitted to the server.

Creating a Search

Form on a Web Page
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 5.17

Add a search form to the home page in
your Caddy Shop Web.

You can also create a search form using
the Search Page template in the 
New dialog box.  Replace the boilerplate
text to customize the new page. Use the
Save As command to save the search
page in your Web when you are finished.

Figure 5-15  Search Form Properties dialog box

Figure 5-16  Search form in Preview mode

Labels for the Search
button and the button
that clears the text box

Searches Web
for keywords

Clears keywords
from the text box

Type text to
search for in
the text box



O v e r v i e w FrontPage also includes special effects you can add as one page disappears or
another page loads. Page transitions will make your Web site resemble a
PowerPoint slide show. These animations can add spark to your site. Attractive
page transitions will impress your visitors as they enter and leave your Web pages.

H o w  To : Format the page transitions in your Web.

Open the home page.

Click Format on the Menu bar. Click Page Transition on the Format menu. You
may have to open the extended menu to find the Page Transitions command.

The Page Transitions dialog box opens, as shown in Figure 5-17.

Click the Event: drop-down list arrow. Click Page Exit to select it.

In the Duration (seconds): text box type: 3.

In the Transition Effect: list box click Wipe right to select it.

Click              . Save the home page.

Click the Preview tab at the bottom of the screen. You will only be able to view the
page transition on the Preview tab if you have Internet Explorer 4.0 or above
installed on your computer. If you do not have IE 4.0, preview the page in a Web
browser that supports DHTML.

Click one of the hyperlinks in the table on the home page. For three seconds the
home page will slide to the right as the new page enters. This is displayed in 
Figure 5-18.

Close FrontPage and save all your changes when prompted.

E x t r a Some page transition effects are created using Dynamic HTML (DHTML).
Unfortunately, Internet Explorer 4 and Netscape Navigator 4 use two different
forms of DHTML. Special effects you create using FrontPage DHTML may not
appear in Netscape Navigator.

To add a page transition effect to a specific page element, select the page element
and open the Format menu. Click the Dynamic HTML Effects command. On the
DHTML toolbar, select Page load in the On list box. Select the animation effect
and setting in the Apply and Effect list boxes. You will learn more about DHTML
effects in Lesson 7.

Formatting Web

Page Transitions
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 5.19

Open the home page in your Caddy Shop
Web. Create a page transition for exiting
pages in your Web. Make sure the duration
is long enough that the effect will be 
visible.

You must make the duration long enough
that the effect is visible but short enough
that it doesn’t bore visitors. 

Figure 5- 17  Page Transitions dialog box

Figure 5-18  A page transition in effect

Choose the effect
you like best

There are different
events you can use
animations for

New page

Exiting page



O v e r v i e w The W3C or World Wide Web Consortium, which is responsible for the official
HTML standards, developed the Cascading Style Sheet system. You can use this
powerful tool to position Web page elements and design page layouts. A style sheet
is a collection of style rules that allow you to precisely fine-tune how your pages
will look. As older browsers become obsolete, Web designers believe CSS, which
separates the HTML content of a page from its presentation, will become the 
standard in Web page design.

H o w  To : Use a style sheet to arrange items on your news page.

Open the news page in the Skydiver Web.

Right-click the image on the page. Click Picture Properties on the shortcut menu.
The Picture Properties dialog box opens.

Click              . The Modify Style dialog box opens.

Click             . Click Position on the menu. The Position dialog box opens.

In the Wrapping style section, click the Right icon.

In the Positioning style section, click the Relative icon. The dialog box should look
like Figure 5-19.

Click               to close the Position dialog box. Click               twice more to close
the Modify Style and Picture Properties dialog boxes.

The style sheet has rearranged the location of items on the Web page, as shown in
Figure 5-20.

Close FrontPage. Save the changes when prompted.

E x t r a There are two types of style sheet positioning: relative and absolute.  When you use
absolute positioning, you place an element at an exact location on the page. You
designate the (x, y) coordinates of the top left corner of the element relative to the
top left corner of the page (0, 0) to position the element. When you use absolute
positioning, elements are not part of the text flow. Instead, they will appear in front
of or behind the text flow. Do not use absolute positioning with DHTML, because
you may not be able to control the results. Relative positioning places elements at a
fixed point within the text flow. The element is moved the designated distance
down and to the right from where it would normally appear on the page, rather
than from the edge of the page. With relative positioning, the position of the ele-
ment will adjust to the flow of the rest of the page. You can use style sheets to posi-
tion any element on a Web page including tables, lists, and graphics. Style sheet
rules, including positioning, are not supported by older browser versions. For a
cross-platform, cross-browser layout, use tables to position your page elements.

Using Style Sheets
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 5.21

Use style sheets to modify the page you
inserted the money image on earlier.
Change the positioning, and the way the
text is wrapped around it.

In the past, you had to write the style
sheet code. Using FrontPage 2000, you can
apply absolute or relative positioning using
the familiar Windows interface, and
FrontPage will create the style sheet code
for you.

Figure 5-19  Position dialog box

Figure 5-20  Items reconfigured with style sheets

Relative and absolute
positioning are new
style sheet features

Specific coordinates and
dimensions are used for
absolute positioning

Text wrapping can also
be modified with style
sheets
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Shortcuts
B u t t o n / M o u s e M e n u

Click Edit, then click
Undo

Click Edit, then click
Redo

Click Insert, then
move the pointer over
Component

Click Format, then
click Page Transition

K e y b o a r d
[Ctrl] + [Shift] + C

[Ctrl] + [Z]

[Ctrl] + [Y]

F u n c t i o n
Format Painter

Undo last action

Redo last action

Font Color

Insert Component

Page Transition



Test Yourself

a. Format Painter

b. keywords

c. relative

d. bevel

e. Dynamic HTML

f. Pictures toolbar

g. Hit counter

10. A special effect that makes an image appear as if it is in a frame

11. The command buttons to bevel an image and place text over it are found here

12. Allows you to format large blocks of text quickly and easily

13. Tracks how many visitors have been to your Web site

14. A search form looks for these on a Web site

15. This is used to create some page transition effects

16. One of two types of positioning with style sheets
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I d e n t i f y  K e y  F e a t u r e s

Figure 5-21 Using style sheets in FrontPage



Test Yourself

17.  One of the advantages of importing text from 
another document rather than simply opening it in a
Web page is:

a. Imported text is automatically linked to the 
document it is imported from

b. Imported text is automatically converted to the
style of your Web

c. Imported text is more fun than opening an office
document

d. Importing text takes up less memory

18.  To import a Web page from the Internet you must
first:

a. Click Add File in the Import dialog box to open
the Add File dialog box

b. Click Open in the Import dialog box to open the
Open File dialog box

c. Click From Web in the Import dialog box to open
the Import Web Wizard

d. Click From Web on the File menu to open the
From Web Wizard

19.  When you click Modify in the Import dialog box:

a. You will erase all the files you are importing

b. The Edit URL dialog box opens

c. All files are converted to HTML format

d. All files are converted to JPEG format

20.  Clicking the Bevel button on the Pictures toolbar 
multiple times will:

a. Undo the bevel effect

b. Open the Bevel dialog box

c. Make no changes

d. Add depth to the frame

21.  The essential function of the Format Painter is to:

a. Copy and paste the format of a block of text

b. Copy and paste a block of text

c. Move a block of text

d. Erase a block of text

22.  In order for hit counters and search forms to be 
visible on your Web pages you must:

a. Make sure the HTML code is correct

b. Publish them to a server which is FrontPage 
compliant

c. Make sure you have the Windows NT Personal
Web Server

d. Publish them to a Windows NT server
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Test Yourself
1.  Import text to your Web site:

a. Open the Information page in the Water Taxi Web.

b. Open the Import dialog box from the File menu.

c. Open the Add File to Import List dialog box.

d. Import the MS Word document, Water Taxi Calendar, to your Web from the Student Files folder.

e. Use the Select Field dialog box to insert the Word.doc on the Information page. Save your changes to the
Information page.

2.  Import Web pages to your Web site:

a. Open the Import dialog box from the File menu.

b. Open the Add File to Import List dialog box.

c. Import the FPTest 5 Web page to your Web from the Student Files folder.

d. Rename FPTest 5.htm, faq.htm. Change the page title to FAQ. Add it to the Web hierarchy underneath the
Information page.

3.  Import an Image to your Web site:

a. Open the Import dialog box from the File menu.

b. Open the Add File to Import List dialog box.

c. Import the Watertaxi.bmp image from your Student Files folder. Insert the image on the Index page between the
table and the slogan. Center the picture, and save the changes to the Index page.

d. Save your changes to the Index page.

4.  Use advanced formatting tools to format an image:

a. Open the Image page in the Water Taxi Web.

b. Click the image to select it and open the Pictures toolbar.

c. Click the Bevel button three times. If you don’t like this effect click the Undo button to reverse it.

d. Save your changes to the Image page.

5.  Place text over an image:

a. With the Index page still open and the image still selected, click the More Contrast button.

b. Click the More Brightness button several times. Then, use the Less Brightness button to get the desired effect.

c. Resize the image in any way you want.

d. Switch to Folders view and move all the images to the Images folder.
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Test Yourself
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6. Use the Format Painter to format text:

a. Open the Index page in the Water Taxi Web.

b. Open the Calendar page in the Skydiver Web.

c. Use the Format Painter to copy the format of the text in the first cell of the table on the calendar page. Paste the
format to all the hyperlinks on the the Index page in the Water Taxi Web. Double-click the Format Painter 
button so you can easily format the text in both the table and the navigation bar in the left shared border.

d. Save your changes to the Index page.

7.  Insert a hit counter:

a. Use the Insert Component button on the Standard toolbar to insert a hit counter on your Index page in the
Water Taxi Web.

b. In the Hit Counter Properties dialog box, select a style of hit counter, how many digits will be on the hit
counter, and when it will reset.

c. If you have installed the Microsoft Personal Web Server, publish this Web to test the hit counter.

d. Save your changes to the Index page.

8.  Create a search form:

a. Use the Insert Component button on the Standard toolbar to insert a search form on the Index page in the
Water Taxi Web.

b. Accept the default settings in the Search Form Properties dialog box.

c. If you have installed the Microsoft Personal Web Server, publish this Web to test the search form.

d. Save your changes to the Index page.

9.  Format the page transition:

a. Open the Page Transitions dialog box from the Format menu.

b. Select Page Exit in the Event: drop-down list. Type: 3 for the duration. Select your own transition effect.

c. Preview the transition to make sure it works correctly.

d. Save your changes to the Index page.



Test Yourself
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10.  You have several more tasks to complete for your Diggs & Associates Web site. Use style sheets to arrange the 
elements on your pages. Open the Index page. Locate the table you inserted and formatted in the previous lessons.
Use the Table Properties dialog box to access the Position dialog box. Use relative positioning to position the elements
on your page. Regardless of the changes you make to the page above or below them, the layout of the positioned 
elements will stay the same.

11.  Use your advanced formatting skills to format all the pages in the Diggs & Associates Web site. First, find and
insert a clip art image related to the publishing industry. Bevel the image. Click the Bevel button several times to add
depth to the frame. If you don’t like it, use the Undo command. Place the text Diggs & Associates, over the image.
Locate a block of text with character formatting you like, and use the Format Painter to copy the formatting to a
block of text on the Index page. Create a Search form on the Index page. If you have installed the Microsoft Personal
Web Server, publish the Web locally to show your employers.  Save all your changes.

12.  Use some of the advanced formatting techniques you just learned on your personal Web site. Begin by adding a
hit counter to your Index page. Remember to choose a hit counter from the Hit Counter Properties dialog box that
fits with the general theme and style of your Web. Some hit counters may not look good with the colors you may
have chosen. If you are operating a business Web site, you may want a more conventional hit counter or none at all.
If you have many pages in your Web, add a search form to help visitors find information on your site.

13.  Use the Page Transition command to format the page transitions for your Web. Either choose an effect that can
be viewed by multiple browsers or one that fits your target audience. Do not create an effect that does not fit the style
and theme of your Web. For example, a Web site dealing with a serious topic should not have frivolous effects. On
the other hand, if your Web is geared towards technological innovation, choose an effect that will impress users.





Skills

As you have seen, tables can be easily added to Web pages and
are perfect for organizing and presenting information in a
visually attractive and organized way. Innovative Web

designers have learned to use tables to expand the page layout pos-
sibilities. You can modify, format and integrate text and images in
tables to create sophisticated Web pages.

Before you can design novel page layouts using tables, you must
learn some basic tasks. You will learn how to draw a table directly
onto your Web page. Then you can use the menu commands or the
new Tables toolbar to adjust and format it to meet your specifica-
tions. You can insert rows or columns to add information to your
table, delete unnecessary cells, divide cells in half, or combine select-
ed cells and merge them into a single cell.

You will also learn how to create special borderless cells that extend
the entire width of a table. These cells, called captions, can provide
a heading for your table or an instructive note at the bottom of a
table. Captions share the background color you have applied to
your table and are generally used to provide a descriptive title. A
caption can tell visitors to your site how to use the table and the
data it contains.

You can also convert text you have already composed and format-
ted into a table. Tables give structure to an existing page. You can
then split or merge cells, equalize the width and height of selected
rows or columns, or change the size of certain cells to design a truly
innovative page. You can also remove a table format and convert a
table back to text if it will improve your page design.

FP 6.1

MODIFYING
TABLES

Deleting Table Rows and
Columns

Drawing Table Rows and
Columns

Resizing Table Cells

Merging Table Cells

Converting Text into a Table

Inserting Captions

6L E S S O N



O v e r v i e w You may have to modify a table after it has been created. One way to modify a
table is to delete rows and columns. You can delete rows and columns to delete
information from a table, save space, or enhance the appearance of your Web
pages.

H o w  To : Delete a row from the table on the home page in the Skydiver Web.

Open the home page in the Skydiver Web. Scroll down until the table is visible.

Move the pointer over the left border of the table, so it becomes a selection arrow
pointing to the bottom two cells of the table. 

Click to select the bottom two cells. Your table should look like the one in 
Figure 6-1.

Click Table on the Menu bar.

Click Delete Cells on the Table menu.

The cells are deleted, as shown in Figure 6-2.

Click the Undo button       .

Save the home page.

O v e r v i e w To delete a column rather than a row, move the pointer over the top border of the
table until it becomes a down-pointing selection arrow    . Make sure it is pointing
at the column you want to delete. Click to select the column, then click Delete Cells
on the Table menu, as you learned earlier.

You can also add and delete single cells from your table. This can produce an
unusual visual effect for data that is not strictly tabular in nature. Above or below
the single cell there will be an odd-looking blank space that is neither a cell nor
available space. By default, cells are added to the right of a left-aligned table and to
the left of a right-aligned table. To insert a single cell in a left or center-aligned
table, click in the cell that you want to be on the left of the new cell. Open the
Table menu, highlight Insert and click the Cell command. To delete a single cell,
click in the cell you want to remove. Open the Table menu, highlight Select and
click the Cell command. The cell you want to remove will be highlighted. Then,
click the Delete Cells command.

Deleting Table Rows

and Columns
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Practice Hot Tip
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Delete the the right-hand column on the
table on the home page in the Caddy Shop
Web. When you have finished, undo the
action and save the page.

You can also use the Delete Cells button
on the Tables toolbar to delete a single cell.
First, select the cell using the Cell com-
mand on the Select submenu.

Figure 6-1  A selected table row

Figure 6-2  A table after a row is deleted

All the cells must be
selected to delete an
entire row or column

The space and alignment on
the page is altered by the
deletion of rows and columns



O v e r v i e w You can also customize tables by drawing rows and columns. Drawing rows and
columns in a table allows you to create uneven spacing in your tables. You can use
the Draw Table pencil and the Eraser tool to experiment with unusual page layout
designs.

H o w  To : Expand the table on the home page to include enough cells to accommodate links
for the rest of the pages in the Web.

Open the home page in the Skydiver Web. Scroll down until the table is visible.

Click Table on the Menu bar.

Click Draw Table on the Table menu.

The Tables toolbar opens, as shown in Figure 6-3.

The Draw Table button      is depressed. The pointer has turned into a pencil   .

Move the pointer near the top border of the table, at the end of the words
Organizational Goals.

Click and drag down until you reach the bottom of the table. A dotted line appears
to display where the new cell borders will be. This process is shown in Figure 6-4.

The column that existed before is moved to the left of the new column.

Repeat the same procedure with the column on the far-right of the table. Your table
should now look like the one in Figure 6-5.

Save the changes to the home page.

E x t r a To deactivate the Draw Table function, click the Draw Table button      on the
Tables toolbar. The pointer will return to normal. The Eraser button      will 
activate the eraser tool, which you can use to remove any unwanted borders
between cells. Click the Close button to close the Tables toolbar when you are 
finished.

You can also use the Draw Table feature to create a table from scratch. Simply
click and drag the pointer to create a table which has the dimensions you want.
This will simply create a large table with one cell. Follow the steps outlined above
to add cells to the table.

To draw a row in a table, draw a line where you want the cell border to be, 
vertically rather than horizontally.

To automatically fit tables and rows in relation to one another after you have
drawn them, use the AutoFit button      on the Tables toolbar.

Drawing Table Rows

and Columns
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Practice Hot Tip
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Add a row to the table on the home page
in the Caddy Shop Web. Make the new
row border run through the top row of the
table. Save your changes to the home
page.

Clicking the Insert Rows and Insert
Columns buttons on the Tables toolbar
automatically inserts rows and columns
evenly. Use one of these commands if you
want all the cells to have an equal amount
of space.

Figure 6-4  Drawing a column in a table

Figure 6-5  A customized table

Figure 6-3  Tables toolbar

Eraser

Insert Rows Insert Columns

Delete Cells

AutoFit

Fill Color

Distribute
Columns EvenlyDistribute

Rows Evenly

Align Bottom

Center
Vertically

Align Top

Dotted line marks
where new column
will be located



O v e r v i e w As you learned earlier, cells automatically expand as you add content. If you want
cells to occupy a certain percentage of the table, however, you can define the size of
your cells. You can specify how many rows or columns a cell will span. You can
also set the width and height of cells in pixels or as a percentage of the table. These
are excellent tools for emphasizing or de-emphasizing certain cells in a table.

H o w  To : Resize the cells in the table on your home page.

Open the home page in the Skydiver Web. Scroll down until the table is visible.

Right-click in the cell that contains the words Organizational Goals.

Click Cell Properties on the shortcut menu that opens. This opens the Cell
Properties dialog box, as shown in Figure 6-6.

In the Columns spanned: spin box, click the up arrow button          once to change
the number to 2. The selected cell will now span 2 columns instead of one.

In the Rows spanned: spin box click the up arrow button          once. This will
change the number in the text box to 2.

Double-click in the Specify width: text box to highlight its contents.

Type 25. This will increase the width of the cell.

Click              .

Save the changes to your home page. Your table should look like the one in
Figure 6-7.

E x t r a You can also use pixels to specify the cell width. Click the In pixels radio button
next to the Specify width: text box. This allows you the most control over the
width of the cell. Pixels are units that are used to form images. They are the small-
est units of a video display such as the display on a 
computer monitor. Specifying a measurement in pixels specifies the area an object
will occupy on your computer display.

If you size a cell in pixels, the cell size will not change regardless of the size of the
table.  If you set the width and height of a cell as a percentage of the overall table,
the cell size will change in accordance with the size of the table.  If you would
rather have the cells automatically size themselves depending on the content,
remove the check from the Specify width check box.

To change the dimensions of the entire table, right-click to open the Table
Properties dialog box. If you set table size as a percentage of page size, the table
dimensions will change according to the size of the browser window. If you set the
width and height in pixels, the size of the table will not change with the page size.

Resizing Table Cells
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Select one cell from the table on the home
page in the Caddy Shop Web. Use the Cell
Properties dialog box to manipulate the
size of that cell. Once you have found a
size you like, save the changes.

To even out the available space between
rows or columns, use the Distribute Rows
Evenly and Distribute Columns Evenly

buttons on the Tables toolbar. To reopen
the Tables toolbar, open the View menu,
highlight Toolbar and click Tables.

Figure 6-6  Cell Properties dialog box

Figure 6-7  A resized table cell

Specify the dimensions of
a cell by making it span
multiple rows or columns

Click this radio
button to specify
the cell width in
pixels

Cell has more than
doubled in size by
spanning 2 rows
and 2 columns



O v e r v i e w You can use the Merge Cells command to combine two or more adjacent cells.
You can merge cells to create larger available spaces to insert graphics or simply to
eliminate empty cells. You can merge several cells in one column and leave the cells
in the other columns divided to create an attractive table design.

H o w  To : Merge several cells in the table on your home page.

Open the home page in the Skydiver Web. Scroll down until the table is visible.

Click in the cell that contains Recent News and drag the pointer up so both the
bottom and top cells are selected.

Click Table on the Menu bar.

Click Merge Cells on the Table menu. The cells are merged, as shown in Figure 6-8.

Follow the same procedure for the next two columns. When you are finished your
table should look like the one in Figure 6-9.

Save the changes you made to the home page.

E x t r a You can also use the Tables toolbar to merge cells. Select the cells you want to
merge just as you did in the exercise. Then click the Merge Cells button      on the
Tables toolbar.

There is also a command on the Tables toolbar that allows you to split cells rather
than merge them. Splitting cells divides single cells into multiple cells. You can split
cells into multiple rows or columns. Select the cell(s) in the table you want to split.
Click the Split Cells button      on the Tables toolbar. This opens the Split Cells dia-
log box, shown in Figure 6-10 below. Choose whether to split the cells into rows or
columns. Use the Number of columns: spin box to set the number of times to split
the cell and click              .

Merging Table Cells
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Figure 6-10  Split Cells dialog box

Select to split
rows and
columns

Select number
of times to
split cells
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As you did in the How To: section, merge
the cells that contain text with cells next to
them that are empty on the home page in
the Caddy Shop Web.

To organize your table more efficiently, you
may want two blocks of text to share the
same cell. Two cells that contain text can
also be merged.

Figure 6-8  Two cells merged into one

Figure 6-9  Table after cells have been merged

Cell has been
merged so now one
cell occupies 2 rows

The table structure has
changed due to the
merging of several cells



O v e r v i e w You can also convert text you have already inserted and formatted into a table. The
text must be delimited or separated using characters such as commas and 
paragraph markers. FrontPage will format the table so that all the text fits properly.
You can use this feature to create interesting page layouts including one-celled
tables that contain various blocks of text on a page.

H o w  To : Convert the text on the calendar page into a table.

Open the calendar page in the Skydiver Web.

Click at the top of the page and drag down until all the text is highlighted and
selected.

Click Table on the Menu bar.

Move the pointer over Convert on the Table menu.

Click Text To Table on the submenu that appears.

The Convert Text To Table dialog box opens as shown in Figure 6-11.

Click the Commas radio button to select it. This will specify how your table is
organized.

Click              .

The text is converted into a table. Separate cells are created at each comma. Your
table should now look like the one in Figure 6-12.

Save your changes to the calendar page.

E x t r a You can also convert a table to text. Click anywhere in the table and open the
Table menu.  Move the pointer over Convert and click Table To Text on the 
submenu. You can perform this procedure on any table or use it to reverse a text to
table conversion.

HTML does not directly support tab characters so you might run into problems if
you use them as your text delimiter. If your text does not contain separator 
characters, you will have to type them in where you want to divide your text into
columns. When you use any delimiter other than paragraph to separate the text, a
new column is created at each separator character and the paragraph markers 
automatically signal the end of each row. If you separate the text at each 
paragraph, a new row will be created at each paragraph marker and there will be
only one column.

Converting Text into

a Table
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In Lesson 5 you inserted text at the bottom
of the home page in the Caddy Shop Web.
Convert this text into a table. Use whichev-
er setting will make the table most attrac-
tive and organized. Save your changes
once you are satisfied.

To create a one-celled table, click the
None(text in single cell) radio button in the
Convert Text To Table dialog box.

Figure 6-11  Convert Text To Table dialog box

Figure 6-12  Text converted into a table

You can organize the
table based on almost
any letter, number,
character, or spacing

A new column has
been created at
each comma and a
new row at each
paragraph marker



O v e r v i e w You can use captions, which are borderless cells, to add a descriptive title to your
table. Captions can also be used to explain the relevance of certain data, the 
contents of the table or to provide instructions on how to use the table. You can
use them to add a disclaimer or simply to leave a message for your visitors.

H o w  To : Add a caption to a table to explain its contents.

Open the home page in the Skydiver Web. Scroll down until the table is visible.

Click anywhere inside the table.

Click Table on the Menu bar.

Move the pointer over Insert on the Table menu.

Click Caption on the Insert submenu.

This process is displayed in Figure 6-13.

Type: Click on a link to read more information about skydiving and the Speed
Demons National Skydiving Organization.

Your table should resemble the table in Figure 6-14.

Save the changes to your home page.

E x t r a A caption can be displayed above or below a table and can be formatted just like
any other text. To place the caption below the table, right-click the caption and
select the Caption Properties command on the shortcut menu. The Caption
Properties dialog box opens, as shown in Figure 6-15 below. Click the Bottom of
table radio button and click              . To change the alignment of a caption, select
the caption and click either the Align Right or Align Left button on the Formatting
toolbar.

Inserting Captions
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Figure 6-15  Caption Properties dialog box

Align the caption
with the table

Modify the style of
the caption text
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Add a caption to the first table on the
home page in the Caddy Shop Web. Align
the caption on the bottom of the table.
Make sure the caption accurately describes
the information contained in the table.

To quickly select a lengthy caption to apply
formatting changes, press the Alt key and
click the caption. The entire caption will be
selected.

Figure 6-13  Inserting a caption on top of a table

Figure 6-14  A caption for a table

The Insert Caption
command

Caption appears in
the style of your Web
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Shortcuts
B u t t o n / M o u s e K e y b o a r dF u n c t i o n

Draw Table

Erase

Insert Rows

Insert Columns

Delete Cells

Merge Cells

Split Cells

Distribute Rows Evenly

Distribute Columns
Evenly

AutoFit

M e n u
Click Table, then click
Draw Table

Click Table, then
move pointer over
Insert, then click Rows
or Columns

Click Table, then
move pointer over
Insert, then click Rows
or Columns

Click Table, then click
Delete Cells

Click Table, then click
Merge Cells

Click Table, then click
Split Cells

Click Table, then click
Distribute Rows
Evenly

Click Table, then click
Distribute Columns
Evenly

Click Table, then click
AutoFit



Test Yourself

a. Merge Cells

b. Split Cells

c. Tables toolbar

d. Caption

e. Cell Properties dialog box

10. Many commands necessary to draw and modify a table appear here

11. Use this to resize a cell in your table

12. This feature allows you to leave visitors a message about your table

13. This command breaks a cell into two equal cells

14. This combines two adjacent cells
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I d e n t i f y  K e y  F e a t u r e s

Figure 6-16  Tables toolbar and table on Web page



Test Yourself

15.  The first thing you must do to delete a column or a
row is:

a. Click Table on the Menu bar

b. Click Delete Cells on the Table menu

c. Select the cells you want to delete

d. Click the Undo button

16.  When you use the Draw Table command to create a
new table the new table will have:

a. 1 cell

b. 2 cells

c. 3 cells

d. 4 cells

17.  Rather than specifying the dimensions of a table
using percentage you can use:

a. Inches

b. Thumbnail

c. Picas

d. Pixels

18.  A pixel is:

a. A type of table that is created using the Draw
Table command

b. A computer display

c. A unit of measurement that is the smallest unit of
a video display

d. The width of a cell

19.  You can only merge cells if:

a. The cells are not next to each other

b. You only select one cell

c. You select cells that are next to each other

d. You select cells from different tables

20.  The Split Cells command:

a. Combines cells that are next to each other

b. Divides a cell into multiple cells

c. Cannot be used unless you buy a special plug-in

d. Is not very useful

21. Converting text into a table and converting a table
into text:

a. Are simple using the Convert submenu on the
Table menu

b. Are both impossible to do

c. Are only useful in other MS Office programs

d. Should only be used in emergencies

22. The text used to create a caption:

a. Must be imported from somewhere else

b. Cannot be formatted after it is inserted

c. Can only be a certain length

d. Can be formatted just like any other text

FP 6.16
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Test Yourself
1.  Delete table rows and columns:

a. Open the Fees page in the Water Taxi Web.

b. Insert a third column on the right-hand side of the table.

c. Undo the previous action when you have finished.

d. Delete the first row from the table.

e. Undo the previous action.

2.  Draw a table row and column:

a. Open the Fees page in the Water Taxi Web.

b. Draw two columns at the far-right of the table.

c. Draw a row at the bottom of the table.

d. Save your changes to the Fees page.

3.  Resize table cells:

a. Open the Fees page in the Water Taxi Web.

b. Select one cell in the table on the Fees page.

c. Resize that cell so it takes up one more row and one more column than it previously did. (Hint: Open the
Cell Properties dialog box.)

d. Save your changes to the Fees page.

4.  Merge table cells:

a. Open the Fees page in the Water Taxi Web.

b. Locate a table cell that has text in it, next to a cell which is empty.

c. Select both cells.

d. Merge the two cells so they become one.

e. Do this until all of the empty cells in the table are gone. You can also use the Select Cell and Delete Cells
commands to delete any extra cells.

FP 6.17
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5.  Convert text to a table:

a. Open the Information page. It contains the Water Taxi Calendar you inserted in the previous lesson. Select the
text.

b. Open the Table menu, highlight Convert, and click the Text to Table command. 

c. Choose commas as your delimiter. Click OK to close the Convert Text to Table dialog box.

d. Format the text in the table. Adjust the cell and table properties in any way you choose.

6.  Insert a caption:

a. Open the Fees page in the Water Taxi Web.

b. Insert a caption on the table.

c. The caption should read: Fares represent the one-way charge per person. Tipping is customary.

d. Format the caption text any way you choose. Save the changes to the Fees page.

7.  Modify the tables on each page of the Diggs & Associates Web site. Begin with the Index page. First, use the
Draw Table command to add two rows and columns to every table. For now these tables will have empty cells, but
you will modify that later. Next, go to all the other pages except the Index page. Make the cell that contains the link
to the Index page larger than all the other cells in each table. After you have resized the Index link cell, remove the
empty cells in the tables. You can either merge cells or delete them, but make sure the cell with the link to the Index
page remains larger than the other cells in the tables.

8.  Next, open the Feedback page. Convert the text on this page into a table. For large amounts of text it is advisable
that you do not use commas to separate the cells in the table. First separate the text at the paragraph markers. If this
makes the table look awkward, use a different method. You may have to create more paragraphs to add rows and use
another delimiter to separate the text into columns. When you have achieved a suitable table format, add a caption
and insert hyperlinks to every page in the Web. Add a second caption to summarize the data in the table and inform
visitors that the links will take them to the other pages in the Web.

9.  Now you will make the necessary modifications to the pages in your personal Web. If you have not created a
table, convert a block text on one of the pages into a table. Even if you think a table is not necessary, just try it. A
table will make your Web pages more organized and attractive. Also, as you learned in the previous chapter, you can
use tables and style sheets to position elements on the Web. If you have any text that may be better served as a table, 
convert it now. You should also add a caption to any table you create. This can be invaluable to site visitors.

Finally, make any necessary modifications to the tables on your Web pages. You may need to delete cells to eliminate
unnecessary space. You can also do this by merging cells. Take advantage of the versatility of the table format to 
organize your page layout. You can merge two adjacent cells containing data to make the information on your page
tighter. You may decide to do the opposite and create more cells. If so, drawing a new column or row will give you
the most control over the final product. You can also use the Split Cells command to divide any cells containing too
much data in half.
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Since text usually carries the main content of Web pages, two
Web management tools you will want to make full use of are
the global spell-check and global find and replace functions.

You can use these tools to perform routine maintenance and to
ensure that your content is accurate, well phrased, and professional.

Another management tool you should become familiar with is 
compatibility targeting. You can target you Web for compatibility
with specific browsers, browser versions, or technologies. However,
if you try to target the widest possible audience by making your
Web compatible with older browsers, you may not be able to use
some of the more advanced features of FrontPage, such as Dynamic
HTML effects and ActiveX controls. As a result, you may want to
set the compatibility of your Web to a higher level, such as browser
versions 4 or above. At the same time, it would probably be wise to
use advanced special effects sparingly so that users with older
browsers can still enjoy your site.

FrontPage also includes tools for organizing the content of your
Web. Two more layout and design options you can choose are
shared borders and frames. In Lesson 4 you learned to add a shared 
border to insert a Navigation bar throughout your Web. You can
also add effects, text, or images that will be shared by all the pages
in your Web. Frames allow visitors to view multiple documents in
the same window. You are probably familiar with the frames pages
used by most search engines. The search form generally appears in
one frame and the results in another. Web designers often put a
multimedia file, Java applet, or inline video clip in a separate frame.
Even Web pages with borderless frames are very recognizable. You
click a hyperlink and part of the page changes while the rest stays
the same. Frames are most often used to construct a functional 
navigation scheme. Generally, a Table of Contents occupies the left
frame and the target of each hyperlink opens in the center frame.
You can also create a no-frames alternative for your visitors who
cannot view frames.
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O v e r v i e w Global find and replace simply means using the Find and Replace command to
change text throughout your Web. For example, you may have to change the 
company name, a product name, or an employee's name that appears on multiple
pages in your Web. The global find and replace function makes it easy to make
wholesale text changes and is a great time saving device.

H o w  To : Use the Global Find and Replace feature to capitalize all instances of the word
Skydiving in your Web. This will prevent you from having to change instance of the
word individually.

Open the home page in the Skydiver Web.

Click Edit on the Menu bar.

Click Replace on the Edit menu. You may have to access the extended menu to find
the Replace command.

The Replace dialog box opens, as shown in Figure 7-1.

Click the All pages radio button in the Find where: section.

Click the Match case check box in the Options: section.

She will only use the beginning of the word, Sky, because she knows that this word
does not occur alone. It only occurs at the beginning of every reference to
Skydiving. Type: sky, in the Find what: text box. Type: Sky, in the Replace with:
text box.

Click              . The Replace dialog box displays a list of pages and the number of
times the word occurs per page, as shown in Figure 7-2. Double-click the first page
in the scrolling list box to begin editing.

Click             . FrontPage makes the replacement. A dialog box opens that says
FrontPage has finished checking the document and asks if you want to save the
document before moving on to the next one. This dialog box is shown in 
Figure 7-3.

Click                . The page is saved and the Replace command moves to the next
page. Continue the same procedure until every page is done. A final dialog box will
open telling you that all the pages have been completed. Click              .

Click the Close button on the Replace dialog box to close it. Then close any pages
that are open in the Skydiver Web, saving changes when prompted.

E x t r a If you do not want to complete the global find and replace now, click              for
each page you want to correct later.  You can create a task for every page on the
list. Tasks help you to manage work that needs to be done in your Web. You will
learn how to use tasks in Lesson 8.

Using Global Find

and Replace
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 7.3

Use the Replace command to make sure
all instances of the word Caddy are 
capitalized. If FrontPage does not find any
corrections that need to be made simply
close the Replace dialog box.

You can click the Up or Down radio 
buttons in the Direction: section of the
Replace dialog box to specify the direction
in which every page will be checked. You
can check from the top to the bottom or
the bottom to the top.

Figure 7-1  Replace dialog box

Figure 7-2  Pages with selected text are listed

Figure 7-3  Continue with next document? dialog box

Red circles mark the pages
that have not been edited

Allows you to search
all the pages in a Web

Matches uppercase and
lowercase in selected text

Searches only for the
exact word specified 

Specifies number of
times selected text
was located

Allows you to find
and replace text in
the HTML code



O v e r v i e w When you work with many pages in a Web, spell-checking them one at a time is no
longer time efficient. You can use FrontPage to run a spell-check on an entire Web.
Like the global Replace command, the global spell-checker will create a list of each
page with an editing task. It will also display how many misspelled words were
found on how many pages. You can easily view each page and correct the errors to
ensure that your site looks professional.

H o w  To : Run a spell-check across the entire Skydiver Web and correct the errors.

Open the home page in the Skydiver Web.

Click the Navigation button      on the Views bar.

Click the Spelling button      on the Standard toolbar.

The Spelling dialog box opens, as shown in Figure 7-4.

Make sure the Entire Web radio button is selected.

Click              .

The Spelling dialog box displays the pages with misspellings, the misspelled words,
and how many misspellings are on how many pages. This is shown in Figure 7-5.

Double-click the Calendar page, which should be the first page with an error on it.
The Spelling dialog box changes to the dialog box displayed in Figure 7-6.

Click              to add the word to the dictionary. At the end of the document, a
dialog box will open asking if you want to save the current document and continue
to the next one. Click                 .

The next document is opened and the spell-checker takes you through the mis-
spelled words. Click              four times. A dialog box opens asking if you want to
save and close the current document. Click              .

Click the Close button to close the Spelling dialog box.

Save the home page.

E x t r a Clicking              will replace the selected word with the word the spell-checker has
suggested.

Clicking              adds the selected word to the custom dictionary.  This will ensure
that the next time the word is used it will not be flagged.

You must click the Spelling button in any view other than Page view to perform a
global spell-check.

Spell-Checking a

Web
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 7.5

Spell-check the Caddy Shop Web. Add any
words that are not in the dictionary but
you know are spelled correctly. Change any
typos or misspelled words.

After the spell-checker has compiled the
list of errors, you can double-click any page
to begin correcting anywhere you want.

Figure 7-4  Checking an entire Web

Figure 7-5  Search across Web is finished

Figure 7-6  Fixing words not in dictionary

Spell-checks
your Web

Adds tasks
to fix errors

Lists the words on
a page that are not
in the dictionary

The number of
misspelled words
on each page

Suggests words
to replace ones
in the Web

Word that does
not appear in
dictionary

The word in the dictionary
that is the closest match to
the misspelled word



O v e r v i e w The Shared Borders command is not only used to add Navigation bars. You can
create other effects that are shared by all the pages in your web. Any graphic, text,
or HTML element can be placed in a shared border and appear on the top, bottom,
or sides of every page in your Web. You can use shared borders to insert a compa-
ny logo or slogan throughout your site.

H o w  To : Add text and page banners to the shared borders so every page in the Skydiver Web
will display them.

Open the home page in the Skydiver Web. 

Right-click the dotted line on the left side of the page.

Click Shared Borders on the shortcut menu.

The Shared Borders dialog box opens.

Click the Top check box. Then, click the Include navigation buttons check box in
the Top section. Your dialog box should look like the one in Figure 7-7. Remove
the check from the Include navigation buttons check box under Left.

Click              . A message box will warn you that changing the settings for the top
or left shared borders will overwrite any content you have added. Click
to overwrite the shared borders. A banner and hyperlinks are added to every page.
Switch to another page to view the Navigation bar in the top shared border.

Return to the home page. Delete the text below the page banner that says, “Edit
the properties for this Navigation bar to display hyperlinks here.” The navigation 
buttons in the top shared border are deleted from all the pages.

Click the comment in the left shared border to select it. Delete the text that
instructs you to replace the comment with your own content. If the Navigation bar
is still in the left shared border, click to select it and press the [Delete} key.

Type: Speed Demons: A National Skydiving Organization.

Your home page should look like the one in Figure 7-8. The text you added will be
visible on every page.

Save the changes you made.

E x t r a You can add graphics to the shared borders as easily as you added text in the How
To: steps above. Place the insertion point inside the border to which you want to
add the graphic. Insert the image just as you would anywhere else on the page. The
image will be added to the shared border and will appear on every page in your
Web.

Using Shared

Borders
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 7.7

Add a banner to a shared border at the top
of your Web pages in the Caddy Shop
Web.

When you use shared borders, you can
only place navigation buttons on the left or
top of the page, but you can manually add
text hyperlinks to the bottom or right
shared border.

Figure 7-7  Shared Borders dialog box

Figure 7-8 Banner and text in a shared border

Each page will
have a page title
banner

You can apply
settings to only
the current page

Deleting the
text that was
here deleted
the navigation
buttons on all
the pages

Page banner is in
the theme and
style of your Web

The text in the
shared border will
appear on every
page



O v e r v i e w One commonly used component is a banner ad. Banner ads are slideshow style pre-
sentations usually used to advertise products. Companies can send images for a
banner ad to a Web master who will post them on the site. You can also use the
Banner Ad Manager to create a special effect that is attractive and fun. You can set
the interval at which the images rotate and add transition effects to create a unique
element for your site.

H o w  To : Use the Banner Ad Manager to make your home page more exciting.

Open the home page in the Skydiver Web.

Place the insertion point in front of the banner that says Home.

Click Insert on the Menu bar. Move the pointer over Component. Click Banner Ad
Manager on the submenu that appears. The Banner Ad Manager Properties dialog
box opens.

In the Width text box, type: 75, to make the banner 75 pixels wide. Double-click in
the Height: text box. Type: 75, to select it as the height of the banner in pixels.

Leave the transition effect. Double-click in the Show each picture for (seconds): text
box. Type: 3.

In the Link to: text box, type: calendar.htm. If you were creating an advertisement,
you would enter the URL of the company whose ad you were going to display.

Click               next to the  Pictures to display: box.  In the Add Picture for Banner
Ad dialog box, shown in Figure 7-9, click the Select a file on your computer 
button      to the right of the URL list box. The Select File dialog box opens.

Locate your Student Files folder. Double-click to place it in the Look in: list box.
Click earth.jpg to select it, and click              . The image is added to the Banner
Ad Manager Properties dialog box.

Click . Click again. Add Fish.jpg to the Banner Ad Manager
Properties dialog box. Repeat the procedure to add the Leopard.jpg image. When
you are finished your dialog box should look like the one in Figure 7-10. 

Click              . To view your banner you will have to preview the Web in a 
browser, as shown in Figure 7-11.

Save your home page. Click               to save the embedded images in your Web.
Two dialog boxes may appear asking if you want to overwrite the previously saved
versions of Shared Borders. Click              .

Adding and

Modifying Banners
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 7.9

Put a banner at the bottom of the home
page in the Caddy Shop Web. Use the
same images you used in the How To:
steps. Change some settings so your ban-
ner is different than the one you created
earlier.

To change the size, transition effect, dura-
tion per picture, or hyperlink for a banner
ad, right-click it and choose Banner Ad
Manager Properties to open the Banner
Ad Manager Properties dialog box.

Figure 7-9  Add Picture for Banner Ad dialog box

Figure 7-10  Banner Ad Manager Properties dialog box

Figure 7-11  Banner ad in a browser

Use this button to
search for images
outside the Web

Dimensions of
the banner

There are several
transition effects
available

Image switches every
3 seconds and links to
the Calendar page



O v e r v i e w One of the newest advances in Internet technology is Dynamic HTML or DHTML.
DHTML can be used to add special motion effects to your Web pages.  DHTML
combines JavaScript, CSS, and internal browser technology to add spice to your
Web pages. Using FrontPage, you can create vibrant animations for text or images
with no knowledge of these programming codes.

H o w  To : Sydney is going to add DHTML effects to her home page in the Skydiver Web to
make it more lively.

Open the home page in the Skydiver Web.

Highlight the text that makes up the marquee (Come fly with us) and the text
Speed Demons on your home page.

Click Format on the Menu bar.

Click Dynamic HTML Effects on the Format menu. You may have to access the
extended menu to find the Dynamic HTML Effects command. The DHTML Effects
toolbar appears, as shown in Figure 7-12.

Click the On drop-down list arrow. Click Page load from the drop-down list. The
Apply box becomes active. 

Click the Apply drop-down list arrow. Click Fly in on the drop-down list.

Click the Effect drop-down list arrow. Microsoft has chosen not to label the Effect
list box. However a ScreenTip identifies it as such. Click From top from the 
drop-down list. Your home page should now look like Figure 7-13.

Click the Preview tab to preview the page. The effect will look something like
Figure 7-14.

Click the Close button on the DHTML Effects toolbar to close it.

Save your changes.

E x t r a You can also use the DHTML Effects toolbar to remove an effect. Simply click the
text or graphic to which you applied the effect. Then, click the Remove Effect but-
ton                   on the DHTML Effects toolbar.

Different effects are available when you select different text, objects, and elements
on your Web page.

To reopen the DHTML Effects toolbar, open the View menu and highlight
Toolbars. Select DHTML Effects on the View Toolbars submenu.

Using Dynamic

HTML Effects
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 7.11

Create a DHTML effect on the caption of
the table on the home page in the Caddy
Shop Web. Choose whatever settings you
like. Save your changes and preview the
page to make sure you like the effect.

Notice that the text you animated is high-
lighted in Page view. To remove the 
highlighting, click the Highlight Dynamic
HTML Effects button     on the DHTML
Effects toolbar.

Figure 7-12  DHTML Effects toolbar

Figure 7-13  A DHTML effect applied to a Web page element

Figure 7-14  Previewing an effect

Choose when
effect will happen

Apply selected
effect

Details for
selected effect

Highlighted area is
affected by DHTML

Text going through Fly
in effect, from the top



O v e r v i e w ActiveX controls are compact computer programs that you can embed in your Web
pages. These controls cause something to happen in response to an action by the
user. Some of the available interactive ActiveX controls are: a media player to run a
video, a calculator, images that change when the visitor moves the pointer over
them, a stock ticker, and an interactive calendar.

H o w  To : Insert an ActiveX interactive calendar in one of your Web pages.

Open the calendar page in the Skydiver Web.

Scroll to the bottom of the page and place the insertion point at the bottom.

Press Enter twice.

Click Insert on the Menu bar.

Move the pointer over Advanced on the Insert menu.

Click ActiveX Control on the submenu.

The Insert ActiveX Control dialog box opens, as shown in Figure 7-15.

Click Calendar Control 9.0.

Click              .

Click the Preview tab at the bottom of the screen to preview the page.

Your page should look like Figure 7-16.

Save your changes to the calendar page and close it.

E x t r a When you use ActiveX controls, many different programs are available. Click
in the Insert ActiveX dialog box to open the Customize ActiveX Control

List dialog box. This is a list of ActiveX programs you can use with the controls
you insert on your pages. To be safe, do not customize your ActiveX 
controls unless you know the program you are selecting or have been instructed to
do so.

To find more ActiveX controls to add to your Web pages, visit, www.activex.com,
or www.browserwatch.com/activex.html.

Inserting an ActiveX

Control
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 7.13

Insert an ActiveX calendar on the home
page in the Caddy Shop Web. If the 
download time exceeds twenty seconds on
a 28.8k modem, create a new calendar
page and insert the control there instead.

To change the dimensions, colors, font,
effects, or style of a control, right-click it
and choose ActiveX Control Properties to
open the ActiveX Control Properties
dialog box.

Figure 7-15  Insert ActiveX Control

Figure 7-16  An ActiveX Control previewed

Inserts a calendar
control

You can view a 
different month
using this calendar

You can view any
year from 1900-2100



O v e r v i e w In order to maximize the number of people who will be able to view your Web site
in its entirety, you can target your Web for compatibility with certain browsers and
technologies. If you target your Web for older browser versions, commands for
components not supported by those versions will no longer be available. You can
choose settings for multiple browsers to ensure that your pages will display proper-
ly for all of your visitors.

H o w  To : Make your Web compatible with multiple browsers so it can be viewed by the 
maximum amount of people.

Open the home page in the Skydiver Web.

Click Tools on the Menu bar.

Click Page Options on the Tools menu.

The Page Options dialog box opens.

Click the Compatibility tab to select it and bring it to the front. This is shown in
Figure 7-17.

Click the Browsers: drop-down list arrow. Click Both Internet Explorer and
Navigator on the drop-down list. This will make your Web work with both
Internet Explorer and Netscape Navigator. These are the two most popular
browsers on the market today.

Click the Browser versions: drop-down list. Click 4.0 browsers and later from the
drop-down list. This will allow you to use some of the more advanced options
available in FrontPage.

You do not want to specify a server right now and all of the options are as you
want them.

The dialog box should look like the one in Figure 7-18. Click              .

The dialog box closes and the options you selected are enabled. You will not be
able to add any options that are not compatible with the settings you chose.

Save your changes.

E x t r a As you select different browsers and different versions of those browsers, the 
available options will change. Many earlier browsers will not support Java, Frames,
Dynamic HTML, and other more advanced options. If you are creating a simple
page, it is not important that you select browsers that support these technologies. If
you are creating a simple page with few special effects, you can target a wider audi-
ence. However, if you want to use many of the advanced components available in
FrontPage, only Internet Explorer users will be able to fully view your site. For
example, ActiveX controls are only supported by Internet Explorer 3.0 and above.

Reaching a Target

Audience
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 7.15

Create settings for browser compatibility
for the Caddy Shop Web. Select Internet
Explorer 4.0 and later as your compatible
browser. Disable the Cascading Style
Sheets and Frames options for your Web.

When you select certain browsers, some
technologies will be excluded. You can tar-
get specific technologies instead of
browsers, but if you override the defaults
for a specific browser or version, your page
may not display properly for those visitors.

Figure 7-17  Compatibility tab on Page Options dialog box

Figure 7-18  Compatible browsers selected

Select browsers
which will be
most compatible
with your Web

Select the browser
versions with which
you want your site to
be compatible

Cascading Style Sheets
enabled and viewable with
compatible browsers

All selected technologies will
be viewed by visitors using
the browsers you selected



O v e r v i e w A frames page is a Web page that divides the browser window into several different
areas. Most frames pages use a layout with divisions on the top and left of the
page. Generally, one or both of the smaller frames will contain navigation controls.
When you click a hyperlink, the target page will open in the main, center frame.
Frames can make your entire site accessible on a single screen.

H o w  To : Create a frames page in the Skydiver Web.

Open the home page in the Skydiver Web.

Click File on the Menu bar. Move the pointer over New. Click Page on the 
submenu that appears. 

In the New dialog box click the Frames Pages tab. Click the Banner and Contents
icon, the first icon in the top-left of the dialog box. Click              . The frames
page is created, as shown in Figure 7-19. 

In the frame on the left, click             . A new page in the theme of the Web is 
created in the left frame

In the center frame, click                  . In the Create Hyperlink dialog box locate
your Skydiver Web. Select the home page. Click              .

Copy the text, Speed Demons, on the top of the home page.

In the top frame, click             . A new page in the theme of the Web is created in
the top frame. Paste the text in the top frame.

Move the pointer over the border of the top frame until it turns into a vertical 
resizing arrow. Click and drag the border down until the words Speed Demons are 
visible. Center the text in the frame if necessary.

Place the insertion point in the left frame. Create hyperlinks to all eight pages in
your Web so that your page looks like Figure 7-20.

E x t r a The method outlined in the How To: steps above will guide you in creating frames
pages. The purpose of a frames page is smooth navigation. Each hyperlink will
open the corresponding page in the center frame while the frames on the left and
top remain the same. The frame with the navigation controls will not change. You
can also create a title, as in the exercise above, that will display no matter what
page the visitor is viewing. Each frame can contain any HTML elements you can
insert in a regular Web page. However, since frames are primarily used to construct
a useful navigational scheme, if you overdo the design elements in the frame with
the navigation controls it will detract from the function.

Although this exercise created a frames page using a page with shared borders
applied, in general, if you use frames to design your page layout you should not use
shared borders particularly those with Navigation bars.

Creating Frames

Pages
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 7.17

Create a frames page in the Caddy Shop
Web. Set the center frame to the home
page. Create a new page on the top. Enter
the words Caddy Shop in the top frame.
Create a new page in the left frame. Create
hyperlinks to the other pages in the Web.

There are many different arrangements for
frames pages available in the Frames
Pages tab of the New dialog box. All
frames pages will function the same way.
They will simply use different layouts.

Figure 7-19  An empty frames page

Figure 7-20  A complete frames page

These frames will
remain constant
while the center
frame changes

Left frame contains
navigation controls
for the frames page

Top frame contains
title for entire Web



O v e r v i e w When you save a frames page, you are actually saving the frames page, which 
contains the instructions for the layout and design of the page, and the rest of the
frameset. The frameset includes all of the individual pages within the frames page.
Any initial pages that have been saved previously will simply be saved with the
whole, but any new pages will have to be saved individually.

H o w  To : Save the Frameset, and the entire frames page in the Skydiver Web.

With the frames page still open, click File on the Menu bar.

Click Save on the File menu. The Save As dialog box opens with the top frame
highlighted in a preview window, as shown in Figure 7-21.

Accept the default name for the top frame. Click                . The top frame is
saved.

The Save As dialog box opens again with the left frame selected. Change the 
file name to menu.htm and the Page title to Menu. Click                .

The Save As dialog box opens one last time with the entire page selected in the 
preview window.

In the File name: text box, type: frame, as the name for the page, as shown in
Figure 7-22. Change the page title to Frame. Click                .

Click the Preview tab at the bottom of the screen.

Click the hyperlink in the left frame that links to the Calendar page. It should look
like Figure 7-23.

Close the Frame page.

E x t r a Do not save the entire frames page as your home page. Always save the frames
page under a new, unique file name. If you save the frames page with the same
name as another file in the Web, your page will not work. Rather than opening the
original page, the hyperlink will target the entire frames page. Essentially you will
have created a frames page within a frames page. For example, in the exercise
above, if you had saved the frames page as home.htm replacing the original file, the
entire frames page would open in the center frame.

Saving Frames

Pages
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Practice Hot Tip

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

FP 7.19

Save your new frames page in the Caddy
Shop Web. Accept the default names for
the left and top frame. Save the entire page
as Frame.

After you have saved your frames page for
the first time, the Save As command will
save the frames page as a whole. Any
changes you have made to the individual
frames will be saved in the corresponding
frame file.

Figure 7-21  Saving the top frame in Save As dialog box

Figure 7-22  Saving the entire page

Figure 7-23  Previewing a frames page

Selected frame in
preview is frame
currently being
saved

All the frames are
selected and saved
as one Web page

Frames stay the
same as center
frame changes



O v e r v i e w As they continue to build a site, Web authors often end up redesigning their pages.
Using FrontPage you can easily remodel any of the predefined frames templates. As
you have seen, you can resize frames to modify your page layout. You can also
delete frames and split frames. You split a frame either horizontally or vertically to
add a new frame to your frames page.

H o w  To : Delete a frame from the Frame page in the Skydiver Web, and then add a frame to
the same page.

Open the Frame page in the Skydiver Web.

Place the insertion point anywhere in the top frame.

Click Frames on the Menu bar.

Click Delete Frame on the Frames menu. The top frame is deleted as shown in
Figure 7-24.

Click the Save button      on the Standard toolbar to save the page.

Place the insertion point in the right frame so it is selected.

Click Frames on the Menu bar.

Click Split Frame on the Frames menu.

The Split Frame dialog box opens, as shown in Figure 7-25.

Click the Split into rows radio button to split the page lengthwise.

Click              .

The frame is split into two, as shown in Figure 7-26. You can click and drag the
frame border to change the size of the frame.

Close the Frame page. Do not save changes.

E x t r a When you deleted the top frame, you did not delete it from the Web. Remember,
the frame was saved in the Web with its own file name. You can easily reuse the
frame as you redesign your page. Simply click in the frame where you
want to use it. Then select the file name, in this case speed_demons.htm, in the
Create Hyperlinks dialog box.

Manipulating

Frames Pages
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Practice Hot Tip
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Delete the top frame in the Frame page in
the Caddy Shop Web. Then, save the page.
Finally add another frame to the page, it
can be a row or column. Close the Frame
page without saving the changes.

You can also use the resizing pointer to
create a new frame. Press the Control key
while you click and drag a frame border.
When you release the mouse button, a
new frame with the Set Initial Page and
New Page buttons will appear.

Figure 7-24  A frame deleted from the page

Figure 7-25  Split Frame dialog box

Figure 7-26  A new frame added to a page

Blue border means
the frame is selected

More of the page is
visible because there
is no frame on top

Previews how the
frame will be split

The frame has been split
into two equal parts.
You can resize the frame
using the pointer



O v e r v i e w Many older browsers and browser versions do not support frames. Some visitors
do not like frames pages and will set their browser preferences to avoid sites that
use them. You do not have to lose potential customers or turn visitors away. You
can create a no-frames alternative to ensure that everyone will be able to view your
site, even those who do not have the browsers needed to view all of your elements.

H o w  To : Create a no-frames alternative for the Frame page in the Skydiver Web.

Open the Frame page in the Skydiver Web.

Click the No Frames tab at the bottom of the screen.

When you create a frames page, FrontPage creates a default no-frames page, as
shown in Figure 7-27.

Place the insertion point at the end of the default no-frames text.

Press the Enter key. Type: Click here to view the no-frames version of this Web site.

Turn the word here into a hyperlink which links to the home.htm page. Save your
changes. Your no-frames page should look like Figure 7-28. You can test it by 
previewing it in a browser that either does not support or is set to not view frames
pages.

Switch to Folders view. Right-click your current home page and click Rename on
the shortcut menu. Type: home-old.htm. Press the Enter key. Click to
update the hyperlinks.

Right-click frame.htm. You now want this to be your home page. Click Rename
and type the original name of your home page, home.htm. Press Enter. Switch to
Navigation view. Change the page title of the Frame page to Home. A parallel 
hierarchy has been created. Return to Page view. Click the Normal tab. Right-click
the banner ad. Click Banner Ad Manager Properties to open the Banner Ad
Manager Properties dialog box. Click .

The Select Banner Ad Hyperlink dialog box opens. Click the Change Target Frame
button      in the Optional section at the bottom of the dialog box. The Target
Frame dialog box opens. Click the main frame in the Current frames page graphic.
Click               to close each of dialog boxes. The banner ad hyperlink will now
open the Calendar page in the main frame.

Open the Organizational Goals page in the main frame. Right-click the hover but-
ton. Click Hover Button Properties. Click             . Click Change Target Frame.
Target the main frame. Click               to close each of these dialog boxes. Save the
changes.

Republish your Web. Click the Publish all pages radio button. Click to
replace all updated files and remove all renamed files. Click to preview your pub-
lished Web. The frames page is now your home page.

Creating No-Frames

Pages
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Practice Hot Tip
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Create a no-frames page for the Frame
page in the Caddy Shop Web. Make sure
the user has the ability to link to your home
page in a non-frames setting.

If you are creating a Web for a corporate
intranet, the Americans with Disabilities
Act (ADA) may require a no-frames 
alternative. Employees who do not use
visual browsers cannot use frames pages.

Figure 7-27  Default no-frames alternatives

Figure 7-28  Link to no-frames version of Web site

Default text offers
no alternatives for
viewing without
frames

Displays HTML
for each frame

Allows you to
specify alternatives
for no-frames
viewing

A link to a no-frames
alternative home page
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Shortcuts
F u n c t i o n
Find

Replace

Spelling

Banner Ad Manager

ActiveX Control

Save

M e n u
Click Edit, then click
Find

Click Edit, then click
Replace

Click Tools, then click
Spelling

Click Insert, then
move the pointer over
Component, then click
Banner Ad Manager

Click Insert, then
move the pointer over
Advanced, then click
ActiveX Control

Click File, then click
Save

K e y b o a r d
[Ctrl] + [F]

[Ctrl] + [H]

[F7]

[Ctrl] + [S]



Test Yourself

a. Shared Borders

b. Banner Ad Manager

c. ActiveX Control

d. Compatibility

e. Dynamic HTML

f. Global Find and Replace

g. Frames pages

h. Entire Web

10. Allows you to search a Web for a specific character or piece of text

11. This tab in the Page Options dialog box allows you to target a browser audience

12. When you add elements to these, any changes will appear on all the changes in
your Web

13. Click this in the Spelling dialog box to check your Web

14. Inserts a slideshow presentation of images to advertise products or Web pages

15. One of the newest advances in Internet technology

16. You could use this to insert a video player on your Web pages

17. A way of letting visitors move smoothly throughout your Web
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Figure 7-29  A frames page in FrontPage



Test Yourself

18.  Click this radio button in the Replace dialog box to
search your Entire Web:

a. Entire Web

b. All Pages

c. Whole Web

d. Current Web

19.  You can select certain advanced options in this sec-
tion of the Compatibility tab of the Page Options
dialog box:

a. Servers

b. HTML Source

c. Technologies

d. General

20.  If a word has been selected by the Spell-checker it
means:

a. Nothing

b. The word must be changed to the suggestion in
the Spelling dialog box

c. You should ignore it

d. It does not appear in the Spelling dictionary

21.  You can create Dynamic HTML effects using this
toolbar:

a. Formatting toolbar

b. DHTML Effects toolbar

c. Special Effects toolbar

d. Advanced Effects toolbar

22.  The following item is not an ActiveX control:

a. Stockticker

b. Banner Ad

c. Video Player

d. Calendar

23.  In order to completely save all the elements of a
frames page you must:

a. Save only the whole page

b. Save only the center frame

c. Save all the frames separately as well as the whole
page

d. Save all the frames separately but not the whole
page

24.  For viewers who cannot or choose not to view pages
with frames you should:

a. Provide a no-frames alternatives

b. Create a whole new Web from scratch

c. Provide alternate Web sites with similar topics

d. Do nothing

25.  You can add a frame to a page using this command:

a. Add Frame

b. Multiply Frame

c. More Frames

d. Split Frame

FP 7.26
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Test Yourself
1.  Use the Global Find and Replace function to search the entire Water Taxi Web:

a. Open the Index page in the Water Taxi Web.

b. Open the Replace dialog box.

c. Replace all occurrences of the word leaving with the word departing.

d. Save your changes.

2.  Change settings in your Web so that you are targeting a specific audience:

a. Open the Index page in the Water Taxi Web.

b. Open the Page Options dialog box.

c. Activate the Compatibility tab in the Page Options dialog box.

d. Set the browsers so that the Web is compatible with Both Explorer and Navigator.

e. Set the versions so the Web is compatible with browsers that are 4.0 and later.

f. Click the ActiveX controls check box in the Technologies section, so you can add an interactive calendar.

g. Save your changes.

3.  Use Shared Borders in the Water Taxi Web:

a. Open the Index page in the Water Taxi Web.

b. Open the Shared Borders dialog box.

c. Add a top shared border, and create a header at the top of the page. Delete the left shared border. Type: Water
Taxi, in the top shared border. Format the header any way you want to complement the site.

d. Add two rows to the table. Add hyperlinks to the table for every page in the Web. Format the text to match the
rest of the table. Leave one cell blank for a page you will add later.

e. Add a Home hyperlink to all the other pages. Add an Up hyperlink for all the pages beneath a parent page other
than Home (ex. FAQ is below Information). Do not add these links in the shared border; they are for the 
no-frames site.

4.  Spell-check the entire Water Taxi Web:

a. Open the Index page in the Water Taxi Web. Switch to Navigation view.

b. Open the Spelling dialog box, and check the spelling in the entire Web.

c. Make any spelling corrections. You can ignore proper nouns or add them to the custom dictionary if you prefer.

d. Save any changes you make.

FP 7.27

I n t e r @ c t i v e L e a r n i n g  S e r i e s  • F r o n t P a g e  2 0 0 0

Te s t  Y o u r  S k i l l s



Test Yourself
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5.  Add a Banner Ad to the top shared border in the Water Taxi Web:

a. Open the Index page in the Water Taxi Web. Place the insertion point in front of the header.

b. Use the boats 1, boats 2, and boats 3 images in your FP Data Files folder. Set the duration for 3 seconds, and
leave the effect set to dissolve. Link the Banner Ad to the Information page, and set the size to 100x100.

c. Save your changes.

6.  Create a Dynamic HTML effect on your Index page in the Water Taxi Web:

a. Open the Index page in the Water Taxi Web.

b. Open the DHTML Effects toolbar.

c. Create an effect on the slogan underneath the image. Select any effect you would like to see on this page.

d. Save your changes.

7.  Insert an ActiveX control on the Reservations page in your Water Taxi Web:

a. Open the Reservations page in the Water Taxi Web. Press [Enter] twice.

b. Open the Insert ActiveX Control dialog box.

c. Insert the Calendar Control 9.0 program on the Index page. Center the calendar on the page.

d. Save your changes.

8.  Create a frames page; save it; modify it, and supply no-frames alternatives in your Water Taxi Web.

a. Create a new frames page in the Water Taxi Web. Make it so there is only one frame on the left.

b. In the left frame, create hyperlinks to the other pages in the Web. In the center frame, set the initial page to the
Index page in your Water Taxi Web.

c. Save the frame with filename menu.htm. Change the page title to Menu. Save the frames page as frame.htm and
change the page title to Home.

d. Add a frame to the top of the page.

e. Delete the frame at the top of the page.

f. Click the No Frames tab at the bottom of the screen. Create a hyperlink on the page that links to the Index
page. The text should read, To view this Web site without frames click here. The word here should be the 
connecting hyperlink.

g. Switch to Folders view. Rename the Index page home-old.htm. Change frame.htm to home.htm. Save all of your
changes to each page. You may have to close FrontPage and click Yes to save each page properly.

h. Open home.htm. Open the Banner Ad Manager. Use the Browse, Change, and Target Frame buttons to 
program the hyperlink to target the main frame. Open the Information page in the main frame. Make sure the
hover button targets the main frame. Save your changes. Click the Preview in Browser command with home-old
open to view the no-frames site.
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Test Yourself
9.  You’ve done some excellent work, but you’re not finished yet. You must finish editing the Diggs & Associates Web
site and add some new elements. First, use the Replace command to change all instances of the word Drama to the
word Plays. Next, use the Spelling feature to spell-check the entire Web. Remember, there may be a lot of proper
names and titles that you’ll have to add to the dictionary. Make sure all the necessary spelling changes are made. Set
the target audience for your browser. Make sure your Web is compatible with both Internet Explorer and Netscape
Navigator. The settings should be at 4.0 browsers and later. Make sure the ActiveX Control check box is selected in
the Technologies section of the Page Options dialog box.

10. Create a banner ad on the Diggs & Associates home page. Use three clip art images that are related to books and
the publishing industry. These images should each appear for a duration of 3 seconds. Add a Dynamic HTML effect
to one of the images in your Web. Your colleagues at Diggs & Associates would like to see the different ways you can
make an image move and choose the one they like best. Insert the ActiveX device, Calendar Control 9.0 on the home
page. Finally, create a frames page for the Diggs Web. Create a frame on the left with hyperlinks to all the other pages
in the Web. In the main frame, set the initial page to the home page. Make sure you create a no-frames alternative.
Save the frame and the frames page under the default file names.

11. Now open your personal Web. Apply any of the layout options, or insert any of the HTML elements you learned
about in this lesson. Use the Compatibility tab in the Page Options dialog box to set the browser compatibility for
your Web. If you know that most of your visitors will have 3.0 versions, make your pages compatible with those
browsers. If you do not have headings for your pages, add a shared border at the top of your page. If you have adver-
tisers lined up or graphics that will promote a friend's site, use the Banner Ad Manager to support these sites. You can
use images from or associated with the site you want to advertise or a corporate logo. Finally, decide whether or not
to apply DHTML effects or insert ActiveX Controls. If you set your target audience for browsers other than Internet
Explorer, the ActiveX command will be inactive. You will have to change the compatibility settings to add the 
control. Some of your audience will not be able to see these special effects. You can insert an ActiveX video player
and use DHTML effects for your high-tech visitors.

12. Finally, create a frames page in your personal Web. Create a single frame on the left side of the page. Create
hyperlinks in this frame to all the pages in your Web. Set the other frame to your home page. Preview the frames page
and make sure it works. Provide a no-frames alternative for visitors who cannot or choose not to view frames. You
can either provide a link to your home page or create a portal page where visitors can choose which version of your
Web site to visit. When you are finished, spell-check your Web to ensure that it is professional in appearance. Add
words to the custom dictionary as appropriate. If there is any text you want to change, use the Replace command to
change all occurrences of the word or words in the Web.
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Have you ever had the feeling that you had too much to do
and not enough time to do it? Creating a large Web site,
even with all the FrontPage shortcuts, is a big job that can

sometimes seem overwhelming. Fortunately, FrontPage includes a
task manager called Tasks view. In Tasks view you can organize the
work that must be completed on your Web, assign tasks to co-
workers, and track what jobs have been completed, when and by
whom for a multiauthored site.

Tasks are simply reminders about actions you need to perform in
your Web. You can build a Tasks list to provide a clear and accurate
account of what work has been finished and what remains to be
done before your Web can be published. The Tasks list is a to-do
list that will also provide valuable documentation, especially for
team projects.

Some FrontPage wizards automatically create tasks for you. You
can also create tasks from scratch. In this lesson you will learn how
to create your own tasks, assign tasks to others and add tasks that
are linked to a particular page. You will learn how to edit and
delete tasks and how to start and complete them. You will also
learn how to mark tasks as completed. Next, you will learn how to
sort your tasks by who is assigned to complete the task, date modi-
fied, status, priority and other criteria. Finally, you will learn how
to use the Show History command to limit the Tasks list to jobs
that have not been started or are still in progress or to view the
complete task history.

FP 8.1

CREATING AND
MANAGING TASKS

Creating New Tasks

Adding a Task Linked to a
Page

Starting and Completing Tasks

Sorting Tasks

Viewing Task History
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O v e r v i e w Although some wizards add tasks automatically, most do not. In general, you will
have to manually add tasks. You will need to add to the Tasks list created by a 
wizard or create a Tasks list for a Web you are constructing from scratch or with a
template. When you create a task you can specify to whom it is assigned and any
other pertinent information. This documentation is especially important for large
corporate Web sites with many contributors.

H o w  To : Create a new task in the Skydiver Web.

Open the FPHowto8-1 Web from your FP Data Files folder. Open the home page.

Click the Tasks button      on the Views bar. Tasks view opens. The global find and
replace function was not completed.  Instead, the Add Task button              in the
Replace dialog box was used to create a task for each page with at least one 
occurrence of the word sky.  The uncompleted tasks are displayed in Figure 8-1.

Click File on the Menu bar.

Move the pointer over New.

Click Task on the submenu that appears.

The New Task dialog box opens, as shown in Figure 8-2.

In the Task name: text box type: Recalculate hyperlinks.

In the Description: text box type: Check all hyperlinks in Web. Recalculate if 
necessary.

Click the Low radio button in the Priority section of the New Task dialog box. 

Click              . The task is added to your Tasks list.

E x t r a If you are managing a project, you can assign tasks to other people. Employees can
then open a Web to see if any work has been assigned to them and complete the
tasks. You can also create tasks for yourself to serve as reminders of what you need
to do before your Web is ready to be published.

There are two kinds of tasks, linked and unlinked or general tasks.  In this exercise
you created a general task.  A linked task is associated with a particular file or
page. For example, each Replace task is linked to the page on which it occurs. You
can also create a linked task to remind yourself to add a paragraph, table, or 
graphic to a particular page.

Creating New Tasks

L e s s o n  8  • C r e a t i n g  a n d  M a n a g i n g  T a s k s

FP 8.2

1

5

6

4

2

3

7

10

9

8

Skill



Practice Hot Tip
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Create a new task in the Caddy Shop Web.
The task is a high priority. Name the task,
Check Spelling. For a description type:
Check Web for spelling errors.

To edit a task, right-click it and choose the
Edit Task command from the shortcut
menu. You can view or make modifications
to the task details in the Task Details
dialog box.

Figure 8-1  Tasks list in Tasks view

Figure 8-2  New Task dialog box

Marks the
progress of a task

Marks
importance
of project

Set the priority
level for task

When a task is created
linked or associated
with a page



O v e r v i e w As you have seen, some FrontPage features allow you to add a task to your Tasks
list while you are performing another function. When you are starting a new page
you can create a task in the New dialog box. Rather than actually creating the
page, you can create a task to remind you to finish the page later. The task will be
linked to the new blank page.

H o w  To : Add a task to remind yourself to complete a new page in the Skydiver Web.

Open the home page in the Skydiver Web.

Click File on the Menu bar.

Move the pointer over New on the File menu.

Click Page on the submenu that appears.

The New dialog box opens. Click the Just add Web task check box on the right
side of the dialog box, as shown in Figure 8-3.

Click              . The Save As dialog box opens. 

Type: Task as the file name. 

Click                . 

Click the Tasks button      on the Views bar. The new page appears as a high 
priority task on the Tasks list, as shown in Figure 8-4.

Right-click the task. Click Edit Task on the shortcut menu to open the Task Details
dialog box, as shown in Figure 8-5. You can reassign the task, change or add to the
description or change the priority level. Click               when you are finished.

E x t r a The priority level automatically assigned to a task by FrontPage depends on the
type of task. Finishing a new page, as in the exercise above, is treated as a high 
priority task. Each Spelling or Replace task you add while using the Replace and
Spell-checking tools is linked to the page on which it occurs and is considered a
medium priority task.

To add a task that is linked to an existing page, first highlight the page in any view.
Then, follow the steps in the previous skill.  For example, select a page in
Navigation view. Then, open and complete the New Task dialog box. The task will
be added to the Tasks list associated with that page.

Adding a Task

Linked to a Page
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Practice Hot Tip
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Create a new page in the Caddy Shop
Web, but create it as a task. Save the page
as caddytask.

You can also add a task to an existing file
by right-clicking the file in the Folder list.
Click Add Task on the shortcut menu to
open the New Task dialog box. The task
will be associated with the file you select-
ed.

Figure 8-3  Adding a task in the New dialog box

Figure 8-4  New task in Tasks list

Figure 8-5  Task Details dialog box

A task linked to the new
page will be created.

Finishing a page is
a high priority task

The priority and other
details can be changed in
the Task Details dialog box



O v e r v i e w When you are ready to start working on a task, you must first select the task so the
appropriate page will open. When everything is done, mark the task as completed
to keep your tasks list up to date. Tasks can be started and completed in any order
by the person to whom they have been assigned.

H o w  To : Execute your highest priority task in the Skydiver Web and then mark the task as
completed.

Open the home page in the Skydiver Web.

Click the Tasks button      on the Views bar.

Right-click the Finish Task.htm task.

Click Start Task on the shortcut menu that opens.

The new page, task.htm opens, as shown in Figure 8-6. Complete the page. Enter
any content and insert any graphics and components you choose to complete the
page. Be sure to add the new page to Navigation view. Add the necessary hyper-
links to the page, the menu frame, and the table on the home page. Save the
changes to each page.

Click the Tasks button      on the Views bar.

Right-click the Finish Task.htm task.

Click Mark as Completed on the shortcut menu that appears.

The circle on the left of the task changes colors, as shown in Figure 8-7.

Save your changes to the Task page.

E x t r a If you checked the Add a task for each page with misspellings check box in the
Spelling dialog box, starting the task will open the page you selected and the
Spelling dialog box. Similarly, when you start a task you created using the Add
Task button              in the Replace dialog box, the page will open with the speci-
fied text selected. When you save the changes to a page that was opened from
Tasks view, FrontPage will prompt you to mark the task as completed.

If you create a general task you will have to start and complete the task yourself.
When you are done, save any changes, return to Tasks view and mark the task
completed.

When you mark a task completed, it cannot be reversed.  For a multiauthored site,
this may mean that even when a task is complete it should not be marked as such
until it has been reviewed and approved by a department head or supervisor. If you
prematurely mark a task completed, you will have to delete it and create a new task
to replace it.

Starting and

Completing Tasks
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Practice Hot Tip
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Start and complete the highest priority task
in your Caddy Shop Web.

To determine who completed a task and
when it was finished, right-click the 
completed task and click Edit Task to open
the Task Details dialog box.  The updated
information will include the completion
date and time.

Figure 8-6  New page linked to a task

Figure 8-7  Completed task in Tasks list

Task.htm page created in
New dialog box with an
associated task

Green circle marks
completed task



O v e r v i e w By default, tasks appear in the Tasks list in the order in which they were created.
You can sort your tasks to view them in a different order by clicking the column
heading you want to use as the sort criterion. This can be useful in large Web sites
with many tasks assigned to different individuals. You can sort your Tasks list by
status, the people assigned to complete the tasks, priority, or any other column
heading to organize your tasks.

H o w  To : Sort the tasks in your Tasks list to view them in different ways.

Open the home page in the Skydiver Web.

Click the Tasks button      on the Views bar.

Click the Priority button at the top of the Tasks list. 

Your tasks will be sorted by Priority, as shown in Figure 8-8.

Click the Associated With button at the top of the Tasks list.

The tasks are now sorted by which pages in the Web they are associated with.

Click the Modified Date button at the top of the Tasks list.

The tasks are sorted in ascending order by the date they were last modified.

Click the Modified Date button again.

The tasks are sorted in descending order by the date they were last modified. This
is shown in Figure 8-9.

E x t r a You can sort tasks in either ascending or descending order. If the category you are
sorting contains letters, for example, names in the Assigned To category, the first
time you click the column heading the names will be listed in ascending order or
alphabetically from A to Z.  Clicking the Assigned To column heading a second
time will reverse the order.  If you click the Associated With column heading, your
tasks will be listed alphabetically by page title in ascending order. To restore the
default order, click the Modified Date column heading.  If you click the Modified
Date column heading again, the tasks will be listed in descending order with the
most recently created or modified tasks listed first.

To resize a column, move the pointer over the vertical bar on the right edge of the
column heading until it becomes a resizing pointer.  Click and drag to the right to
widen a column and to the left to shrink a column. To make a column in the Tasks
list exactly as wide as the information in the column, double-click the vertical bar.

Sorting Tasks
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Open the Tasks list for your Caddy Shop
Web. Sort the tasks in all the different
ways you can. Take note of the differences,
and why each sorting criteria would be
useful.

To delete a task, right-click it and click the
Delete command on the shortcut menu.
The Undo command will not reverse the
deletion.

Figure 8-8  Sorting tasks by Priority

Figure 8-9  Sorting tasks by Modified Date

All tasks with the same
priority level are grouped
together with High priority
first and Low priority last

Tasks sorted in
descending order
by Modified Date



O v e r v i e w When the Show History command is enabled, all tasks, even those completed, will
be listed in the Tasks list. If the Show History command is inactive, the completed
tasks will not be listed. In large Tasks lists, you may want to turn off the Show
History function to limit the list to those tasks that must still be completed.

H o w  To : Use the Show History command to view the tasks you have completed.

Open the home page in the Skydiver Web.

Click the Tasks button      on the Views bar.

Right-click the first Replace sky task and click Start Task on the shortcut menu.
The page opens with the first occurrence of sky highlighted.

Edit the page. Save the page and mark the task as completed when prompted.

Return to Tasks view. Repeat the procedure to edit the next three pages. Reopen
the Replace dialog box, if necessary. Save each page and mark the tasks as 
completed when prompted. Return to Tasks view.

Click Edit on the Menu bar. Move the pointer over Task. The Task submenu opens.

If Show History is checked, click it. If it is not checked, click outside the menu to
close it.

Click the Refresh button      on the Standard toolbar.  The completed tasks have
been removed from the list as shown in Figure 8-10.

Click Edit on the Menu bar.

Move the pointer over Task.

Click Show History on the submenu that appears.

All the completed tasks are now visible, as shown in Figure 8-11.

Close FrontPage.

E x t r a When Show History is checked, the command is active and all completed tasks will
appear in the Tasks list. If the command is not activated, any action that refreshes
the page such as the Refresh command or closing the Web or FrontPage will
remove the completed tasks. When managing the construction of a large site and
coordinating many tasks, you may want to deactivate the Show History command
to keep the size of the Tasks list manageable and avoid any possible confusion.

The Refresh command is a useful tool for team projects with multiple authors.  For
example, if you have already created a Site Summary you will have to refresh
Reports view to display changes another author has made to the site.

Viewing Task

History
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Practice Hot Tip
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Mark two tasks as being completed in your
Tasks list. Then deactivate the Show
History command. Refresh the page. Then,
activate Show History again.

If you right-click the background in Tasks
view, a shortcut menu including the Show
History command will open. You can check
to see if the function is activated and turn
it on or off.

Figure 8-10  Tasks list with Show History inactive

Figure 8-11  Tasks list with Show History active

Only tasks that are not
complete are visible in
this version

In this view all the
completed tasks are
visible as long as they
have not been deleted
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Shortcuts
B u t t o n / M o u s eF u n c t i o n

Tasks view

Save

New Page

Refresh

Spelling

Replace

M e n u
Click View, then click
Tasks

Click File, then click
Save

Click File, then move
the pointer over New,
then click Page

Click View, then click
Refresh

Click Tools, then click
Spelling

Click Edit, then click
Replace

K e y b o a r d

[Ctrl] + [S]

[Ctrl] + [N]

[F5]

[F7]

[Ctrl] + [H]



Test Yourself

a. Task Details dialog box

b. Descending

c. Priority

d. Show History

e. Ascending

f. Start Task

9. Tells you how important a task is

10. Use this to edit tasks

11. This opens the function used to create a task or the page with which it is 
associated

12. Sorts tasks from A to Z

13. Sorts tasks from Z to A

14. Displays all tasks, including those that have been completed

FP 8.13
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I d e n t i f y  K e y  F e a t u r e s

Figure 8-12  Tasks list in Tasks view



Test Yourself

15.  The purpose of assigning tasks is to:

a. Delegate the tasks

b. Spread tasks to different co-workers

c. Keep track of who has completed what tasks

d. All of the above

16.  Clicking this opens the Task Details dialog box:

a. Task Details

b. Edit Task

c. New Task

d. Add Task

17.  You can sort tasks using all the following categories
except:

a. Task History

b. Priority

c. Assigned To

d. Modified Date

18.  You can mark a task as complete:

a. Only after you have used FrontPage to complete
the task

b. Only in the Task Details dialog box

c. At any time by clicking Mark as Completed

d. At any time by clicking Task Finished

19.  If you sort tasks by who they are assigned to in
descending order, this name would appear first:

a. Sydney

b. Ronald

c. Raymond

d. Matthew

20.  You can delete a task by right-clicking it to open a
shortcut menu and clicking:

a. Edit Task

b. Delete

c. Cut Task

d. End Task

21.  When the Show History command is checked it
means:

a. None of the completed tasks will be visible

b. Only the completed tasks will be visible

c. All the completed and unfinished tasks will be 
visible

d. None of the unfinished tasks will be visible
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Test Yourself
1.  Create new tasks in the Water Taxi Web:

a. Open the Home page in the Water Taxi Web.

b. View the Tasks list.

c. Open the New Task dialog box.

d. The Task name: is Test Hyperlinks.

e. The Description is: Test all the hyperlinks in the Web. If there are faulty hyperlinks, recalculate them.

f. The priority of this task is Medium.

g. Make sure this task has been added properly to your Tasks list.

2.  Add a task to the Water Taxi Web while performing another function:

a. Open the Home page in the Water Taxi Web.

b. View the Tasks list.

c. Open the New dialog box to create a new page.

d. Click the Just add Web task check box.

e. Save the file under the name newtask. Return to Tasks view.

f. Right-click the new task.

g. Click Edit Task on the shortcut menu. View the details of the new task in the Task Details dialog box. Change
the description to: Create a new page listing popular fishing locations.

3.  Start and complete tasks in the Water Taxi Web:

a. Open the Index page in the Water Taxi Web.

b. View the Tasks list.

c. Right-click on the task Finish newtask.htm.

d. Click Start Task on the shortcut menu that opens.

e. Complete the new page and save it as fishing.htm. Change the page title to Fishing Locations.

f. When the message box opens reminding you that the page was opened from Tasks view and asks if you would
like to mark the task as completed, click Yes.

g. Add the page to the navigation structure below the the Locations page.

h. Add a hyperlink to the left frame and empty the cell in the table for the Fishing Locations page.

FP 8.15
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Test Yourself
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4.  Sort the tasks in your Tasks list:

a. Open the Home page in the Water Taxi Web.

b. View the Tasks list.

c. Click the Associated With button at the top of the Tasks list to sort the tasks in ascending order of the pages
they are associated with.

d. Click the Modified Date button at the top of the Tasks list to view the tasks in ascending order of the date they
were last modified.

e. Click the Modified Date button at the top of the Tasks list again to view the tasks in descending order of the
date they were last modified.

5.  View the history of your tasks:

a. Open the Home page in the Water Taxi Web.

b. Preview the Web in a browser and test all the hyperlinks.

c. View the Tasks list. Mark the Test Hyperlinks task complete.

d. If the Show History command is active, deactivate it. If it is not turned on, close the menu.

e. Refresh the page.

f. Activate the Show History command to view your task history.

6.  Before you leave Diggs & Associates you must assign work to the three employees who will be taking over the 
maintenance of the Web, John, Martha, and Alan. If you have any Spell-checking or Replace tasks left, divide them
up as evenly as possible. Create three new linked tasks to remind each employee to finish a new page. Create three
new general tasks. Ask John to perform a final spell-check on the Web, Martha to test all hyperlinks and Alan to
check all interactive and advanced components. Assign priorities to these tasks as you see fit.

7.  Sort the Tasks list in different ways. First, sort them according to the person assigned to complete the task. Make
sure each employee has approximately an equal amount of work. Tasks that were previously assigned to you must be 
reassigned. Next, sort the tasks by priority. Make sure you have equally divided the number of high, medium and low
priority tasks. Finally, return to the default view so that each task is listed by the date it was created or last modified.
Turn off the Show History command if necessary, so that only uncompleted tasks will display.



Test Yourself
8.  You are now ready to finish your personal Web. Perform a final spell-check. Add a task for each page with 
misspellings to perform this task more efficiently. Open the Tasks list and complete all tasks including those you have
created while performing other functions. If you still have pages to create or other maintenance to perform, create
tasks for each job. Be sure to complete all tasks.

9.  Sort the list in various ways to decide how to proceed. You may want to perform all tasks associated with a cer-
tain page first or high priority tasks first. To avoid confusion, do not enable the Show History command until you
have marked all tasks as completed. Then, use the Show History command to make sure you have not accidentally
marked a task completed that you have not finished.
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Glossary
A

ActiveX Control
A control added to your Web pages, 
often interactive, created by a program
written specially for that control.

Align left, right
Command buttons on the Formatting 
toolbar that change the alignment of the
text on a Web page by aligning the text to
the left or the right side of the page.

Answer Wizard
A part of the FrontPage Help feature, it
allows you to type a question, and will
search for the help topics that might be
useful in answering that question.

Applet
A set of instructions written in Java that
tells your browser how to interpret a 
certain object and effect, it only works
with Java-enabled browsers.

B
Background

A command on the Format menu that
allows you to make formatting changes to
different aspects of Web pages.

Banner Ad Manager
Creates a slideshow-like presentation of
images which can be linked to other Web
pages. Often used for advertisements that
appear on Web pages.

Bevel
A formatting option which creates an effect
around an image. The effect makes the
image appear to have a picture frame
around it.

Bold
A command button on the Formatting
toolbar that makes the selected text appear
in bold lettering.

Broken hyperlink
A hyperlink that has a target page that
does not exist, has been moved, or
changed, or for some other reason the
hyperlink does not work, or link to an
appropriate file.

Browser
See Web Browser.

Bulleted list
A type of list in which the information is
organized by graphical marks, called 
bullets, representing a new section of 
information on the list.

C
Caption

A feature which creates a message that
appears with a table, usually used to 
provide explanation on the information in
a table.

Cascading Style Sheets
A new FrontPage feature which uses a text
file to effect the way elements on your Web
are positioned.

Cell
The empty spaces that are created by the
rows and columns of a table. Contains the
information in a table.

Center
A command button on the Formatting
toolbar that changes the alignment of the
text on a Web page by aligning it in the
center of the page.
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Check box
A check box is another way of answering a
yes or no question, the user has an option
of checking the box to select it, a yes
answer, or not checking it, a no answer.

Child page
A page, in a Web hierarchy, which appears
below another page in the hierarchy, and
therefore can only be linked to from that
page.

Click
To press and release a mouse button in one
motion; usually refers to the left mouse
button.

Clickable image
Another name for a hotspot or an image
map, an image that is formatted so that a
hyperlink is added to a particular place on
the image. When clicked this spot acts as a
hyperlink.

Clip Art Gallery
A gallery of images that Microsoft provides
that you can search and use to add 
graphics to your Web pages.

Close button
A sizing button that appears on the Title
bar, when clicked it closes the application.

Column
The vertical border of a table, that 
intersects with the rows to make up the
empty spaces of the table called cells.

Contents
A part of the FrontPage Help feature, this
allows you to search for help based on a
table of contents with help topics that you
can choose to look at.

Control
An object that makes data entry easier and
more efficient, most controls appear on
form pages, such as check boxes, and radio
buttons.

Control Menu icon
An icon that appears in the Title bar that
opens a menu, when clicked, that allows
you to manipulate the FrontPage window.

Convert
A function on the Table menu that allows
you to change plain text into a table and a
table into plain text.

Copy
A command found on the Edit menu that
copies the selected text and moves it to the
Office Clipboard.

Cut
A command found on the Edit menu that
cuts the selected text and moves it to the
Office Clipboard.

D
Decrease indents

A command button on the Formatting
toolbar that allows you to decrease the
indentation between the text and the 
margins.

Desktop
The standard Microsoft Windows screen, it
is designed to have the appearance of an
actual desktop.

Dialog Box
A box that groups functions together, it
performs certain actions depending on the
commands you use and the options you
select.

Drag
To hold the mouse button down while
moving the mouse.

Draw Table
A function on the Tables toolbar that
allows you to draw a table to your own
specifications, and insert columns and
rows.



Font
The style in which text appears. Bold, 
italic, script, serif, and sans serif are all
styles associated with different fonts.

Form page
A type of Web page that asks the user for 
information, once the information has been
entered the page may be sent to the Web
manager, and saved, or sent to an e-mail
address so the data can be recorded.

Format
A menu on the Menu bar that allows you
to make formatting changes to your Web
and Web pages.

Format Painter
A FrontPage feature which allows you to
copy and paste the format from a body of
text and apply it to text in a different 
location.

Formatting
The process of adding elements to your
Web page, including objects, text, colors,
and other important Web components to
give your Web a certain look or style, and
make it attractive.

Formatting toolbar
A bar full of buttons and icons that allows
you to perform certain formatting actions
on your Web pages.

Frames
A menu on the Menu bar that allows you
to add frames to a page, create a frames
page, and make changes to frame pages.

Frames page
Pages which contain an extra frame, which
is another Web page, that allows visitors to
move smoothly through your Web site.

G
Graphic Interchange Format (GIF)

A format in which images are saved, where
the image is compressed so that it does not
take up much space, and doesn’t take long
to download.
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Drop-Down arrow
An arrow that appears in a text box, 
clicking it opens up a menu of options to
choose from.

Drop-Down Menu
A menu of options that opens by clicking
the drop-down arrow. You can also use
FrontPage to create a drop-down menu on
a form page.

Dynamic HTML (DHTML)
A code used to create  motion effects on a
Web page, such as banner ads and other
special effects.

E
Edit

A menu on the Menu bar that provides you
with commands that allow you to make
changes and edit your Web and Web pages.

F
File

A menu on the menu bar, it provides 
commands that have to do with saving,
opening, printing, storing, and performing
other filing options on your Web and Web
pages.

Find
A command found on the Edit menu,
searches for text that you specify and takes
you to where the text is located on a page,
or in a Web.

Folder List
A list of files and folders that appears to
the left of the FrontPage screen, it can also
be accessed by opening the View menu.

Folders view
Allows you to view and organize the 
folders and files that are associated with a
Web.



Global Find and Replace
The same function as the Find command
and the Replace command. The difference
is that global means these commands are
applied to an entire Web.

H
Help

A Microsoft feature that provides several
different ways of searching for help and
information while you are using a
Microsoft program. You can access this
feature with the Help menu on the Menu
bar.

Hit Counter
An interactive feature on a Web page.
When inserted it displays the number of
visitors that have opened a Web page.

Home page
The first page that a visitor sees when they
enter your Web site. It is where they begin
to navigate through your Web.

Hotspot
Another name for an image map or a 
clickable image, when an image is 
formatted so that a particular spot on the
image is linked to a target page. When
clicked the hotspot acts as a hyperlink.

Hover button
A button added to a Web page which 
creates an effect when the pointer hovers
over it, the button is actually a Java applet.

Hyperlink
A hyperlink is a piece of text that links to
another page inside the Web, or externally
to another Web altogether.

Hyperlinks View
Displays every hyperlink to and from each
page in a Web.

Hypertext Markup Language (HTML)
A code used for designing Web pages.
FrontPage writes HTML code for you, but
a knowledgeable user may also write
HTML code for a page in FrontPage.
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HTML tab
Found in Page view, this mode of viewing a
page allows you to look at and edit the
HTML code that makes up the Web page.

I
I-beam

When you move the mouse pointer over
text or an area of a page where text may
be inserted it turns into an I-beam so
named because it looks like an I-beam.

Icon
A small graphic that identifies an object or
a button.

Image map
Another name for a hotspot or clickable
image, when an image is formatted so that
a particular spot on the image is linked to
a target page. When clicked the spot acts as
a hyperlink.

Image toolbar
A bar containing buttons that perform 
specific actions when clicked, this 
particular toolbar contains command 
buttons that act on images alone.

Import
A command which allows you to take files
from another location, such as another
folder, drive, or even from the Web, and
place them in your current Web.

Increase indents
A command button on the Formatting
toolbar that allows you to increase the
indent between the text and the margins.

Index
A part of the FrontPage Help feature, this
function allows you to get help by typing a
keyword and searching for the help topics
related to that keyword.

Insert
A menu on the Menu bar that allows you
to insert certain objects and files into your
Webs and Web pages.
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Insertion point
A flashing point on a page, it marks the
point where text will be entered on the
page, or where an object will be placed.

Internet
A global network of computers exchanging 
information over the network, it includes
the Web servers, the individual user, and 
organizations that manage the networks.

Italic
A command button on the Formatting 
toolbar that makes the selected text appear
italicized.

J
Java

A Web designing language. Similar to
HTML, Java is read by browsers and then
used to display Web pages, but Java allows
certain effects to be created which are not
possible in HTML.

Java applet
A set of instructions written in the Java
language which tells the browser which
effects to perform when the page is 
displayed. These applets are only visible
with Java enabled browsers.

Joint Photographic Experts Group
(JPEG)

A format in which images are saved, where
the image is compressed so that it does not
take up much space, and doesn’t take long
to download.

K
Keyword

A part of the Index help feature, type in a
keyword and the help feature will find a
help topic related to that keyword.

L
List

A list is a way of organizing information
on a Web page by displaying it in list 
format.

Lotus 1-2-3
A spreadsheet program, using FrontPage
you can open documents from this 
program and put them on a Web page.

M
Marquee

An object that takes text and moves it
across the screen to grab the viewers atten-
tion.

Maximize button
A sizing button found on the Title bar that 
maximizes the size of the FrontPage 
window.

Menu
A list of related commands.

Menu bar
Found below the Title bar, it contains the
names of menus that present lists of 
commands to choose from.

Merge Cells
A function performed on a table that turns
two separate cells into one.

Microsoft Personal Web Server
A program which publishes Webs to a local
hard drive or any other local area on your
computer.

Minimize button
A sizing button the Title bar that minimizes
the size of the FrontPage window so that it
no longer appears on the screen.
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Mouse pointer
The arrow shaped cursor on the screen that
you control by guiding the mouse on your
desk. You use the mouse to select and drag
items, choose commands, and start or exit
programs. The shape of the mouse pointer
can change depending on the task being
executed.

N
Navigation bar

A group of hyperlinks appearing as buttons
or simply as text which guide a user
through the navigation of your Web, by
providing hyperlinks, internally, to pages in
the Web.

Navigation button
A button that links to other pages to help
navigate a user through a Web.

Navigation view
Displays the navigation structure of a Web.
It also allows you to add Navigation 
buttons and a Navigation bar to your
pages.

New Page
A command found on the File menu that
allows you to create a new page with a
template, a wizard, or just a blank page.

New Web
A command found on the File menu that
allows you to create a Web using a 
template, a Wizard or a simple one-page
Web.

No-Frames page
An alternative page created simultaneously
with a frames page for users who cannot or
choose not to view frames.

Normal Tab
Found in Page view, this mode of viewing a
page allows you to add objects and 
elements, and perform some of the 
formatting options available to you in
FrontPage.

Numbered list
A type of list in which the information is
organized by numbers representing a new
section of information on the list.

O
Office Clipboard

Allows you to send up to 12 pieces of data
from programs to the clipboard, by cutting
or copying, then allows you to take data
off the clipboard and use it in other 
programs.

Open File
A command found on the File menu that
allows you to open any previously saved
file.

Open Web
A command found on the Menu bar that
allows you to open any previously saved
Web.

P
Page view

This view allows you to work on an 
individual Web page. Most of the 
formatting of additional elements and
graphics to a Web page is done in this
mode.

Page Transition
A formatting feature that creates an effect
as different pages are viewed in a Web.

Parent page
The page that appears above another page
in the Web hierarchy, so that it links to the
child page.

Paste
A command found on the Edit menu that
allows you to take data from the clipboard
and paste it in a document.
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Plain Text (TXT or ASCII)
A format  in which data appears. It is 
significant because you can use FrontPage
to open data in this format and place it on
a Web page.

Preview in Browser
A command found on the File menu, it
allows you to open your Web in a browser,
you may use any browser that is used by
your computer.

Preview Tab
Found in Page view, this mode of viewing a
page allows you to see what the page
would look like if it were published on the
Internet and viewed with a browser.

Print
A command found on the File menu that
allows you to print a copy of the
FrontPage screen, so that you can have a
hard copy of the pages that will be 
published.

Print Preview
A view that shows how an object will
appear when printed on paper. Useful for
evaluating the layout or structure of a
Web, before publishing it.

Publish Web
A command found on the File menu that
publishes your Web to a Web server or to
another location that you specify.

Push button
A button that is added to a form page that
allows a user to submit a form or to reset a
form, these options may be set when the
button is created.

R
Radio button

A group of buttons that allows the user to
select one or more of several options. Users
may be allowed to select more than one, or
can be limited to only one selection, out of
several radio buttons.

Recalculate Hyperlinks
A command found on the Tools menu that
fixes broken hyperlinks, by locating the
intended target pages.

Recent File
A command found on the File menu that
allows you to instantly open one of the
most recent files you have been working
on.

Recent Web
A command found on the File menu that
allows you to instantly open one of the
most recent Webs you have been working
on.

Rename
A command found on many shortcut
menus that allows you to rename an object
using the Rename dialog box.

Replace
A command found on the Edit menu, that
is related to the Find command. It allows
you to find information on a page or in a
Web and replace it with the text you speci-
fy.

Reports view
Provides reports and updates on the status
of the files and hyperlinks of a Web, so you
can keep it up to date.

Resizing arrow
When the pointer is moved over an object
and you have the option of resizing it, the
pointer will turn into an arrow, clicking
and dragging the arrow will resize the
object.

Restore button
A sizing button found on the Title bar that
allows you to revert the FrontPage window
to its previous size.

Rich Text Format (RTF)
A format in which data sometimes appears,
FrontPage can open a document in this 
format and place it on a Web page in
HTML format.
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Right-click
To click the right mouse button; often used
to access specialized menus and shortcuts.

Row
The horizontal border of a table, it inter-
sects with columns to create the empty
spaces called cells.

S
Save

A command found on the File menu that
saves a file simply by overwriting the 
existing saved document.

Save As
A command found on the File menu that
allows you to save a file with a new name
and a new location.

Scroll arrow
Arrows that appear on the right and 
bottom of the FrontPage screen, they allow
you to scroll through a document one line
at a time, by clicking the arrow in the
direction you want the view to move.

Scroll bar
A graphical device for moving vertically or
horizontally through the FrontPage screen
with the mouse. Scroll bars are located
along the right and bottom edges of the
FrontPage window.

Scroll bar box
A small grey box located inside a scroll bar
that indicates your current position relative
to the rest of the window. You can advance
a scroll bar box by dragging it, or by 
clicking the scroll arrows.

Search form
A form control that allows users to search
for specific information in a Web.

Shared borders
A command found on the Format menu
that allows you to add a Navigation bar to
a Web, this is most useful when you add
the shared borders in Navigation view.
Text, images, or other elements added to
the shared borders will be applied on all
the pages in a Web.

Shortcut key
A keyboard equivalent of a menu 
command such as [Ctrl]+[S] for Save.

Shortcut menu
A pop-up menu accessed by right-clicking
the mouse. The contents of the menu
depend on your current activity.

Site Summary
A type of report provided in Reports view
that evaluates files, folders, and hyperlinks
to make sure that every element of your
Web is kept up to date.

Sizing buttons
Three buttons found on the Title bar that
allow you to manipulate the size of the
FrontPage window.

Sizing handles
The small black squares that appear on the
border of an object when it is selected.
Dragging these handles will allow you to
resize the object.

Spelling Checker
A command found on the Tools menu, it
checks the spelling of words on a page or
in a Web with the words in its internal 
dictionary.

Split Cells
A function performed on tables that creates
two cells from a single cell.

Standard toolbar
Found below the Menu bar, it contains
graphical buttons that execute specific
commands.
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Status bar
Appears at the bottom of the screen and
displays the activity being performed, as
well as displaying currently active features,
including the loading time for a Web page.

Style box
A box on the Formatting toolbar that
allows you to set and change the style of
text that appears in a Web page.

Style sheets
See cascading style sheets.

T
Table

An object that you can insert into a Web
page to help organize information. The
table is made up of rows and columns
which create cells, the cells contain the
information. The Table menu on the Menu
bar is used to insert and format tables.

Tables toolbar
A toolbar that contains different graphical
buttons used to work with a table.

Target
The page, Web, or location that a 
hyperlink links to. When creating a 
hyperlink the target page or URL must be
specified. The target page must also be in
working order for the hyperlink to work.

Task
A task provides a reminder as well as docu-
mentation as to what work is to be done in
your Web, who is doing the work, and
when that work is taking place.

Tasks view
Displays the tasks that are and must be
completed in a Web.

Template
A basic structure or outline that FrontPage
provides you with to help you start your
Web. The pages may include placeholder
text which you simply overwrite to create
your page.

Text box
A box that appears on a form page that
allows users to enter text into it, a one-line
box allows a short entries, while scrolling
text boxes allow longer entries.

Theme
An overall style or look that is applied to a
Web page or an entire Web, it is 
customizable so you can create your own.

Title bar
Contains the application Control menu
icon, name of the application, and sizing
buttons, it appears at the very top of the
FrontPage screen.

Toolbar
A graphical bar containing buttons that act
as shortcuts for common commands.

Tools
A menu on the Menu bar that allows you
to select options that are useful for setting
the technical properties of the FrontPage
screen, Webs, and Web pages.

Tree diagram
Another name for a Web hierarchy, it is the
basic structure of a Web displaying all 
parent and child pages and their 
relationships to one another.

U
Underline

A command button on the Formatting
toolbar that makes the selected text 
underlined.

Uniform Resource Location (URL)
The address of a Web page. Every page has
its own URL, no two URL’s are exactly the
same.
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V
View

A menu on the Menu bar that allows you
to choose certain ways of viewing your
Web and Web pages, and allows you to
manipulate what tools and toolbars are 
visible.

View buttons
Found on the Views bar, these buttons
allow you to control the way you view a
Web, and allow you to perform different
functions in a Web.

Views bar
The bar of buttons found on the left side of
the FrontPage screen. This is where you
find the View buttons that allow you to 
perform different functions in a Web.

W
Warning

A dialog box that opens to ensure that you
are performing the action that you want,
you can continue the action, or cancel it. It
is used to prevent you from losing data or
making irreversible changes that you don’t
want to make.

Web
An assortment of Web pages that make up
a Web site. 

Web browser
A program that has the ability to display
Web pages, and can access them off of the
Internet, it displays pages by reading the
code they are written in.

Web hierarchy
Another name for a tree diagram, it is the
basic structure of a Web displaying all 
parent and child pages and their 
relationships to one another.

Web page
A document that appears on the Internet
with its own URL. It may contain graphics,
text, or any number of elements that may
be viewed once it is published.

Web server
A computer running software that stores
Web pages and objects, so that when a
browser requests a page or object, the 
server furnishes the request, the browser
interprets the objects as pages, text, 
graphics, etc.

Web site
One or more Web pages that are linked
and may be navigated by a 
visitor. Web sites are managed and owned
by a person, company, or an organization.

What’s This
A help feature that allows you to point to
an object on the screen, a small box will
open describing what that object is.

Window
A menu on the Menu bar that allows you
to manipulate the FrontPage window. Also
a rectangular area on the screen where you
view and work on files.

Windows Taskbar
Usually located at the bottom of your
screen, it contains buttons that allow you
to open programs and perform certain
functions.

Wizard
A series of dialog boxes that allows you to
enter data and choose options and uses
those choices to create a page or a Web for
you, based on your specifications.

Word
A Microsoft program that is used for word
processing, you can use FrontPage to open
a document from Word on a Web page.

WordPerfect
A word processing program, FrontPage can
open this document and place it on a Web
page.
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Index
A

ActiveX Control, FP 7.12-
7.13

Adding tasks, FP 8.4-8.5
Adding text over an image, FP

5.10-5.11
Advanced formatting, FP 5.1-

5.27
Advanced image formatting,

FP 5.8-5.9
Advanced Web Management,

FP 7.1-7.29
Align left, FP 3.4-3.5
Align right, FP 3.2
Answer Wizard, FP 1.14-1.15
Applet, FP 3.24-3.25
Applying themes, FP 3.10-

3.11

B
Banner Ad Manager, FP 7.8-

7.9
Bevel, FP 5.8-5.9
Bold, FP 3.2
Broken hyperlinks, FP 4.10
Browser: see Web browser

previewing Web page in, FP
2.18-2.19

Bulleted lists, FP 3.4-3.5

C
Captions, FP 6.12-6.13
Cascading Style Sheets, FP

5.20-5.21
Cell Properties, FP 3.8-3.9, FP

6.6-6.7

Cells, FP 3.6-3.9
merging, FP 6.8-6.9
resizing, FP 6.6-6.7

Centering, FP 3.4-3.5
Check boxes, FP 3.30-3.31
Child pages, FP 4.2-4.3
Clickable image, FP 3.22-3.23
Clip Art Gallery, FP 3.18-3.19
Close button, FP 1.7
Color Wheel, FP 3.12
Columns, FP 3.8

deleting, FP 6.2-6.3
drawing, FP 6.4-6.5

Completing tasks, FP 8.6-8.7
Component menu, FP 3.24-

3.27
Contents, FP 1.14-1.15
Control menu icon, FP 1.6-1.7
Controls, FP 3.30-3.31
Converting and importing

text, FP 5.2-5.3
Converting text from a table,

FP 6.10-6.11
Converting text into a table,

FP 6.10-6.11
Copy, FP 4.16-4.17
Corporate Presence Wizard,

FP 2.6-2.9
Creating:

drop-down menus, FP 3.32-
3.33
frames pages, FP 7.18-7.19
Hover button, FP 3.24-3.25
hyperlinks, FP 3.14-3.15
marquees, FP 3.26-3.27
new folders, FP 1.11
new tasks, FP 8.2-8.3
new Web pages, FP 2.2-2.3
no-frames pages, FP 7.22-
7.23
push buttons, FP 3.34-3.35
search forms, FP 5.16-5.17

tasks, FP 8.1-8.17
Tables, FP 3.6-3.7
Web sites, FP 2.21-2.24

Custom themes, FP 3.12-3.13
Customer Support Web, FP

2.4
Customer Support Web

Wizard, FP 2.8
Cut, FP 4.16-4.17

D
Data Access pages, FP 2.8
Deleting rows and columns,

FP 6.2-6.3
Discussion Web Wizard, FP

2.8
Draw Table command, FP

6.4-6.5
Drawing rows and columns,

FP 6.4-6.5
Drop-down menu, FP 3.32-

3.33
Dynamic HTML (DHTML),

FP 7.10-7.11

E
Editing, FP 2.14-2.15

frames pages, FP 7.20-7.21
hyperlinks, FP 3.16-3.17
tasks, 8.3

Excel, FP 4.14
Exiting FrontPage, FP 1.16-

1.17
Exploring the FrontPage

screen, FP 1.6-1.7
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F
File:

open, FP 1.8-1.9
recent, FP 1.8

File menu, FP 1.8-1.9
Find command, FP 2.16-2.17

global find, FP 7.2-7.3
Folder List, FP 4.2-4.3, 4.9
Folders view, FP 4.8-4.9
Font, FP 3.2-3.3
Form page, FP 3.28-3.35
Form Properties, FP 3.34-3.35
Format Painter, FP 5.12-5.13
Formatting:

advanced, FP 5.1-5.27
images, FP 3.20-3.21
lists, FP 3.4-3.5
page transition, FP 5.18-
5.19
tables, FP 3.8-3.9
text, FP 3.2-3.3
Web pages, FP 3.1-3.41

Formatting toolbar, FP 3.2-3.3
Frames:

creating frames page, FP
7.16-7.17
editing frames pages, FP
7.20-7.21
manipulating frames pages,
FP 7.20-7.21
no-frames pages, FP 7.22-
7.23
saving, frames page, FP
7.18-7.19

FrontPage:
exiting, FP 1.16-1.17
exploring the screen, FP
1.6-1.7
help, FP 1.14-1.15
starting, FP 1.4-1.5

G
Global Find and Replace, FP

7.2-7.3

Graphic Interchange Format
(GIF), FP 3.18

Guest Book page, FP 2.2-2.3

H
Help, FP 1.14-1.15
Hit counter, FP 5.14-5.15
Home page, FP 2.4
Hotspot, FP 3.22-3.23
Hover button, FP 3.24-3.25
HTML, FP 4.14-4.15, 4.16
HTML tab, FP 1.12-1.13
Hyperlinks: FP 1.2,

creating, FP 3.14-3.15
editing, FP 3.16-3.17
verifying, FP 4.10-4.11

Hyperlinks view, FP 4.10-4.11
Hypertext Markup Language,

FP 1.12

I
I-beam, FP 2.12-2.13
Image mapping, FP 3.22-3.23
Image toolbar, FP 3.20-3.32
Images:

adding, FP 3.18-3.19
advanced formatting, FP
5.8-5.9
formatting, FP 3.20
importing, FP 5.6-5.7
mapping, FP 3,22-3.23

Import Web Wizard, FP 2.8,
2.10-2.11

Importing and converting
text, FP 5.2-5.3

Importing images, FP 5.6-5.7
Importing Web pages, FP 5.4-

5.5
Index, FP 1.14-1.15
Inserting captions, FP 6.12-

6.13
Inserting a hit counter, FP

5.14-5.15

Insertion point, FP 2.12-2.13
Internet, FP 1.2
Introduction:

to Web design software, 
FP 1.1
to Web site design, 
FP 1.1-1.22

Italic, FP 3.2

J
Java, FP 3.24-3.25
Java applet, FP 3.24-3.25
Joint Photographic Experts

Group (JPEG), FP 3.18

K
Keywords, FP 1.14-1.15

L
List item properties, FP 3.5
Lists, adding and formatting,

FP 3.4-3.5
Lotus 1-2-3, FP 4.14

M
Maintaining, and publishing

Web pages, FP 4.1-4.24
Managing Tasks, FP 8.1-8.17
Manipulating Frames Pages,

FP 7.20-7.21
Marquee, FP 3.26-3.27
Maximize button, FP 1.6-1.7
Menu bar, FP 1.6-1.7
Merge Cells, FP 6.8-6.9
Microsoft Excel, FP 4.14
Microsoft Personal Web

Server, FP 5.14
Microsoft Word, FP 4.14-4.15
Minimize button, FP 1.6-1.7
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Modify Theme, FP 3.12-3.13
Modifying tables, FP 6.1-6.19

N
Navigation bar, FP 4.4-4.5
Navigation view, FP 4.2-4.3
New Page, FP 2.2-2.3
New Task dialog box, FP 8.2-

8.3
New tasks, creating, FP 8.2-

8.3
New Web, FP 2.4-2.5
No-frames page, FP 7.22-7.23
Normal tab, FP 1.12-1.13
Numbered lists, FP 3.4

O
Objects, adding to Web pages,

FP 3.1-3.41
Office Clipboard, FP 4.1,

4.16-4.17
Office document, opening in a

Web, FP 4.14-4.15
Open:

file, FP 1.8-1.9
office document, FP 4.14-
4.15
Web, FP 1.8

Opening a Web page, FP 1.8-
1.9

Organizing files in Folders
view, FP 4.8-4.9

P
Page transition, FP 5.18-5.19
Page view, FP 1.12-1.13
Parent page, FP 4.4-4.5
Paste, FP 4.16-4.17
Paste Special, FP 4.16-4.17
Personal Web, FP 2.4
Plain text (TXT or ASC II),

FP 4.14

Shared Borders, FP 4.4-4.5,
7.6-7.7

Shared Borders dialog box, FP
7.6-7.7

Show History command, FP
8.10-8.11

Site Summary, FP 4.10-4.11
Sizing buttons, FP 1.6-1.7
Sizing handles, FP 3.20
Sorting tasks, FP 8.8-8.9
Spell-checking, FP 2.14-2.15

a Web, 7.4-7.5
Standard toolbar, FP 1.6-1.7
Start menu, FP 1.4-1.5
Starting FrontPage, FP 1.4-1.5
Starting tasks, FP 8.6-8.7
Status bar, FP 1.6-1.7
Style sheets, FP 5.20-5.21

T
Tables:

adding, FP 8.4-8.5
converting from text, FP
6.10-6.11
converting to text, FP 6.10
creating, FP 3.6-3.7
deleting rows and columns
in, FP 6.2-6.3
drawing rows and columns
in, FP 6.4-6.5
formatting, FP 3.8-3.9
merging cells, FP 6.8-6.9
modifying, FP 6.1-6.19
resizing cells, FP 6.6-6.7

Tables toolbar, FP 6.4-6.5
Target address, FP 3.15
Target Audience, FP 7.14-7.15
Task Details dialog box, FP

8.3
Task history, FP 8.10-8.11
Taskbar, windows, FP 1.4-1.5
Tasks:

creating and managing, FP
8.1-8.17
creating new, FP 8.2-8.3
deleting, FP 8.9

Preview, FP 1.12-1.13
Preview a Web page in a

browser, FP 2.18-2.19
Print Preview, FP 4.6-4.7
Printing the Web structure, FP

4.6
Project Web, FP 2.4
Properties, FP 4.7
Publishing a Web, FP 4.18-

4.19
Publishing and Maintaining

Web Pages, FP 4.1-4.24
Push button, FP 3.34-3.35

R
Radio buttons, FP 3.30-3.31
Reaching target audience, FP

7.14-7.15
Recalculate hyperlinks, FP

4.10
Rename, FP 4.8-4.9, 4.12-

4.13
Replace, FP 2.16-2.17

global replace, FP 7.2-7.3
Reports view, FP 4.10-4.11
Resizing arrows, FP 3.8
Resizing cells, FP 6.6-6.7
Restore button, FP 1.6-1.7
Rich Text Format (RTF), FP

4.14
Rows, FP 3.8

deleting, FP 6.2-6.3
drawing, FP 6.4-6.5

S
Save command, FP 1.10
Save embedded files, FP 3.20
Save file, FP 1.18
Saving:

frames page, FP 7.18-7.19
Web page, FP 1.10-1.11

Scroll arrows, FP 2.2-2.3
Scroll bars, FP 2.2-2.3
Search form, FP 5.16-5.17
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editing, FP 8.3
history, FP 8.10-8.11
sorting, FP 8.8-8.9
starting and completing, FP
8.6-8.7

Template, FP 2.2, 2.4-2.5
Text:

adding over an image, FP
5.10-5.11
adding to a Web page, FP
2.12-2.13
converting into a table, FP
6.10-6.11
formatting, FP 3.2-3.3
importing and converting,
FP 5.4-5.5

Text boxes, FP 3.28-3.29
Themes:

applying, FP 3.10-3.11
custom themes, FP 3.12-
3.13

Title bar, FP 1.6-1.7
Toolbar:

formatting, FP 3.2-3.3
image, FP 3.20-3.23
standard, FP 1.6-1.7

Tree diagram, FP 4.2-4.3

U
Underline, FP 3.2-3.3
Uniform Resource Location

(URL), FP 1.2, 3.14-3.15,
4.12-4.13

V
Verifying hyperlinks, FP 4.10-

4.11
View:

Folders, FP 1.6-1.7, 4.8-4.9
Hyperlinks, FP 1.6-1.7,
4.10-4.11
Navigation, FP 1.6-1.7, 4.2-
4.3, 4.4-4.5
Page, FP 1.6-1.7

Reports, FP 1.6-1.7, 4.10-
4.11
Tasks, FP 1.6-1.7

View buttons, FP 1.6-1.7
Viewing and printing the Web

structure, FP 4.6-4.7
Views bar, FP 1.6-1.7

W
Web:

applying themes to, FP
3.10-3.11
defined, FP 1.6-1.7
hierarchy, FP 4.2-4.3
new, FP 2.4-2.5
open, FP 1.8
publishing, FP 4.18-4.19
recent, FP 1.8
server, FP 2.5, 4.18-4.19
spell-checking, FP 7.4-7.5
viewing and printing the
structure of, FP 4.6-4.7
Wizard, FP 2.6-2.9

Web Browser, FP 1.8, 2.18-
2.19, 3.24

Web Design Software, 
introduction to, FP 1.2-1.3

Web hierarchy, FP 4.2-4.3
Web Pages:

adding objects to, FP 3.1-
3.41
adding text to, FP 2.12-2.13
creating new, FP 2.2-2.3
defined, FP 1.2
editing, FP 2.14-2.15
formatting, FP 3.1-3.41
importing, FP 5.4-5.5
opening, FP 1.8-1.9
previewing in browser, FP
2.18-2.19
publishing and maintaining,
FP 4.1-4.24
renaming, FP 4.12-4.13
saving, FP 1.10-1.11
spell-checking, FP 2.14-2.15

Web Sites: FP 1.1

creating, FP 2.1-2.24
defined, FP 1.2
design, introduction to, FP
1.1-1.22

What’s This, FP 1.14
Windows:

taskbar, FP 1.4-1.5
Wizard:

Form Page, FP 3.31
Import Web, FP 2.10-2.11
Web, FP 2.6-2.9

Word, FP 4.14-4.15
WordPerfect, FP 4.14
Works, FP 4.14
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Appendix
M O U S  O b j e c t i v e s  I n d e x
Skills

Creating a new Web site
Save a FrontPage Web
Create a Web site using a Web

Wizard
Create a Web site using a Web

template

Open and edit an existing
FrontPage-based Web site

Open an existing FrontPage
Web

Modify and save changes to
the Web site

Apply and edit a Theme
across the Entire Web site

Apply a Theme to entire Web
site

Apply a custom Theme across
entire Web site

Add a new Web page
Create and Preview a new

Web page using a FrontPage
page template or wizard

Create a new page within
Page View

Open, view and rename Web
page

View a Web document in
Normal, HTML, and
Preview view

Open an Office document in a
FrontPage Web

Rename page title and change
page URL

Content

FP 2.6-2.7
FP 2.6-2.9

FP 2.4-2.5

FP 1.8-1.9

FP 1.10-1.11, 2.14-2.15

FP 3.10-3.11

FP 3.12-3.13

FP 1.12-1.13, 2.2-2.3, 2.18-
2.19

FP 2.2-2.3

FP 1.12-1.13

FP 4.14-4.15

FP 4.12-4.13

Exercises

FP 2.6-2.7
FP 2.6-2.9

FP 2.4-2.5

FP 1.8-1.9

FP 1.10-1.11, 2.14-2.15

FP 3.10-3.11

FP 1.12-1.13, 2.2-2.3, 2.18-
2.19

FP 2.2-2.3

FP 1.12-1.13

FP 4.14-4.15

FP 4.12-4.13
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Skills

Import text and images onto
Web page

Add or import images into a
Web page (automatically
converted to GIF/JPEG)

Add or import text to a Web
page (automatically 
converted to HTML)

Add or import elements from
a Web site to a FrontPage
Web

Type and format text and
paragraphs and create
hyperlinks

Type and format text/fonts on
a Web page

Add multi-level bulleted or
numbered lists to Web page

Format bulleted or numbered
lists

Add hyperlinks pointing to:
an existing page in the cur-
rent site, the WWW, or a
brand new page

Use the Format Painter to
apply formats

Use the Office Clipboard

Edit images, apply image
effects; create hotspots

Rotate, flip, bevel, or resize
images on a Web page

Add text over image
Create a hotspot  (clickable

imagemap)

Create and edit tables on a
Web page

Create tables on a Web page
Erase or delete table rows or

columns
Draw or add table rows or

columns
Resize tables and cells
Select and merge table cells

Content

FP 3.18-3.19, 5.6-5.7

FP 5.2-5.3

FP 5.4-5.5

FP 2.12-2.13, 3.2-3.3

FP 3.4-3.5

FP 3.5-3.5

FP 3.14-3.15

FP 5.12-5.13

FP 4.16-4.17

FP 3.20-3.21, 5.8-5.9

FP 5.10-5.11
FP 3.22-3.23

FP 3.6-3.7
FP 6.2-6.3

FP 6.4-6.5

FP 6.6-6.7
FP 6.8-6.9

Exercises

FP 3.18-3.19, 5.6-5.7

FP 5.2-5.3

FP 5.4-5.5

FP 2.12-2.13, 3.2-3.3

FP 3.14-3.15

FP 4.16-4.17

FP 3.20-3.21, 5.8-5.9

FP 3.22-3.23

FP 3.6-3.7
FP 6.2-6.3

FP 6.4-6.5

FP 6.6-6.7
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Skills

Insert dynamic, Active
Elements and FrontPage
components on a Web page

Add a Hit Counter to Web
page

Format Page Transition for
Web page

Add or edit scrolling Marquee
text on a Web page

Add a Search Form to a Web
page

View and organize Web site
documents

View a Web site in Reports
View, Hyperlinks View, or
Folders View

View your Web site structure
and print it from
Navigation View

Move and organize files using
drag and drop in Folders
View and Navigation View

Manage a Web site (including
all files and hyperlinks) and
automatically keep contents
up-to-date

Check spelling on a page or
across a Web site

Change the file name in
Folders View and update its
hyperlinks

Verify hyperlinks
Use Global Find and Replace

across a Web site

Manage Tasks
View task history
View and sort tasks in Tasks

View

Exercises

FP 4.2-4.5, 4.8-4.11

FP 4.6-4.7

FP 4.2-4.3, 4.8-4.9

FP 4.8-4.9

FP 4.10-4.11
FP 7.2-7.3

Content

FP 5.14-5.15

FP 5.18-5.19

FP 3.26-3.27

FP 5.16-5.17

FP 4.2-4.5, 4.8-4.11

FP 4.6-4.7

FP 4.2-4.3, 4.8-4.9

FP 7.8-7.9

FP 4.8-4.9

FP 4.10-4.11
FP 7.2-7.3

FP 8.10-8.11
FP 8.8-8.9
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A n s w e r  K e y
Lesson 1

Identify Key Features
1. Title bar
2. Toolbar
3. Menu bar
4. Views bar
5. Page View button
6. Reports View button
7. Navigation View button
8. Hyperlinks View button
9. Start button

Select the Best Answer
10. c
11. h
12. e
13. a
14. g
15. b
16. f
17. d

Complete the Statement
18. c
19. b
20. a
21. d
22. d
23. a
24. c
25. d

Lesson 2

Identify Key Features
1. Menu bar
2. File menu
3. Edit menu
4. Views bar
5. Preview in Browser button
6. Check Spelling button
7. Replace dialog box
8. Match case check box
9. Status bar

Select the Best Answer
10. f
11. c
12. g
13. b
14. a
15. e

16. h
17. d

Complete the Statement
18. d
19. b
20. c
21. a
22. c
23. b
24. c
25. d

Lesson 3

Identify Key Features
1. Bold button
2. Italics button
3. Center button
4. Image map, clickable image, hotspot
5. Image frame
6. Sizing handles
7. Table
8. Hyperlink
9. Hotspot button

Select the Best Answer
10. h
11. g
12. a
13. c
14. i
15. b
16. e
17. d
18. f

Complete the Statement
19. a
20. b
21. c
22. a
23. c
24. d
25. c
26 b

Lesson 4

Identify Key Features
1. Folder List button
2. Publish Web button
3. Folder list
4. Views bar
5. Folders View button
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6. Cut button
7. Paste button
8. Navigation button
9. Status bar

Select the Best Answer
10. h
11. a
12. f
13. d
14. i
15. b
16. c
17. e
18. g

Complete the Statement
19. d
20. b
21. b
22. a
23. d
24. d
25. c
26. a

Lesson 5

Identify Key Features
1. Format Painter button
2. Insert Component button
3. Position dialog box
4. Absolute positioning button
5. Relative positioning button
6. Location and Size section
7. Format button
8. Style button
9. Bevel button

Select the Best Answer
10. d
11. f
12. a
13. g
14. b
15. e
16. c

Complete the Statement
17. b
18. c
19. b
20. d
21. b
22. b

Lesson 6

Identify Key Features
1. Table menu
2. AutoFit button
3. Distribute Columns Evenly button
4. Merge Cells button
5. Insert Columns button
6. Insert Rows button
7. Split Cells button
8. Distribute Rows Evenly button
9. Caption

Select the Best Answer
10. c
11. e
12. d
13. b
14. a

Complete the Statement
15. c
16. a
17. d
18. d
19. c
20. b
21. a
22. d

Lesson 7

Identify Key Features
1. Frames menu
2. Save button
3. Insert Component button
4. Find What: text box
5. Replace With: text box
6. All Pages radio button
7. Active X control, Calendar control
8. Frame
9. No Frames tab

Select the Best Answer
10. f
11. d
12. a
13. h
14. b
15. e
16. c
17. g
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Complete the Statement
18. b
19. c
20. d
21. b
22. b
23. c
24. a
25. d

Lesson 8

Identify Key Features
1. Refresh page button
2. Tasks bar
3. View bar
4. Task, not started
5. Completed task
6. Priority heading
7. Modified date heading
8. Tasks button

Select the Best Answer
9. c.
10. a
11. f
12. e
13. b
14. d

Complete the Statement
15. d
16. b
17. a
18. c
19. a
20. b
21. a
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